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Hardware Warranty

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and

workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this

warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,

or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration

of the warranty period and make suitable arrangements for the performance of service. Customer shall be

responsible for packaging and shipping the defective product to the service center designated by Tektronix, with

shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a

location within the country in which the Tektronix service center is located. Customer shall be responsible for

paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate

maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage

resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;

b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any

damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been

modified or integrated with other products when the effect of such modification or integration increases the time

or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND

EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.

TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,

INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR

THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Software Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on

the media will be free from defects in materials and workmanship for a period of three (3) months from the date of

shipment. If a medium or encoding proves defective during the warranty period, Tektronix will provide a

replacement in exchange for the defective medium. Except as to the media on which this software product is

furnished, this software product is provided “as is” without warranty of any kind, either express or implied.

Tektronix does not warrant that the functions contained in this software product will meet Customer’s

requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration

of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and

workmanship within a reasonable time thereafter, Customer may terminate the license for this software product

and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS

THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS

WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,

SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER

TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH

DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Wear Eye Protection.Wear eye protection if exposure to high-intensity rays or
laser radiation exists.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING.Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

CAUTION
Refer to Manual

WARNING
High Voltage

Double
Insulated

Protective Ground
(Earth) Terminal

Symbols and Terms
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Service Safety Summary

Only qualified personnel should perform service procedures. Read this Service
Safety Summary and the General Safety Summary before performing any service
procedures.

Do Not Service Alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect Power. To avoid electric shock, switch off the instrument power, then
disconnect the power cord from the mains power.

Use Care When Servicing With Power On. Dangerous voltages or currents may
exist in this product. Disconnect power, remove battery (if applicable), and
disconnect test leads before removing protective panels, soldering, or replacing
components.

To avoid electric shock, do not touch exposed connections.
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Preface

This document describes how to use the following Tektronix MTS200 Series
MPEG Test System components:

� Expert Client

� Configuration Client

� Private Syntax Interpreter

If you purchased a Tektronix MTS200 Series MPEG Test System and are
looking for hardware and software installation instructions, first-time operation
procedures, or specifications, refer to theMTS200 Series Hardware and Software

Installation Technical Reference, Tektronix part number, 071-0261-XX.

Manual Structure

This Real-Time Analysis user manual is organized into the following sections:

Getting Started. This section provides brief overviews of the MTS200 and client
applications, descriptions of the rear panel connectors, procedures for starting
and logging onto the MTS200 system (including enabling/disabling Auto
Logon), and procedures for shutting down the MTS200 system and applications.

Operating Basics. This section describes the MTS200 system interface and
provides a brief tutorial that shows how the client modules are used to monitor
and analyze transport streams.

Reference. This section provides detailed descriptions and procedures for using
each of the MTS200 client modules. It also provides a reference for all user-con-
trolled analyses (called probes) enabled by the MTS200 system.

Appendix NO TAG: What to Do if an Application Locks Up.Appendix NO TAG
describes how to recover if the MTS200 system locks up.

Appendix B:Networking. This appendix describes network requirements, basic
TCP/IP and SNMP network installation procedures, and basic network trouble-
shooting information for the Tektronix MTS200 Series MPEG Test System.

Appendix C: Private Syntax Interpreter. This appendix describes how to create and
compile private syntax definitions for use with the MTS200 Series.
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Appendix D: ATSC Program Paradigm. This appendix describes the ATSC
program paradigm, which is the method used for allocating the values of the
Packet Identifier (PID) field of the transport packet header in a systematic
manner for ATSC transport streams.

Appendix E: Software Repair. This appendix explains how to create and use an
Emergency Repair Disk and how to reload the test system software if the
installed copy becomes corrupt.

Glossary. The Glossary contains definitions of new, uncommon, and/or unique
terms used in this manual.

Index. The Index provides a comprehensive alpha-numeric reference to the topics
covered in this manual.

NOTE. Refer to theMTS200 MPEG Test System Hardware and Software
Installation Technical Reference manual (Tektronix part number 071-0667-XX)
that is delivered with each MTS200 system for the following information:

� Hardware installation procedures

� Instrument option, accessory, and upgrade lists

� First time operation and functional check procedures

� MTS200 system specifications and compliances

� Software recovery procedures
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Manual Conventions

Throughout this manual the following typographic, symbolic, and terminology
conventions apply:

� Bold terms are found in procedures and denote interface items that you need
to select in order to cause an event to occur. For instance, to configure
default directories the procedure would read as follows:

Select Directories from the Options menu.

In this example, even though the Options menu is an interface element, the
Directories selection is the element that displays the needed dialog box
(causes an event to occur) and is the only bold term. When interface items
are referred to outside of procedures, the terms are not boldface.

� Manual names, manual section names, and words that are defined in the text
are italicized.

� Specific input that you need to make is indicated in the text using
mono-spaced font. Unless otherwise stated, do not enter punctuation at
the end of a mono-spaced font entry.

This manual uses symbols and terminology consistent with the following
publications:

� For PSI elements, ISO/IEC Standard 11172 and 13818 (parts 1, 2, and 3)

� For DVB elements, ETSI Publication ETS 300 468

� For DVB-T elements, ETSI Publication TS 101 191 V1.2.1

� For ATSC elements, ATSC Document A/65

� For Windows elements, The Microsoft Manual of Style for Technical

Publications, 2nd ed.

The following ARIB and ITU-R standards were used to develop the added ARIB
enhancements to the MTS200 system:

� ARIB STD-B10 (1.2), 1999, Service Information for Digital Broadcasting

System

� ARIB STD-B16 (1.1), 1999, Digital Receiver Commonly Used for Digital

Satellite Broadcasting Services Using Communication Satellite

Typographic Conventions

Symbols and Terminology
Conventions
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� ARIB STD--B20 (1.1), Digital Broadcasting System and Related Operation-

al Guidelines for Broadcasting Satellites

� ITU-R BO. 1408, Transmission System for Advanced Multimedia Services

Provided by Integrated Services Digital Broadcasting in A Broadcasting

Satellite Channel

In cases where terms, symbols, or references are or may be ambiguous, check the
Glossary located at the back of this manual for definitions. Also, refer to the
Glossary for definitions unique to the RTA test system and applications.

Refer to the Windows NT online Help for definitions and explanations of
Windows NT specific terminology.

Related Documents

TheMTS200 Series MPEG-2 DVB / ATSC ISDB--S/ARIB System Analyzer User

Manual, Tektronix part number 071-0532-XX, contains information about using
the Deferred-Time Analyzer and DVB Channel Coding and Decoding applica-
tions.

TheMTS200 Series Stream Creation Applications User Manual, Tektronix part
number 071-0534-XX, contains information about using the Multiplexer, DVB
Table Editor, ATSC Table Editor, DVB Channel Coding and Decoding, Jitter
Adder, Error Injector, and Open Mux Controller applications.

TheMTS200 Series Program Stream Analyzer User Manual, Tektronix part
number 071-0384-XX, contains information about using the deferred-time
Program Stream Analyzer application.

TheMPEG Test System Dolby Digital Audio Stream Analyzer User Manual,
Tektronix part number 071-0535-XX, contains information about using the
deferred-time AC-3 Audio Stream Analyzer application.

TheMTS200 Series MPEG Audio Stream Analyzer User Manual, Tektronix part
number 071-0192-XX, contains information about using the deferred-time
MPEG Audio Stream Analyzer application.

TheMTS200 Series Video Stream Analyzer User Manual, Tektronix part number
071-0249-XX, contains information about using the deferred-time MPEG Video
Stream Analyzer application.

TheMTS200 Series Data Store Administrator User Manual, Tektronix part
number 071-0536-XX, contains information about using the Data Store (CARB)
system that is part of MTS210 and MTS215 test systems.
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Software Version

Table i lists the version numbers for the MTS200 system applications supported
by this manual. To verify an application version number, select About from the
Help menu.

Table i: Supported applications version numbers

Application or server name Version supported

Expert Client 2.06

Configuration Client 2.06

Private Syntax Interpreter 1.0

Related Applications

The real-time applications described in this manual are part of the suite of
software and hardware components that comprise the Tektronix MTS200 Series
MPEG Test System. Table ii shows the program icons for each application,
briefly describes the purposes for each application, and lists the manual name
and number that you should look to for information about that test system
component.

The applications that appear in version 4.0 Tektronix MPEG Test System
program group and Start menu depend on the system configuration and its
installed options. Table ii summarizes all test system applications available in
release 4.0.

Table ii: Tektronix MPEG Test System version 4.0 applications

Icon Application title Function User document

Expert Client Continuously monitor an input bitstream for
compliance with the MPEG-2, DVB-SI, ARIB,
and ATSC PSIP digital television standards.

MTS200 Series Real-Time Analyzer
User Manual 071-0076-xx

Configuration Client Set, remove, and configure probes for MPEG-2,
DVB, ATSC, and ISDB-S/ARIB inputs.

Private Syntax Interpreter Create table definitions used by the Real-Time
Analyzer to interpret private syntax sections.

Data Store Administrator Manage the data store (CARB) disks and control
acquisition/generation of MPEG-2 transport
streams.

MTS200 Series MPEG Test
System Data Store Administrator
User Manual 071-0536-xx
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Table ii: Tektronix MPEG Test System version 4.0 applications (Cont.)

Icon User documentFunctionApplication title

MPEG-2 DVB/ATSC
System Analyzer

Analyze transport streams and packetized
elementary streams saved to system disk or
data store (CARB) files.

MTS200 Series MPEG-2
DVB/ATSC System Analyzer User
Manual 071-0532-xx

TMCC Deferred-Time
Client

Analyze ISDB-S/ARIB (TMCC) transport stream
files saved to the system disk or data store
(CARB) files.

DVB Channel Coding
and Decoding

Code and decode transport stream files to DVB
specifications.

MTS200 Series Stream Creation
Applications User Manual
071-0534-xx

(Information repeated in both
manuals)

Program Stream Analyzer Analyze MPEG program stream files. MTS200 Series Series Program
Stream Analyzer User Manual
071-0384-xx

MPEG Video Stream
Analyzer

Analyze MPEG-1 and MPEG-2 video elementary
streams files or streams extracted from the
MPEG-2 System Analyzer or Program Stream
Analyzer.

MPEG Test System Video Stream
Analyzer User Manual 071-0249-xx

MPEG Audio Stream
Analyzer

Analyze MPEG-1 and MPEG-2 audio elementary
streams files or streams extracted from the
MPEG-2 System Analyzer or Program Stream
Analyzer.

MPEG Test System Audio Stream
Analyzer User Manual 071-0192-xx

Dolby Digital Audio Stream
Analyzer

Analyze Dolby Digital (AC-3) audio elementary
stream files or streams extracted from the
MPEG-2 System Analyzer.

MTS200 Series Dolby Digital Audio
Stream Analyzer User Manual
071-0535-xx

MPEG-2 Transport Stream
Multiplexer

Create transport stream files from PSI/SI/PSIP
table files, elementary stream files, and data
files.

MTS200 Series Stream Creation
Applications User Manual
071-0534-xx

DVB Table Editor Create and edit PSI and DVB SAI table files for
use with the transport stream multiplexer.

ATSC Table Editor Create and edit PSI ad ATSC PSIP table files for
use with the transport stream multiplexer.

ARIB Table Editor Create and edit PSI and ARIB table files.
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Table ii: Tektronix MPEG Test System version 4.0 applications (Cont.)

Icon User documentFunctionApplication title

TMCC Combiner Create transport stream files with TMCC
information in the first eight bytes of the 16-byte
Reed-Solomon area of 204-byte transport
stream packets.

MTS200 Series Stream Creation
Applications User Manual
071-0534-xx

Jitter Adder Add jitter to PCR data in MPEG-2 transport
stream files.

Error Injector Insert or correct errors in transport stream
packets.

Real-Time Multiplexer Configure the real-time multiplexer application to
remultiplex system and or elementary streams
for immediate output.

Open Mux Server Remultiplex various MPEG inputs (system,
MPEG-2, DVB, ATSC, and elementary streams)
into a valid transport stream for immediate
output. The user interface for this application is
the Real-Time Multiplexer.

Tektronix Software
Protection

Enter or reenter the general password to enable
licensed applications.

Read This First, MTS200 Series
Software V4.0 071-0537-xx

MPEG2_Part1
(ISO/IEC 13818-1)

The international MPEG-2 system standard in
Windows Help format.

none

Uninstall MTS Remove MPEG Test System software from the
system disk.

All MTS200 Series User Manuals
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Other Information Sources

For information about the Windows NT operating system, refer to the Microsoft
documentation that accompanied your system.

If you purchased a Tektronix MTS200 Series MPEG Test System, refer to the
Compaq documentation that accompanied your test system for information about
the Compaq server.

For the latest information about MTS200 Series Real-Time Analyzer features
and bugs, refer to theMTS200 Series Software Version 4.0 Read This First

document that accompanied your Tektronix MPEG Test System product.

Two sources of online information are provided with the MTS200 Series Stream
Creation Applications. The first is the online help that accompanies each
application.

� Access help topics by selecting Contents from the Help menu.

The second source of online information is the MPEG-2 stand-alone Help file.
This help file, called MPEG-2 Help, is the MPEG-2, Part 1 (Systems), standard.
The help file is installed when you install the software and an icon is placed in
your Tektronix MPEG Test System program group window.

� To display the help, double click theMPEG-2 icon in the Tektronix MPEG

Test System program group window.

The following URLs access the websites for the standards organizations listed
(the URLs listed were valid as of January, 2001):

� MPEG-2 standards (International Organization for Standards)

http://www.iso.ch/

� DVB standards (European Technical Standards Institute)

http://www.etsi.org/

� ATSC standards (Advanced Television Systems Committee)

http://www.atsc.org/
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*
1-503-627-2400

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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Getting Started

This section contains the following information to help you get started using
your Tektronix MTS200 MPEG Test System:

� Overviews of the MTS200 test system and client applications

� Procedures for starting and logging onto the MTS200 system

� Procedures for shutting down the MTS200 system and applications

NOTE. Refer to theMTS200 MPEG Test System Hardware and Software
Installation Technical Reference manual that is delivered with each MTS200

system for the following information:

� Hardware installation procedures

� Descriptions of the rear panel connectors

� Instrument option, accessory, and upgrade lists

� First time operation and functional check procedures

� MTS200 system specifications and compliances

� Software installation and recovery procedures
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MTS200 System Overview

The MTS200 test system is an MPEG-2 protocol monitor and analyzer used to
monitor and analyze single and multiple program transport streams in MPEG-2,
DVB, ATSC, and ISDB-S/ARIB environments.

When used with the MTS200 options, the MTS200 test system provides three
primary capabilities to support the design and testing of MPEG, DVB, ATSC
and ISDB-S/ARIB systems:

� Real-time monitoring and analysis of transport streams

� Deferred-time analysis of transport streams

� Custom transport stream creation and generation

See the MPEG-2, DVB, ATSC, and ISDB-S/ARIB standards for detailed
information about the syntax and semantics of each system.

The MTS200 system now uses a client/server architecture for real--time analysis
of MPEG-2, DVB, ATSC, and ARIB structures consisting of an MPEG Analysis
Server and the following client applications:

� Expert Client

� Configuration Client

The Analysis Server is the process that actually analyzes transport stream inputs.
The Analysis Server process interacts with the Expert Client to display analysis
results, and with the Configuration Client to set the monitoring and analysis
parameters for each MPEG Analysis Server process operating on the test system.

The Expert Client application allows you to analyze a single MPEG transport
stream in greater detail. You will use the Expert Client as your primary tool to
help troubleshoot errors in your digital transmission system.

The Expert Client characteristics are shown in the following list:

� Graphical displays that show the structure (hierarchy) of the input transport
stream and display characteristics of each component of the input stream
(for example: PID and type allocation, section rate analyses, and timing
analyses).

� Report views that indicate the types of errors recorded by the Analysis
Server and the characteristics of the input stream.

� Error views that show specific errors recorded for the various components
of the transport stream; for instance, PMT section rate errors and ETR290
errors.

Analysis Servers

Expert Client
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The Configuration Client allows you to perform the following tasks:

� Specify the standard to which you are testing: MPEG-2, DVB, ATSC, or
ISDB.

� Set, remove, or modify the probes that test transport streams for valid syntax
and semantics and rates.

� Specify the way in which errors are reported in Expert Client. You can
configure each probe to report an error as Critical, Major, Minor, Warning, or
as information only.

� Stop and restart an MPEG Analysis Server running on a MTS200 system.

� Set passwords on specific inputs that prevent others from changing the
Analysis Server configuration for that input.

� Set parameters for capturing part of an input transport stream.

Logging On to the MTS200 Series System

Perform the following steps to log on to your MTS200 Series system:

1. Switch the MTS200 Series power on to begin the Windows NT initialization
process. Initialization can take up to two minutes. Under normal circum-
stances no action is required until the Begin Logon window appears.

2. When the Begin Logon window appears, press CTRL + ALT + DELETE (all
three keys simultaneously) to open the Logon Information window.

3. EnterMTS100 in the User name box, leave the password blank, and then
press ENTER (these are the default values set at the factory). This is the login
account you should use for most of your work. Refer to Login User Names

and Login Passwords below for more information about those topics.

The “MTS100” user name is the login account you should use for most of your
work. Two additional login user names are available. The first is “guest” with no
password. The guest login level has only limited access to files and applications.
The second is “administrator” with “MPEG2” as the password. The administra-
tor login level has administrator privileges to files and applications.

NOTE. You must use the “administrator” login when you perform any software

upgrades.

Configuration Client

Login User Names
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CAUTION. The “administrator” user has all the privileges of an administrator. If

you are connected to a network, you may have more privileges than you realize

within the network. It is recommended that you do not perform normal opera-

tions while logged in as an “administrator” user.

You can change the login passwords if necessary; refer to the Windows NT
documentation for instructions. If you change any login password, be sure to
create a new emergency repair disk.

Starting and Exiting the Expert and Configuration Client Applications

Once you have logged in to the MTS200 Series system, you can start the Expert
and Configuration client applications using one of the following two methods:

� Select the client name from the from the Windows NT Start | Programs |
Tektronix MPEG Test System menu

� Double-click the Expert or Configuration client icon from the Tektronix
MPEG Test System window

You can exit the application using one of the following two methods:

� Select Exit from the Session menu

� Click the close button in the upper-right corner of the application window
(shown below)

Close button

When you exit the application, the current configuration is preserved and used
the next time you start the application. In the default configuration, information
and error messages (up to 20 Mbytes) are automatically saved in the Win-
dows NT Event Viewer. No other information is saved.

Login Passwords
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Shutting Down the MTS200 Series System

CAUTION. Do not switch power off to your MTS200 Series system before the

message “It is now safe to turn off your computer” appears. Doing so may result
in lost data and difficulty in restarting Windows NT.

Perform the following steps to shut down the MTS200 Series system:

1. To avoid loss of data and possible problems during subsequent Windows NT
initialization, always shut down Windows NT before switching computer
power off. To shut down Windows NT, select Shut Down from the Start
menu (shown below).

2. Select Shut down the computer? in the resulting Shut Down Windows
dialog box (shown below) and then click Yes.

3. After a few seconds, the Shutdown Computer window appears with the
message that “It is now safe to turn off your computer.” You can now power
off the MTS200 Series system.
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Real-Time Analysis Performance Factors

The Analysis Server analyzes the input stream as it is received and attempts to
report errors as they are detected. When the Analysis Server cannot process and
display errors in real time, the Buffer filling bar in the Expert Client becomes
active. The Buffer filling bar (shown below) is located in the center of the Status
bar on the bottom of the Expert client application window. As buffer filling
increases, error and message displays are less timely.

The following factors determine the real-time performance of the test system:

� The number and type of errors in the stream

� The number and type of analyses that you have configured

� The host computer processor speed

NOTE. A test system running on a 120 MHz Compaq Prosignia platform is more

likely to use the buffer than one that is based on a 200 MHz, 266 MHz, or

300 MHz Compaq Proliant platform.

� The memory (RAM) that is available on the host computer. The computer
should have at least 32 Mbytes RAM; 64 Mbytes are standard on the
Proliant 1600

If the input stream contains many errors, you can reduce buffer filling by
limiting the number of analyses performed. Refer to Analysis starting on
page 3--1 for more information.
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Operating Basics

NOTE. If you are not familiar with the Windows NT 4.0 operating system, review

the Windows NT online help.

This section provides a functional overview and menu item descriptions of the
MTS200 Series MPEG Test System Expert and Configuration client modules.

The rear-panel connectors are described in theMTS200 Series Hardware and

Software Installation Technical Reference.

See the following sections for information about using the Expert and Configura-
tion clients and descriptions of the analyses performed by the Analysis Servers.

� The Expert Client Reference page 3--9

� The Configuration Client Reference page 3--61

� The Analyses Reference page 3--1
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Expert Client Display Elements

Figure 2--1 shows the different elements of the Expert Client display.

Hierarchic
view

Menu bar

View
Toolbar

Status bar

Title bar

Report view
toolbar

Client
area

Report view
hierarchic
view panel

Address
bar

Analysis
indicator

Report view
analysis

results area

Figure 2- 1: Expert Client display elements

The Title bar (see Figure 2--1) displays the following information:

� Name of the application in the window (EC is displayed for Expert Client)

� Address and I/O port number of the signal source (w-novo2.cse.tek.com is
the address and IO#1 is the I/O port number)

� Name of the view displayed in the Client area (in this example the Statistic
view is currently displayed)

The Expert Client control buttons are located on the far right side of the Title bar.

Title Bar
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The Menu bar provides access to the menus and contains the control buttons for
the Client area of the Expert Client display. Refer to Expert Client Menus on
page 2--8 for detailed descriptions of the menu functions available within the
Menu bar. The menus contain commands grouped by their functions:

� The active view menu performs standard Windows NT window-management
actions on the top (active) view in the Client area. You access this menu by
clicking the icon at the far left of the Menu bar.

� The Session menu lists commands that configure connection and display
parameters for the Expert Client.

� The View menu lists commands to manage and print the Expert Client
views.

� The Trace menu lists commands to control the manual capture of a transport
stream input. Refer to Manually Capturing a Transport Stream on page 3--10
for more information.

� The Window menu lists commands that control the appearance of open
windows in the Client area.

� The Help menu provides access to the online Help systems of the Expert
Client and the Analysis Server. In addition, there is a command to access the
version and copyright information for the Expert Client.

The Address bar contains two address boxes that allow you to specify which
Analysis Server and which I/O port you want the Expert Client to analyze (for
test systems with multiple inputs).

Enter the IP Address (or machine name) in the text box using one of the
following two formats:

� <MTS system IP address>

For example, enter 121.181.77.121 to analyze the signal from an MTS
system with an IP address of 121.181.77.121.

� <MTS system name>

For example, enter w-novo2.cse.tek.com to analyze the signal from an
MTS200 test system named w-novo2 on the cse.tek.com network.

The Server drop-down selection box lists the Analysis Servers you have
successfully connected to in the past. You can select an MTS200 test system
name or IP address from the drop-down selection box.

Menu Bar

Address Bar
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The command buttons in the View toolbar provide direct access to the most-used
menu commands for the Expert Client. Click a command button to perform the
associated command. You can toggle the View toolbar on and off using the
Toolbar command in the View menu. Table 2--1 lists the function of each icon in
the View toolbar.

Table 2- 1: Functions of the View Toolbar buttons

Button Name Function

Freeze views
(or pause)

Freezes (pauses) the updates to the current Expert Client display.
The analyses occurring on the input are not stopped, and the
history of the analyses is preserved while the views are frozen. This
button is equivalent to the Freeze Views command in the View
menu.

Report view Opens or selects the Report view located at the bottom of the
Expert Client display. This button is equivalent to the Report View
command in the View menu.

Statistic view Opens or selects the Statistic view in the Client area. This button is
equivalent to the Statistic View command in the View menu.

ETR 290 view Opens or selects the ETR 290 Monitor view in the Client area. This
button is equivalent to the ETR 290 View command in the View
menu.

Restore stan-
dard views

Restores the default Expert Client display, which consists of the
Hierarchic, Statistic, and Report views. This button is equivalent to
the Restore Standard command in the Window menu.

Start trace Starts moving transport stream data through the capture memory
buffer. This button is disabled until you enable a manual capture of
a transport stream (see Manually Capturing a Transport Stream
beginning on page 3--10).

Record trace Starts the manual capture of the transport stream input. This button
is disabled until you enable a manual capture of a transport stream.

Stop trace Stops the movement of transport stream data through the capture
memory buffer. This button is disabled until you enable a manual
capture of a transport stream and click the Record Trace button.

Refer to Manually Capturing a Transport Stream on page 3--10 for more
information about using the Stop trace, Record trace, and Stop trace buttons.

The Analysis indicator (shown below) at the far right of the Address bar is
animated when the Expert Client is actively analyzing the input stream. The
indicator is motionless when analysis by the Expert Client is disconnected.

View Toolbar

Analysis Indicator
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The Hierarchic view area displays the hierarchy of the transport stream as
indicated by the PSI/SI/PSIP tables. This view enables you to display specific
analyses, using shortcut menus associated with each transport stream item (you
access these menus by right-clicking the icons). Refer to Using the Hierarchic

View on page 3--12 for more information.

The Client area contains various views of the current analyses. There are three
basic views you can display in this area:

� The Statistic view is the default display for the Client area. There are six tabs
at the bottom of the Statistic view that you can use to display different
aspects of the transport stream analysis.

� The ETR 290 view shows the results of the ETR 290 analysis. You access
the ETR 290 view using the ETR 290 button on the View toolbar.

� The Analysis, Rate, and Report views show the result of specific analyses
being performed on the transport stream using various graphs. You open
these views using the Hierarchic view shortcut menus.

The Report view toolbar buttons allow you to change the display mode of the
Report view. Table 2--2 lists the functions of the toolbar buttons.

Table 2- 2: Functions of the Report View Toolbar buttons

Button Name Function

Program mode Groups analysis results by program name in the Report view
hierarchy.

ETR 290 mode Groups analysis results by ETR 290 priority level (priority 1, 2, 3
and Warning) in the Report view hierarchy.

Advanced mode Groups analysis results by error type (Multiplex, Syntax, Timing,
and Rate) in the Report view hierarchy.

Error mode Groups analysis results by user-defined error severity (Critical,
Major, Minor, and Warning) in the Report view hierarchy.

Close report
view

Closes the Report view.

Hierarchic View

Client Area

Report View Toolbar
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The Report view displays the results of the analyses performed by the Analysis
Server on the selected input. The Report view hierarchic display organizes the
analysis results according to the mode you select from the Report view toolbar:

� Program mode groups analysis results by program name.

� ETR 290 mode groups analysis results by ETR 290 priority level (priority
1, 2, or 3).

� Advanced mode groups analysis results by error type (Multiplex, Syntax,
Timing, or Rate).

� Error mode groups analysis results by user-defined error severity (Critical,
Major, Minor, and Warning).

The Analysis Results area has three types of views. The type of view displayed
depends on the type of icon selected in the Report view hierarchy:

� First level icon (a folder): Displays the Summary view (the default Report
view) which displays various summary information about the transport
stream being analyzed.

� Second level icon (a folder): Displays the Error Graph view which displays
graphs showing the number errors occurring on the transport stream. The
graphs are presented based on the mode of the Report view.

� Third level icon (changes depending on the mode): Displays the Message
view (first, second, or third level icon) which displays the text of error
messages. The error messages are presented based on the mode of the Report
view.

The second- and third-level icon views display the results of the transport stream
analysis organized based on the display mode selected from the Report view
toolbar (Program, ETR 290, Advanced, or Error).

Report View Hierarchic
View Panel

Report View Analysis
Results Area
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The Status bar displays short Help and status messages and also contains several
analysis indicators. The Status bar shows the following information:

� Help and status messages for menu and toolbar commands. In the Status bar
in Figure 2--1 on page 2--2, the message “For Help, press F1” appears.

� The status (percent usage) of the communication buffer. When the buffer
reaches 100% usage, you may need to remove probes to ensure that complete
measurements are made from the active probes.

� The number of bytes (188, 204, or 208) in the input stream transport packets.

� The global bit-rate of the input stream.

� Presence of priority one (PR1), priority two (PR2), and priority three (PR3)
ETR 290 errors. If no error is detected, a green LED icon is displayed; when
an error occurs, the LED icon becomes red. If the error stops, the LED icon
becomes orange to indicate that at least one error has been detected in the
past.

� Status of the TEI (Transport Error Indicator). The error indicator icon
follows the same color conventions as the PR1, 2, and 3 indicators. The icon
is gray when TEI analysis is disabled.

� State of the UNP (Unsynchronized Packet). The error indicator icon follows
the same color conventions as the MG1, 2, and 3 indicators. The icon is gray
when UNP analysis is disabled.

Status Bar
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Expert Client Menus

The menu bar (shown below) in the Expert Client display contains the command
menus (Active View, Session, View, Window, and Help). The following pages
describe the selections available within each of the menus.

The Active View menu performs standard Windows NT window-management
actions on the top view in the Client area. You can access this menu by clicking
the icon at the far left of the Menu bar when the Client views are maximized (the
example below shows the Statistic view icon).

Active view menu

The Menu bar icon representing the Active View menu changes to match the
type of view currently displayed in the Client area. When the panels in the Client
area are tiled, this menu can be accessed for each panel in the Client area.
Table 2--3 describes the menu selections available in the Active View menu.

Table 2- 3: Expert Client Active View menu commands

Command Function

Restore Changes all open Client area views to windows or icons within the Client
area, depending on the last state of each window. The Active View menu
icon disappears from the Menu bar when you select this command.

Move Moves the selected view within the Client area.

Size Resizes the selected view within the Client area.

Minimize Minimizes all open Client area views to icons within the Client area. The
Active View menu icon disappears from the Menu bar when you select this
command.

Maximize Maximizes all open Client area views. The Active View menu icon returns to
the Menu bar when you select this command.

Close Closes the active (top) Client area view.

Next Selects the next Client area view. This command is equivalent to clicking the
view tab to the right of the currently active view tab.

Active View Menu



Operating Basics

MTS 200 Series Real-Time Analyzer User Manual 2- 9

The Session menu contains commands for configuring the Expert Client settings,
for saving and loading analysis configurations, and for exiting the Expert Client.
Table 2--4 describes the menu selections available in the Session menu.

Table 2- 4: Expert Client Session menu commands

Command Function

Connection Opens the Connection dialog box where you can select an Analysis
Server and input to begin Expert Client analysis. This command is
only available when the Expert Client is not performing analysis.

Disconnection Disconnects the Expert Client from the Analysis Server and stops
analysis. You can still examine the displayed analysis results. When
you select this command, the analysis indicator (train icon) at the far
right of the toolbar becomes motionless.

Settings Opens the Settings configuration window. Refer to Configuring the
Expert Client on page 2--19 for information about using the Settings
window.

Load Restores a previously-saved analysis configuration.

Save as Saves the current analysis configuration.

Restore standard Restores the default settings for the Expert Client. This command is
only available when analysis is stopped.

Exit Stops analysis and exits the Expert Client.

Session Menu
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Use the View menu commands to control the information displayed in the Expert
Client. Table 2--5 describes the menu selections available in the View menu.

Table 2- 5: Expert Client View menu commands

Command Function

Freeze views Suspends (freezes) window updates while analysis continues.
Freezing the views allows you to examine or capture transitory
information (that is likely to soon disappear from the display) and to
find and examine error messages that have scrolled off the top of a
message window.

Report view Opens the Report view (if it is closed) or selects the Report view and
places it in front of all other views in the Client area, if necessary.

Statistic view Opens the Statistic view (if it is closed) or selects the Statistic view
and places it in front of all other views in the Client area, if necessary.

ETR 290 view Opens an ETR 290 view or selects the ETR 290 view and places it in
front of all other views in the Client area, if necessary.

Toolbar Toggle the presence of the View Toolbar (Command buttons) on and
off. A check mark precedes the command when the Toolbar is present.

Status bar Toggle the presence of the Status bar on and off. A check mark
precedes the command when the Status bar is present.

Print Prints the current window or window pane. In the Message view just
the contents of the message view are printed.

Print Setup Opens the Print Setup dialog box where you can configure the printer.

Use the Trace menu commands to control the manual capture of a transport
stream input. Refer to Manually Capturing a Transport Stream on page 3--10 for
more information the Trace menu commands. Table 2--5 describes the menu
selections available in the Trace menu.

Table 2- 6: Expert Client View menu commands

Command Function

Start trace Starts moving transport stream data through the capture memory
buffer. This button is disabled until you enable a manual capture of a
transport stream.

Record trace Starts the manual capture of the transport stream input. This button is
disabled until you enable a manual capture of a transport stream.

Stop trace Stops the movement of transport stream data through the capture
memory buffer. This button is disabled until you enable a manual
capture of a transport stream and click the Record Trace button.

View Menu

Trace Menu
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Use the Window menu commands to manage the various windows within the
Client area display. Table 2--7 describes the menu selections available in the
Window menu.

Table 2- 7: Expert Client Window menu commands

Command Function

Cascade Arranges windows in the Client area in an overlapping upper-left to
lower-right cascade. The active window is on the lower right.

Tile horizontally Arranges Client area windows as non-overlapping tiles that stretch
from left to right across the Client area.

Tile vertically Arranges Client area windows as non-overlapping tiles that stretch
from the top to bottom in the Client area.

Arrange icons Arranges minimized-view icons along the bottom of the Client area.

Restore standard Restores the default Expert Client window arrangement (will close all
Client area views except for the Statistic view).

(List of open Client
area windows)

Selects the Client area window to be shown in front of all other open
windows.

Use the Help menu to access to online help and Expert Client version informa-
tion. Table 2--8 describes the menu selections available in the Help menu.

Table 2- 8: Expert Client Help menu commands

Command Function

Expert Client help Opens the Expert Client online help.

Analysis Server help Opens the Analysis Server online help.

About Expert Client Displays Expert Client version and copyright information.

Window Menu

Help Menu
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The Expert client views and elements show the detailed results of analyses being
performed on one transport stream input. See Figure 2--2.

Client
area

Hierarchic panel of
the Report view

Messages panel of
the Report view

Address bar

Report view
toolbar

Hierarchic
view

Figure 2- 2: The Expert client application window

Note the following characteristics of the Expert Client window in Figure 2--2:

� The Hierarchic view shows the structure of the transport stream you are
monitoring. The hierarchy shown is based on the transport stream elements.
For instance, since the Program Map Table (PMT), and the program
elements the PMT references, are referenced by the Program Allocation
Table (PAT), the PMT icons are shown subordinate to the PAT icon.

� The Address bar shows that the Expert client is connected to the Analysis
Server analyzing the transport stream being input through I/O#1 on novo2.
You can select another Analysis Server on a remote machine by entering the
machine name or IP address in the Server text box, and then selecting an I/O
from the I/O list box.

Expert Client
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� The Client area is displays the Program Allocation panel, which is one of the
panel in the Statistics view. The Statistics view panels display statistical
information about the input stream to which the Expert client is connected.
Other views can also be displayed in the Client area. These views are
accessed using shortcut menus displayed when you right-click an icon in the
Hierarchic view.

� The Messages panel of the Report view shows the errors occurring on the
input selected in the Hierarchic panel of the Report view. You can display
more detail about a specific error by double-clicking the line on which the
error is reported.

� The Hierarchic panel of the Report view allows you to select different ways,
or modes, of displaying errors or statistics about the transport stream being
analyzed. The mode of the Report view is determined using the toolbar to
the left. The current mode is Program and FUN TV is selected.

� The Report view toolbar allows you to change the mode of the Report view.
Using this toolbar you can display errors grouped in one of four logical
modes: by program, ETR290 priority, error type, or error severity.
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Configuration Client Display Elements

Figure 2--3 shows the different elements of the Configuration Client display. The
display elements are described on the following pages.

Navigation
panel

Menu bar

Toolbar

Title bar

Configuration
panel

Address
bar

Analysis
indicator

Hexadecimal
check box

Profile
name

Figure 2- 3: Configuration Client display elements

The Title bar displays the following information:

� Name of the application in the window (in Figure 2--3, CC is displayed for
Configuration Client)

� Address and I/O port number of the signal source (in Figure 2--3,
128.181.99.193 is the address and IO#1 is the channel number)

The standard Windows NT window-sizing control boxes for the Configuration
Client are located on the far right side of the Title bar.

Title Bar
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The Menu bar (see Figure 2--3) provides access to the Session and Help menus.

Session menu. The Session menu contains commands for connecting or
disconnecting the Configuration Client, for saving and loading analysis
configurations, for starting and stopping the Analysis Server, and for exiting the
Configuration Client. Table 2--9 describes the menu selections available in the
Session menu.

Table 2- 9: Configuration Client Session menu commands

Command Function

Connection Opens the Connection dialog box from which you select the Analysis
Server that you will connect to.

Disconnection Disconnects the Configuration Client from the Analysis Server
indicated in the address bar. When you select this command, the
indicator (train icon) at the far right of the toolbar becomes
motionless.

New configuration Loads the default analysis configuration in the Configuration Client
(MPEG-2 analysis type, with no probes set). You must use the Apply
toolbar button or menu command to apply the setting changes to the
Analysis Server indicated in the address bar.

Load configuration Displays a dialog box from which you select saved configurations.
You must use the Apply toolbar button or menu command to apply
the setting changes to the Analysis Server.

Save configuration as Saves the current analysis configuration to the Windows NT registry.
A dialog box appears where you can enter a profile name.
Configurations are saved in the following directory in the registry:
HKEY_LOCAL_MACHINE\Software\Tektronix\MTS\Configu-
ration Client\1.0\Profiles.

Apply Applies the current Configuration Client parameters to the Analysis
Server that you are connected to.

Restart analysis server Stop and restarts the Analysis Server indicated in the address bar
(the one you are currently connected to).

Stop analysis server Stops the Analysis Server of the Analysis Server indicated in the
address bar (the one you are currently connected to).

Start analysis server Starts the Analysis Server indicated in the address bar.

Shut down server Displays the Shutdown dialog box. Using this dialog box, you can
restart or shut down the MTS200 system indicated in the address
bar. See Managing Remote Test Systems on page 3--65.

The shutdown.exe and shutgui.exe files need to be installed locally in
the C:\MTS200\bin directory for this menu item to be active.

Exit Exits the Configuration Client.

Menu Bar
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Help menu. The Help menu provides access to the online Help systems of the
Configuration Client and the Analysis Server. In addition, there is a command to
access the version and copyright information for the Configuration Client.
Table 2--10 describes the menu selections available in the Help menu.

Table 2- 10: Configuration Client Help menu commands

Command Function

Configuration Client help Opens the Configuration Client online help.

Analysis Server help Opens the Analysis Server online help.

About Configuration Client Displays Expert Client version and copyright information.

The command buttons in the Toolbar provide direct access to the most-used
menu commands for the Configuration Client. Click on a command button to
perform the associated command. Table 2--11 lists the function of each icon in
the Toolbar.

Table 2- 11: Functions of the Configuration Client Toolbar buttons

Button Name Function

New configuration
(CTRL+N)

Loads the default analysis configuration in the Configuration
Client (MPEG-2 analysis type, with no probes set). You must
use the Apply toolbar button or menu command to apply the
setting changes to the Analysis Server indicated in the
address bar.

Load configuration
(CTRL+L)

Displays a dialog box from which you select saved
configurations. You must use the Apply toolbar button or menu
command to apply the setting changes to the Analysis Server.

Save configuration
as (CTRL+S)

Saves the current analysis configuration to the Windows NT
registry. A dialog box appears where you can enter a profile
name.

Configurations are saved in the following directory in the
registry: HKEY_LOCAL_MACHINE\Software\Tektro-
nix\MTS\Configuration Client\1.0\Profiles.

Apply
(CTRL+A)

Applies the current Configuration Client parameters to the
Analysis Server you are connected to.

If you have loaded a saved analysis configuration, this box will list the name of
the saved configuration. Otherwise the box will be blank.

Toolbar

Profile Name
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The Address bar contains two address boxes that allow you to specify which
Analysis Server and which I/O port (for test systems with multiple inputs) you
want the Configuration Client to analyze.

Server list box. Enter the IP Address (or machine name) in the Server text box
using one of the following two formats:

� <Test system IP address>

For example, enter 121.181.77.121 to analyze the signal on an MPEG test
system with an IP address of 121.181.77.121.

� <Test system name>

For example, enter jam20.cse.tek.com to analyze the signal from a test
system named jam20 on the cse.tek.com network.

The Configuration Client saves machine names and IP addresses that you have
successfully connected to in the past. You can select an MTS200 system name or
IP address from the drop-down selection box.

I/O list box.Use the I/O list box to select the I/O port to which you want to
connect. You can only connect to I/O ports that have been assigned to an
Analysis Server. The I/O drop-down selection box uses icons to indicate which
application is assigned to each I/O port.

The Analysis indicator (shown below) at the far right of the Address bar is
animated when the Expert Client is actively analyzing the input stream. The
indicator is motionless when analysis by the Expert Client is disconnected.

Use the Navigation panel to select which configuration panel to open. Use
standard Windows NT hierarchy navigation techniques to move through the
available panels.

Displays the configuration panel selected in the Navigation panel. Each
configuration panel displays analysis options related to different aspects of the
transport stream.

Select the Hexa Display option to display all appropriate values in the Configu-
ration Client in hexadecimal base. Clear the check box to display decimal values.
This option appears on each configuration panel and affects all configuration
panel displays.

Address Bar

Analysis Indicator

Navigation Panel

Configuration Panel

Hexadecimal Check Box
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The Configuration client views and elements allow you to quickly and easily set,
modify, and remove probes for analyzing and monitoring transport stream inputs.
See Figure 2--4.

Address bar

Navigation
panel

Selection Indicator bar

Configuration
panel

Figure 2- 4: The Configuration client application window

Note the following characteristics of the Configuration client window in
Figure 2--4:

� The Navigation panel allows you to quickly choose the category of error for
which you want the Analysis Server to probe.

� The Address bar shows that the Configuration client is connected to the
Analysis Server that is analyzing the transport stream being input through
I/O#2 on oxford6.

� The Selection Indicator bar shows the item currently selected in the
Navigation panel.

� The Configuration panel allows you to specify probes or configure analyses
for the Analysis Server indicated in the address bar. This panel changes
depending on the item selected in the Navigation panel.

Configuration Client
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Configuring the Expert Client Views

NOTE. The Expert Client displays the analyses of only one transport stream at a

time.

You can configure different aspects of the Expert Client display using the
Settings configuration window. You access the Settings configuration window by
selecting Settings from the Session menu. The Settings window contains the
following four configuration panels: View, Report View, Graphics View, and
PID Allocation View.

The following options appear on each of the Settings panels:

Hexa display.Use the Hexa display check box to set the PID and other values to
be displayed in hexadecimal or decimal format in the Expert Client display and
in the Settings panels. When cleared, values are displayed in decimal format.

Restore default. Click this button to restore the default configuration selections
for the displayed panel.

Select View in the Settings window hierarchy to open the View configuration
panel (see Figure 2--5). The View panel contains the following option:

Default view on start.Use the Report view check box to select or deselect the
Report view to be visible when the Expert Client is started. When cleared, this
option causes only the Hierarchic view and the Client area to occupy the Expert
Client window when you start the Expert Client.

Select View:Report in the Settings window hierarchy to open the Report View
configuration panel (see Figure 2--6). Use this panel to limit the types of
messages displayed in all report message views.

Common Options

View Panel

Report View Panel
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Figure 2- 5: View panel in the Settings window

Figure 2- 6: Report View configuration window
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The Report View panel (see Figure 2--6) contains the following configuration
options:

Information messages. Selected by default, this option alerts you to input stream
events that are not considered errors, but may be important to your stream
analysis. These events include as PSI and SI table updates, the presence of ghost
(unreferenced) packets, and error disappearance. Clear the Information messages
check box to prevent the display of these information events.

TDT and TOT update message.Not selected by default, this option lets you see
information messages that report TDT (time and date table) and TOT (time offset
table) updates.

STT update messages. This option is only valid when ATSC mode is selected in
the Analysis configuration panel in the Configuration Client (refer to Analysis

Panel on page 3--69).

DSMCC multiprotocol update messages. This option is only valid when
SIDAT 360 data broadcasting analysis is selected in the Analysis configuration
panel in the Configuration Client (refer to Analysis Panel on page 3--69). Select
this option to inform you of errors and events detected in a SIDAT 360 stream.
Clear this option when the message rate is too high.

Data carousel module update messages. This option is only valid when
SIDAT 360 data broadcasting analysis is selected in the Analysis configuration
panel in the Configuration Client (refer Analysis Panel on page 3--69). Select this
option to inform you of errors and events detected in a SIDAT 360 stream. Clear
this option when the message rate is too high.

EMM update message.Not selected by default, this option lets you see informa-
tion messages that report EMM (Entitlement Management Message) updates.

Select View:Graphics in the Settings window hierarchy to open the Graphics
View configuration panel (see Figure 2--7). Use this panel to set options that
determine how the Expert Client updates the various analysis graphs.

The Graphics View panel contains the following configuration options:

Scrolling option. In the standard configuration, scrolling is disabled for all graph
types. You can enable (selected) or disable the scrolling mode for each of the
listed views. The scrolling mode causes the data in the display to be updated
from right to left without using a cursor.

Background gradation option. You can change the background color of the
Statistic view by clicking the Statistic view background gradation check box.

Hierarchic view. Select this option to display the transport stream using small
icons. By default, the stream components are displayed using large icons.

Graphics View Panel
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Figure 2- 7: Graphics View configuration window

Bar graph bounds option. The bar graphs displayed in the Program Allocation
view (first panel of the Statistics view) can be configured, specifically for the
lower and higher bound values. You need to make these changes in order to draw
an accurate comparison between all the bar charts displayed.

If you need to display the bar graphs as histograms, for example, to compare the
values with each other, select Zero for the Lower Bound Value option (default
selection), and select Overall maximum value for the Upper Bound Value option
(default selection).

If you need to accurately assess the change of a value, select Minimum value for
the Lower Bound Value option, and select Maximum value for the Upper Bound
Value option.

Program alloc pie-chart option.Use this option to hide the pie-chart in the
Program Allocation panel of the Statistic view by unchecking the box (in order
to display the bar graphs as histograms, for instance).
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Select View:PID Allocation in the Settings window hierarchy to open the
PID Allocation View configuration panel (see Figure 2--8). Use this panel to
select which PIDs are displayed in the PID Allocation panel of the Statistic view
in the Client area when you select the Selection button.

NOTE. When you add and remove PIDs directly from the PID Allocation panel by

dragging and dropping stream icons between the Hierarchic view and the PID

Allocation panel, the PID Allocation View panel automatically updates.

Figure 2- 8: PID Allocation View configuration window

The PID Allocation View panel contains the following configuration options:

Display all PID. Select this option to display all PIDs in the transport stream.

Display selected PID. Select this option to display only the PIDs in the transport
stream that you select in the PID Allocation View configuration panel. After you
select Display selected PID, use the following methods to select PIDs to display:

� You can select a specific PID number from the top list box. Apply this
choice by clicking the Add button.

� You can select a group of PID such as PSI, SI or a specific Program in the
bottom list box. Apply this choice by clicking the Add button.

PID Allocation View Panel
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� You can remove a PID in the Selected PIDs list box by selecting the PID and
clicking the Remove button or double-clicking the PID.

� You can remove all the PIDs in the Selected PIDs list box by clicking the
Remove All button.
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Reference

This section is a complete reference to the MTS200 Series Expert and Configura-
tion client modules. Together, these two clients provide the same functionality as
the MTS200 Series Version 3.0 Real--Time Analyzer, with additional ARIB table
analysis capablities. The information in this section is organized as indicated in
the following list:

� This Reference section explains why monitoring transport stream inputs is
important and briefly describes the terms MPEG-2, DVB, ATSC, and
ISDB-S/ARIB. This section also explains client-server computing as it
relates to the MTS200 system software modules and describes the two server
modules enabled by the test system software.

� The Expert Client Reference (see page 3--9) provides procedures for
displaying and analyzing errors on transport stream inputs. It also describes
the Expert Client views, panels, menus, icons, and toolbar buttons.

� The Configuration Client Reference (see page 3--61) provides procedures for
setting, modifying, and removing probes on transport stream inputs. This
section also describes the Configuration Client panels, menus, icons, and
toolbar buttons.

� The Analyses Reference (see page 3--1) describes all of the MTS200 system
analyses performed by the Analysis Servers. This section also provides
procedures for setting, modifying, and removing the user-controlled
analyses, called probes.

See Operating Basics for basic operating procedures for starting, logging on to,
and stopping the test system.

See Appendix B: Networking for information about installing MTS200 test
systems in networked environments and basic network troubleshooting
procedures.

Finally, see theMTS200 Series Hardware and Software Installation Technical

Reference manual for hardware and software installation procedures, for
complete electrical, mechanical, and environmental specifications, and for the
safety compliance information for the MTS200 Series.
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MPEG Overviews

This section provides some brief overviews of MPEG monitoring and the types
of transport streams monitored and analyzed by the MTS200 system.

In today’s compressed digital TV environments you can think about operational
monitoring requirements in terms of layers:

� Information layer. Is the information correct and of suitable quality?

Monitoring the information layer is an extension of picture quality
measurements in the compressed digital realm.

� Transmission layer. Does the signal itself conform to standards?

Monitoring the transmission layer is standard practice in all transmission
systems: cable, terrestrial, and satellite.

� Protocol layer. Can the transmitted data be decoded at the destination?

Monitoring the protocol layer is a requirement of MPEG transmission
systems. This functionality is provided by the Master Client, which is a
component of the Tektronix MTS300 MPEG Test System and the Tektronix
MTM300 and MTM301 MPEG Transport Monitors.

The protocol layer provides the following functionality:

� Metadata. Metadata refers to information about the transport stream that is
carried by the transport stream such as PSI and SI or PSIP tables. This
information describes the multiplex and the transmission environment
completely so that the IRD (integrated receiver/decoder) can decode the
transport stream correctly. Metadata is specified in the appropriate MPEG,
DVB, ATSC, and ISDB--S/ARIB standards.

� Timing information. Timing information is used by the IRD to decode and
present the data correctly (at the right times and in the right sequence).
Timing information is carried in both the transport stream layer and the
elementary stream layer.

MPEG monitoring is used to verify that the transport stream you are transmitting
conforms to the appropriate MPEG-2, DVB, ATSC, and ISDB-S/ARIB
standards. The following list describes operational monitoring requirements that
you may have for your environment:

� Ensure that transmitted data is free of defects and can be decoded
appropriately at the destination. This monitoring task is performed by the
Master client, which is a component of the Tektronix MTS300 MPEG Test
System and the Tektronix MTM300 and MTM301 MPEG Transport
Monitors.

MPEG Operational
Monitoring
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� Identify specific errors so you can isolate the source of errors quickly. This
analysis task is performed by the Expert Client.

� Specify monitoring parameters for transport streams in ways that make sense
to you. This configuration task is performed by the Configuration Client.

MPEG stands for Motion Picture Experts Group. Among the standards
developed by this ISO body are the set of standards describing Transport Stream
System Target Decoders (T-STD) with defined behaviour when handling video,
audio, or data elementary streams or when handling PSI (Program Specific
Information) packets. By defining a T-STD, the output of encoders and
multiplexers is implied. Consequently, the output of any valid MPEG-2 encoder
or multiplexer can be used as input to another manufacturer’s decoder or
multiplexer.

MPEG-2 transport streams are two layer structures: the Compression layer (for
encoded audio, video, and data elementary streams) and the System layer (for
timing and describing different elements of the multiplexed transport stream and
the network over which it is carried).

Valid MPEG-2 transport streams require certain information that describes the
content and organization of transport streams and certain characteristics of the
network over which the transport stream is carried. This information is called
Program Specific Information (PSI) and is carried in table structures:

� Conditional Access Table (CAT)

� Network Information Table (NIT)

� Program Association Table (PAT)

� Program Map Table (PMT)

� Transport Stream Descriptor Table (TSDT)

See the MPEG-2 standards documents for more specific information about
encoding elementary streams, multiplexing transport stream elements, and these
transport stream structures.

One of the strengths of the MPEG standards is that they are generic and can be
adapted to different broadcast environments. Three groups, the Digital Video
Broadcasters (DVB), the Advanced Television Systems Committee (ATSC), and
the Association of Radio Industries and Business (ARIB) have created MPEG-2
compliant standards that are used in DVB, ATSC, and ISDB-S/ARIB markets.

MPEG-2
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DVB stands for Digital Video Broadcasting. DVB standards define MPEG-2
compatible transport streams used in DVB markets. The DVB standards define
baseline systems for cable (DVB-C), terrestrial (DVB-T), and satellite (DVB-S)
transmission environments.

Like the MPEG standards, the DVB standards describe both the compression
layer (for encoded audio, video, and data elementary streams) and the system
layer (for timing and describing different elements of the multiplexed transport
stream and the network over which it is carried) of DVB transport streams.

The DVB standards define additional service information (SI) used to describe
the network, transport stream, and services carried by the transport stream. This
additional information is provided by the following table structures:

� Bouquet Association Table (BAT)

� Event Information Table (EIT)

� Network Information Table (NIT)

� Running Status Table (RST)

� Service Description Table (SDT)

� Time and Date Table (TDT)

� Time Offset Table (TOT)

� Discontinuity Information Table (DIT)

� Selection Information Table (SIT)

See the DVB standards documents for more specific information about these
transport stream structures.

DVB
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ATSC stands for Advanced Television Systems Committee. ATSC standards
were developed by the ATSC Technology Group on Distribution (T3). These
standards define baseline systems for cable and terrestrial environments. ATSC
transport streams are valid MPEG-2 transport streams.

Like the MPEG standards, the ATSC standards describe both the compression
layer and the system layer for ATSC transport streams. The compression layer
refers to the encoded audio, video, and data elementary streams; the system layer
refers to timing information and descriptions of different elements of the
multiplexed transport stream and the network over which it is carried.

The ATSC standards define additional information required for ATSC environ-
ments. This information is carried in the following program and system
information protocol (PSIP) table structures:

� Event Information Table

� Extended Text Table

� Master Guide Table

� System Time Table

� Rating Region Table

� Virtual Channel Table

See the ATSC standards documents for more specific information about these
transport stream structures. One of the ATSC standard documents (ATSC
Document A/58) describes how to ensure that valid ATSC transport streams are
also valid DVB transport streams (conforming to DVB standards).

ATSC
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ARIB stands for the Association of Radio Industries and Business. ARIB
standards define elements (carried in table structures) for managing ARIB-com-
pliant transport streams (these are the ARIB structures analyzed by the MTS200
system):

� Broadcaster Information Table

� Download Control Table

� Download Table

� Software Download Trigger Table

ISDB-S/ARIB transport streams are MPEG-2 compliant streams that conform to
the ITU-R standard for ISDB-S (Integrated Service Digital Broadcasting,
Satellite) multiplexing. An ISDB stream uses TMCC (Transmission and
Multiplexing Configuration Control) data multiplexed in the first eight bytes of
the 16 Reed-Solomon bytes of 204 byte MPEG-2 transport streams. TMCC
information is used to manage the modulation parameters of the transponders in
digital broadcast environments that include multiple broadcasters and types of
services with different transmission requirements.

NOTE. The MTS200 MPEG Test System offers only limited ARIB table section

analysis. To analyze Baisc and Data TMCC transport streams in real time, you

need to upgrade your system to the Tektronix MTS300 MPEG Test System.

ARIB/ISDB Overview
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Client-Server Overview

This section briefly describes client-server software architecture and the Analysis
Server enabled by the MTS200 system software.

The client-server software architectural model allows software to be developed
into two or more modules:

� The server module performs CPU intensive operations, runs in the back-
ground (or remotely), and responds to requests from clients. Usually requests
are due to some action you have taken.

� The client module is often a graphical user interface that allows you to
configure or display the status of the server module.

The MTS200 system uses three servers (MPEG Analysis Server, TMCC
Analysis Server, and Real-Time Multiplexer Server) to perform protocol analyses
and generate transport stream output.

The MTS200 test system uses the following client modules to disiplay the
results of and to configure the server functions:

� Expert Client

� Configuration Client

� TMCC Expert Client (deferred--time analysis only, installed when you
purchase deferred--time analysis options or upgrades)

� TMCC Configuration Client (deferred--time analysis only, installed when
you purchase deferred--time analysis options or upgrades)

� OpenMux (MTS205 or MTS215, Option OM only)

Combined, the client and server modules enable you to perform in-depth
analyses of one transport stream input; configure the monitoring and reporting
parameters of the monitored inputs; and to multiplex transport streams for
output.

The Analysis Servers are the processes that perform the actual analyses on
transport stream inputs.

Each Analysis Server interacts with the following entities as described:

� The Expert client displays the results of the Analysis Server.

� The Configuration client sets the monitoring and analysis parameters for
inputs.

Client-Server

Analysis Servers
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Expert Client Reference

The Expert Client application is a full-featured, MPEG-2 protocol analyzer
capable of analyzing transport streams in real time.

NOTE. The Expert Client displays the analyses of only one transport stream at a

time.

The MTS200 Series Expert Client offers only limited ARIB table section analysis.

If you want to analyze TMCC TS streams in real-time, you need to upgrade your

system to the Tektronix MTS300 MPEG Test System.

The Expert Client has the following characteristics:

� Graphical displays that show the structure (hierarchy) of the input transport
stream and display characteristics of each component of the input stream
(for example: PID and type allocation, section rate analyses, and timing
analyses).

� Report views that indicate the types of errors recorded by the Analysis
Server and the characteristics of the input stream.

� Error views that show specific errors recorded for the various components
of the transport stream; for instance, PMT section rate errors and ETR 290
errors.

The Expert Client displays the results of only one Analysis Server (input) at a
time. However, you can connect more than one Expert Client to the same
Analysis Server. (The Analysis Servers is the server component that performs
analyses, the Expert Client is the client component that displays analysis results.)

This section describes the Expert Client in the following subsections:

� Expert Client Display Elements page 2--2

� Expert Client Menus page 2--8

� Manually Capturing a Transport Stream page 3--10

� Configuring the Expert Client Views page 2--19

� Using the Hierarchic View page 3--12

� Using the Report View page 3--18

� Using the Client Area page 3--34
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Manually Capturing a Transport Stream

Using the Expert Client, you can manually capture a transport stream input. Use
the Event Configuration panel of the Configuration Client to enable a manual
capture, and then use the Trace menu commands or toolbar buttons to control a
manual capture from the Expert Client.

NOTE. This procedure is for manually capturing transport stream input. Refer to

Configuration Client Reference starting on page 3--61 for information about

configuring the test system to trigger a data capture on user-defined transport

stream events.

Perform the following steps to manually capture a transport stream:

1. Launch the Configuration Client for the transport stream input you are
monitoring.

2. Open the Event Configuration panel of the Configuration Client (expand
the Data Storage item in the navigation panel of the Configuration Client).

3. Use the Current Input Used Size slide bar to set the size of the capture file
in kBytes. You can set the capture size to a value up to the amount listed in
the Overall Available Size box (determined by the available room on the
SCSI drives).

NOTE. You must set a capture size greater than 0 KB to enable a capture.

4. Verify that theManual stop of acquisition event is enabled in the Message
list.

5. Right-click the File column of theManual stop of acquisition row, and
then click Configure from the shortcut menu to open the Event Settings
dialog box.

6. In the Event Settings dialog box, use the File name box to enter the name of
the capture file. The default file name is RTA.trp, and it will be written to the
Single Shot partition on the Data Store disk (C:/CARB/MONO). Alterna-
tively, enter the complete path (to a local directory) for the file you want to
write in the text box. Remember to ensure that you have adequate disk space
and that you have write permission in this location.

7. Use the Before Event and After Event boxes to set the amount of transport
stream data captured before and/or after you initiate the capture event. For
example, if you set the Before Event value to 1024 and the After Event
Value to 2048, the captured file will include 1024 KB of data preceeding and
2048 KB of data following the moment you initiate the capture.
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8. Click Center Trace if you want to save the same amount of data before and
after the capture occurs. The size of the file will be the size you set in the
Current Input Used Size selection box in the Event Configuration panel in
step 3.

9. Click the appropriateMax button to save data up to the amount you set in
the Current Input Used Size selection box in the Event Configuration panel
in step 3, before or after the capture event occurs.

10. Click OK after you finish configuring the Event Settings dialog box.

11. If desired, open the Filtering panel of the Configuration Client to select
specific PIDs to capture.

12. After you have completed the capture configuration, click the Apply toolbar
button to enable the new Event Configuration settings.

13. Click Restart now to restart the Expert Client. The Start Trace shortcut
button is now enabled (highlighted) in the Expert Client window.

14. Click Start Trace in the Expert Client window to begin moving transport
stream data through the event--capture buffer.

15. Click Record Trace to initiate a transport stream capture, or click
Stop Trace to stop the capture process without recording a file.

The capture point in a captured transport stream file will be based on your
capture configuration as set up in the Event Configuration panel of the
Configuration Client.
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Using the Hierarchic View

The Hierarchic view displays the contents of the transport stream as a hierarchi-
cal structure based on the PSI and SI, PSIP, and ARIB tables. Each item in the
transport stream is located in the hierarchy to show its relationship to other
transport stream items. You can click the hierarchy boxes to show or hide
lower-level hierarchy items. See Figure 3--1.

Selected
hierarchy

item

Click the box to
show or hide
lower level

hierarchy items

Shortcut menu
for the selected
hierarchy item

Level 3: Elementary streams (video, PES...), private, ECM

Level 2: MPEG2-NIT, PMT, EMM (CAT) tables

Level 1: PSI/SI/PSIP/ARIB tables

Additional information about the item

PID of the item

Type of the transport stream item

Figure 3- 1: Expert Client hierarchic display
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To the right of each hierarchy icon is text that shows the type of the transport
stream item. The hierarchic display includes columns which display the PID of
the item and additional information about the item. The type of additional
information that is listed depends on the type of the transport stream item.
Figure 3--2 describes the specific information displayed for the various transport
stream item types.

Transport stream ID
as read in the PAT.

Frequency of the transport stream
as read in the
satellite_delivery_system_descriptor
of the NIT.

Network name as read in the
network_name_descriptor
of the NIT.

Polarization as read in the
satellite_delivery_system_descriptor
of the NIT.
LH = linear horizontal
LV = linear vertical
CL = circular left
CR = circular right

Transport Stream Items

PAT Items

Number of programs defined in the PAT
and described in the sub-levels of the
hierarchy.

PMT Items

Program number
as read in the PAT.

Service name
as read in the SDT.

System ID and name of
the encryption service.

ECM/EMM Items

Figure 3- 2: Specific information displayed for transport stream items
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Table 3--1 summarizes the effects of mouse and keyboard actions that change the
appearance of the Hierarchic view and show (or hide) additional information
about the input stream.

Table 3- 1: Mouse and keyboard actions in the Hierarchic view

Mouse action Keyboard action Effect on Hierarchic view

Left-click an icon Selects the icon.

Right-click an icon Displays a shortcut menu for the
hierarchy item. Refer to Hierarchic Icon
Shortcut Menus on page 3--17.

Double-click an icon Opens an item Report view in the Client
view.

Click the + box next to
an icon

Press + on the numeric
keypad

Displays one sub-level (if any) below the
selected icon.

Click the – box next to
an icon

Press – on the numeric
keypad

Collapses the sub-level below the
selected icon (will not override the F7
through F10 selections explained below).

Press * on the numeric
keypad

Opens all sub-levels below the selected
icon.

Press the up or down
arrow key

Selects the icon immediately above or
below the currently-selected icon.

Press F1 Opens the Expert Client online Help.

Press F2 Toggles the numeric display between
hexadecimal and decimal (for example,
0x00C1↔ 193).

Press F3 Freezes or unfreezes the updates to the
displayed views (analysis does not stop
when the views are frozen).

Press F7 Expands or collapses the hierarchic view
to only display the first-level icons.

Press F8 Expands or collapses the hierarchic view
to only display the first and second-level
icons.

Press F9 Expands or collapses the hierarchic view
to only display the first, second, and
third-level icons.

Press F10 Expands or collapses the hierarchic view
to display the first, second, third, and
fourth-level icons.

Setting the Appearance of
the Hierarchic View
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The Expert Client uses a variety of icons to represent stream items. Each of the
hierarchic icons has an associated menu that allows you to perform specific
functions related to the stream item. Table 3--2 identifies the icons used in the
Hierarchic view.

If an item is referenced in a table, but not found in the stream, the icon is grayed.

Table 3- 2: Hierarchic view icon identification

Icon
Hierarchy
level Element type

1 Transport stream. This icon represents all (188/204/208-byte)
transport packets that make up the stream. If you visualize the
transport stream as a train, this icon represents every car in the
train, regardless of its configuration or what it contains.

2 PAT, CAT, or TSDT table.

2 Any other table except ATSC PSIP tables (such as DVB-SI or
ISDB-S/ARIB).

2 ATSC-PSIP tables (such as CVCT, TVCT, MGT, STT, and RRT).

2 A specific transport packet (such as MIP).

2 GHOST. A ghost indicates one or more transport packets
identified with a PID that is not referenced in an appropriate table.

3 PMT table.

3 MPEG-2 NIT table.

3 For ATSC: EIT and/or ETT tables referenced by MGT.

3 EMM table.

4 Video stream.

4 Audio stream.

4 Data stream.

4 ECM table for program.

Identifying Hierarchic
Icons
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Table 3- 2: Hierarchic view icon identification (Cont.)

Icon Element type
Hierarchy
level

4 For SIDAT 360 streams: DownloadInfoIndication tables for
one-layer Data Carousels.

4 For SIDAT 360 streams: DownloadServerInitiate tables for
two-layer Data Carousels.

4 For SIDAT 360 streams: Multiprotocol Encapsulation sections.

4 DSM-CC generic stream (may carry several tables).

4 Private table.

5 ECM table for elementary stream.

5 For SIDAT 360 streams: DownloadInfoIndication tables for
two-layer Data Carousels.

5 For SIDAT 360 streams: Data Carousel module (one-layer Data
Carousels).

6 For SIDAT 360 streams: Data Carousel module (two-layer Data
Carousels).

PCR clock and scrambling symbols.A PCR clock ( ) symbol is added to the
upper-right corner of stream icons to indicate which stream in a program or
service is carrying PCR clocks.

A padlock symbol ( ) is added to the lower-left corner of stream icons to
signify the streams that are scrambled.



Expert Client Reference

MTS 200 Series Real-Time Analyzer User Manual 3- 17

Each active hierarchy item that is represented by an icon has a shortcut menu that
enables you to learn more about the selected item. Right-click an icon to display
the shortcut menu, and then select a menu command. Table 3--3 describes the
commands you will find in the shortcut menus.

Table 3- 3: Hierarchic view menu commands

Command Description

View section analysis Opens a section view window for the transport stream table
selected in the hierarchic view. Refer to Section Analysis View on
page 3--50.

Section analysis will be performed only if a section probe is set
from the Configuration Client.

View section rate Opens a section rate view in the Client area for the transport
stream table selected in the hierarchic view. Refer to Section Rate
View on page 3--52.

Section rate analysis will be performed only if a section rate probe
is set from the Configuration Client.

View PCR analysis Opens a PCR analysis view for the selected program in the Client
area. Refer to PCR Analysis View on page 3--53.

This command is available for PMTs and independent PCRs only.
The analysis will be performed only if a timing (PCR) probe is set
from the Configuration Client.

View PTS/DTS analysis Opens a PTS/DTS analysis view for the selected video or audio
elementary stream in the Client area. Refer to PTS/DTS Analysis
View on page 3--56.

This command is available for video and audio streams only. The
analysis will be performed only if a timing (PTS/DTS) probe is set
from the Configuration Client.

View IP traffic Opens an IP traffic monitor view for the selected item in the Client
area. Refer to IP Monitoring View on page 3--60.

This command is available for DSM-CC private sections and
SIDAT 360 multiprotocol encapsulation streams only. The analysis
will be performed only if a section probe is set on those streams
from the Configuration Client.

View transport or section
report

Opens an error message window for the selected stream item in
the Client area, or brings an already-opened error message view
to the front of the Client area views.

This command is available for all stream items.

Hierarchic Icon Shortcut
Menus
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Using the Report View

The Report view (see Figure 3--3) occupies the bottom of the default Expert
Client application window. Using the Report view, you can display all analysis
results or only selected results. You can set the Expert Client to display the
Report view by default using the View panel of the Settings window.

The Report view consists of three primary elements: Report view toolbar,
hierarchic view panel, and the analysis results area panel.

� Report View Toolbar. Click a Report view toolbar button to quickly change
the display mode of the hierarchic view panel.

� Hierarchic View Panel. Use this panel to select which analysis results are
displayed in the analysis results area, to select how the analysis results are
displayed, and to acknowledge error messages.

� Depending on the item selected in the hierarchic view panel, the analysis
results area can contain a summary view, a graph view, or a message view.

Hierarchic view panel Analysis results area panelReport view toolbar

Figure 3- 3: Report view display

By default, the Report view occupies the bottom of the Expert Client display
(this is called the “docked” state). You can toggle the location of the Report view
to the Client area using the Toggle Docking command.

Right-click in the white space of the Report view Hierarchic panel and select
Toggle Docking from the shortcut menu (repeating this step returns the Report
view to the default position).

Positioning the Report
View
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The Report view toolbar buttons allow you to quickly change the display mode
of the Report view. These buttons duplicate the commands in the shortcut menu
of the hierarchic view panel in the Report view. Table 3--4 lists the functions of
the toolbar buttons.

Table 3- 4: Functions of the Report View Toolbar buttons

Button Name Function

Program mode Groups analysis results by program name in the Report view
hierarchy.

ETR 290 mode Groups analysis results by ETR 290 priority levels (priority 1, 2, 3
and Warning) in the Report view hierarchy.

Advanced mode Groups analysis results by error type (Multiplex, Syntax, Timing,
and Rate) in the Report view hierarchy.

Error mode Groups analysis results by user-defined error severity (Critical,
Major, Minor, and Warning) in the Report view hierarchy. Set the
severity level using the Message Level panel in the Configuration
Client. Refer to Message Level Panel on page 3--93.

Close report
view

Closes the Report view.

The Report view displays the results of the analyses performed by the Analysis
Server on the selected input. The hierarchic view panel gives you access to the
following different views of the transport stream analysis:

� A summary of all the analysis results, which displays summary statistics of
the transport stream.

� A graph of the errors that have occurred on the transport stream (current and
past).

� A listing of the unacknowledged error messages for the selected item.

Hierarchy icons and levels. The hierarchic view panel in the Report view displays
a hierarchic view of analysis results. The hierarchy display changes depending
on the report display mode. The hierarchic view panel is a three-level display,
and uses the Windows NT conventions for collapsing and expanding directory
structures. The default display for the panel is to show the complete three level
hierarchy.

Report View Toolbar

Report View Hierarchic
View Panel
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Each hierarchic view, regardless of the display mode, has the following
characteristics in common:

� Top Level Icon (Folder). The top level of the hierarchy displays a new folder
each time a new synchronization event occurs. The top level folder repre-
sents a Configuration. A Configuration is a collection of all analysis results
since the previous synchronization. Listed next to the top level icon is the
time of the synchronization event and the running total of errors detected.
When you select a first level icon, the Analysis Results area changes to
display the default summary view.

When the Expert Client loses sync with the signal, the number of errors
represents the total that occurred while the Expert Client was connected and
synched to the input. The history of each input is maintained in the folders
from previously synched sessions. You can delete all or some of these
folders by right-clicking in the report view and making the appropriate
selection from the shortcut menu.

NOTE. The Expert Client creates a new Configuration every time synchronization

is established. Therefore, if you stop and restart analysis, or if the Expert Client

loses and regains synchronization for any reason (such as a momentary loss of

the input signal), another Configuration icon appears in the hierarchic view.

� Second Level Icons (Folder, Other, and Internal). The second level of the
hierarchy displays a folder representing the organization (report mode) of the
error messages you have chosen. When you select an icon at this level, the
Analysis Results area to the right of the Report view updates to display
graphs representing the average number of errors occurring on the transport
stream.

The second level Other icon contains messages that are not related to the
selected report mode.

The second level Internal icon contains the following messages when
appropriate:

� Hardware Input Overflow. This message appears when the user has set
too many probes for the corresponding Analysis Server input.

� Extraction stopped for PID <n>. This message appears when the
requested measurements for PID <n> exceed system resources. The
message indicates that incomplete measurements should be expected for
PID <n>(for example, only some of the subtables of an SI table would
be available for section analysis). When you see this message, you must
removes probes from PID <n> in order to make complete measurements.

� Third Level Icon. The third level icons change depending on which report
mode is selected (Program, ETR 290, Advanced, or Error).
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The color of each report hierarchy icon signifies the presence or absence of errors
and warnings within the corresponding item.

� A green icon indicates that no error or warning messages have been
generated for the item or its hierarchic descendents.

� A red icon indicates that at least one unacknowledged error message has
been generated for the item or its hierarchic descendents.

� A yellow icon indicates that at least one unacknowledged warning message
has been generated for the item or its hierarchic descendents.

When the item (or its descendents) contains both errors and warnings, the errors
take precedence, and the icon is red. The Expert Client displays the total number
of error messages and the total number of warning messages in the item (or its
descendents) in square brackets.

Report modes. The Report view hierarchic display organizes the analysis results
using a user-selected graphical format. You can select a report mode using the
Report view toolbar or the shortcut menu in the hierarchic view panel.

You can select between the following report modes (see Figure 3--4):

� The Program mode groups analysis results by program name
(listed alphabetically).

� The ETR 290 mode groups analysis results by ETR 290 priority level
(priority 1, 2, and 3).

� The Advanced mode groups analysis results by error type
(Multiplex, Syntax, Timing, and Rate).

� The Error mode groups analysis results by user-defined error severity
(Critical, Major, Minor, and Warning). Set the severity level using the
Message Level panel in the Configuration Client. Refer to Message Level

Panel on page 3--93.
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Program mode ETR 290 mode

Advanced mode Error mode

Figure 3- 4: Report view display modes

Acknowledging error messages and deleting configurations.You can acknowledge
error messages from the Report view and delete report configurations by
right-clicking in the hierarchic view panel and selecting the appropriate item
from the shortcut menu. Table 3--5 lists the commands in the shortcut menu.

CAUTION. You cannot undo the following menu commands. Acknowledged

messages cannot be reset, and deleted messages or configurations cannot be

recovered.

Table 3- 5: Report view shortcut menu

Menu selection Function

Acknowledge all mes-
sages

Acknowledges all of the Report view error messages for the selected
configuration. Acknowledging all messages is equivalent to resetting
past errors; the hierarchic icon becomes green (at least momentarily)
as if no messages had been generated. A checkmark precedes all
acknowledged messages.

Delete acknowledged
messages

Deletes all acknowledged error messages from the selected
configuration. Error messages that have not been acknowledged will
not be deleted.

Delete all messages Deletes all error messages (acknowledged or not) for the selected
configuration.

Delete configuration Deletes the selected configuration.

Delete all configura-
tions

Deletes all but the most recent configuration.
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The Analysis Results area has three types of views. The type of view displayed
depends on the type of icon selected in the Report view hierarchy and the
selected report mode (Program, ETR 290, Advanced, or Error):

� First level icon (a folder): Displays the Summary view (the default Report
view) which displays various summary information about the transport
stream being analyzed.

� Second level icon (a folder): Displays the Error Graph view which displays
graphs showing the number errors occurring on the transport stream. The
graphs are presented based on the mode of the Report view.

� Third level icon (changes depending on the mode): Displays the Message
view (first, second, or third level icon) which displays the text of error
messages. The error messages are presented based on the mode of the Report
view.

The second- and third-level icon views display the results of the transport stream
analysis organized based on the display mode selected in the Report view
hierarchy (Program, ETR 290, Advanced, or Error).

Report view Summary (default) view. The Report view Summary view appears in
the right section of the Report view whenever you select a Configuration icon
(folder) in the Report view hierarchic view panel. The summary view presents a
record of the input stream characteristics, contents, and errors.

The Summary view is divided into three regions (see Figure 3--5): the summary
error graph, the general information panel, and the event panel.

� Error Graph. The error graph provides a high-level indicator of the frequency
and severity of the errors measured during the current configuration, or
monitoring session. The height of each segment in the graph indicates the
most significant error level, if any, detected during the corresponding time
period. The most recent segments appear at the right end of the graph, while
the oldest segments scroll off the left end of the graph. The error level
indicator for the current time period is indicated at the right of the error
graph.

Summary
information

Important
events

Error graph

Segment
duration menu

Figure 3- 5: Analysis Results area of the Report view

Report View Analysis
Results Area
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As each measurement time period expires (as set by the Segment Duration
menu), one of the five symbols shown in Table 3--6 appears in the right-most
graph segment:

Table 3- 6: Error graph symbols

Symbol Description

Small green bar Indicates that no error was detected during the measurement time
period.

Short yellow bar Indicates that at least one warning message was generated during the
measurement time period.

Short red bar Indicates at least one ETR 290 priority level three or other non-critical
error was detected during the measurement time period.

Medium red bar Indicates at least one ETR 290 priority level two or other critical error
was detected during the measurement time period.

Tall red bar Indicates at least one ETR 290 priority level one or other very critical
error was detected during the measurement time period.

� The Segment Duration menu at the left end of the error graph controls the
duration of each graph segment. The selections range from 5 s (five seconds)
to 15 m (fifteen minutes). The time span of the error graph (from 18 minutes,
15 seconds to 54 hours, 45 minutes) depends on the settings in the segment
duration menu.

� Summary Information. The summary information section (see Figure 3--5)
displays a variety of information about the input stream. Displayed
information includes the transport stream ID, the network name, the number
of programs, the transmission rate, the available rate, and the conditional
access for the transport stream being analyzed.

� Important Events. The important events section (see Figure 3--5) displays
information about the stream and its contents as well as significant changes
to the stream characteristics and content. Information is presented in a
three-level hierarchic format. To expand the hierarchy at any point and reveal
additional information about a stream item, either click the + box to the left
of the item icon or double-click the icon itself.

Each level of the hierarchy displays the history of the transport stream at a
different level of detail (see Table 3--6). First level icons displays informa-
tion about the transport stream as a whole. Second level icons display
information for each program in the stream. Third level icons display
information about each program component.
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First level
icon

Second level
icon

Third level
icon

Figure 3- 6: Hierarchy levels in the Analysis Results area

Table 3- 7: Icons used in the Report view Analysis Results area

Icon Level Description

1 Synchronization icons display the time of the last synchronization and
consequently the beginning of a configuration.

1 Program icons display the program name and its current state
(presence, number of components, and rate).

1 Lost Synchronization icons display the time of synchronization loss
and, consequently, the end of a configuration.

2 The program State icon indicates whether the program is “present” or
“not present.” You can expand the State icon to reveal all program
appearance and disappearance times.

2 The program Cond. access icon displays all changes in the program
conditional access.

2 The program Rate icon displays the current bitrate for the program.
Expand the rate item to reveal the time of all program rate changes.

2 The Section, Audio, Video, or Data Component icons display the
program component type, its PID, and its current state (presence,
scrambling, and current rate). Expand each component to display the
last level of important events.

3 The component State icon indicates whether the component is “present”
or “not present.” You can expand the State icon to reveal all component
appearance and disappearance times.

3 The component Cond. access icon displays all changes in the
component conditional access.

3 The component Rate icons show the current bitrate for the component.
Expand the rate item to reveal all component rate changes.

3 The component Scrambling icon displays the status and history of
changes in the component scrambling state.
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Report views using the Program report mode. The Program report mode displays
information about the transport stream analysis and errors organized by program
name. When you select the Program mode for the Report view, the information
displayed in the Analysis Results area depends on the icon selected in the
hierarchic view panel:

� When you select a first-level icon (configuration folder), the default
Summary view is displayed (see Figure 3--5 on page 3--23).

� When you select a second-level icon (program folder), the Error Graph panel
is displayed in the Analysis Results area. The Error Graph panel (see
Figure 3--7) displays a graph of errors for each program in the transport
stream. The summary graph of the errors for all components is displayed at
the top of the Error Graph view.

Figure 3- 7: Error Graph panel for the Program report mode

� When you select a third-level icon (program name), the Message panel is
displayed in the Analysis Results area. The Message panel (see Figure 3--8)
displays all errors that have occurred for the selected program. The Message
panel is divided into five columns as listed in Table 3--8. You can sort
messages by clicking the column headers. Double-click an error message to
display the details of the error in a dialog box.

Advanced

Figure 3- 8: Message panel for the Program report mode
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To change the width of a column in the message view, position the cursor
over the divider to the right of the column heading; the cursor shape changes
to indicate that you can change the width. Then click and drag the divider
right or left to increase or decrease column width.

Table 3- 8: Message view column descriptions (Program mode)

Column Description

Type Displays the type of error message: information, warning, error
detected, or error disappearance.

ETR 290 Displays the ETR 290 priority level of the message (priority 1.1 to
3.8.2).

Family Displays the family of the message (multiplex, syntax, timing, or rate).

Message Displays the content of the message.

Time Displays the time and date of the message.

Report views using the ETR 290 report mode. The ETR 290 report mode displays
information about the transport stream analysis and errors organized by ETR 290
priority level (priority 1, 2, or 3). When you select the ETR 290 mode for the
Report view, the information displayed in the Analysis Results area depends on
the icon selected in the hierarchic view panel:

� When you select a first-level icon (configuration folder), the default
Summary view is displayed (see Figure 3--5 on page 3--23).

� When you select a second-level icon (ETR 290 folder), the Error Graph
panel is displayed in the Analysis Results area. The Error Graph panel (see
Figure 3--9) displays a graph of errors for each ETR 290 priority level. The
summary graph of the errors for all ETR 290 priority levels is displayed at
the top of the Error Graph view.

Figure 3- 9: Error Graph panel for the ETR 290 report mode
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� When you select a third-level icon (ETR 290 priority level), the Message
panel is displayed in the Analysis Results area. The Message panel (similar
to Figure 3--8) displays all errors that have occurred for the selected ETR 290
priority level. The Message panel is divided into six columns as listed in
Table 3--9. You can sort messages by clicking the column headers. Double-
click an error message to display the details of the error in a dialog box.

To change the width of a column in the message view, position the cursor
over the divider to the right of the column heading; the cursor shape changes
to indicate that you can change the width. Then click and drag the divider
right or left to increase or decrease column width.

Table 3- 9: Message view column descriptions (ETR 290 mode)

Column Description

Type Displays the type of error message: information, warning, error
detected, or error disappearance.

Program Displays the name of the program on which the error occurred.

ETR 290 Displays the ETR 290 priority level of the message (priority 1.1 to
3.8.2).

Advanced Displays the type of error (multiplex, syntax, timing, or rate).

Message Displays a statement briefly describing the error and the PID on which
it occurred.

Time Displays the time and date of the message.
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Report views using the Advanced report mode. The Advanced report mode
displays information about the transport stream analysis and errors organized by
analysis type (Multiplex, Syntax, Timing, and Rate). When you select the
Advanced mode for the Report view, the information displayed in the Analysis
Results area depends on the icon selected in the hierarchic view panel:

� When you select a first-level icon (configuration folder), the default
Summary view is displayed (see Figure 3--5 on page 3--23).

� When you select a second-level icon (Advanced folder), the Error Graph
panel is displayed in the Analysis Results area. The Error Graph panel (see
Figure 3--10) displays a graph of errors for each Advanced analysis type. The
summary graph of the errors for all Advanced analysis types is displayed at
the top of the Error Graph view.

Figure 3- 10: Error Graph panel for the Advanced report mode

� When you select a third-level icon (Advanced analysis type), the Message
panel is displayed in the Analysis Results area. The Message panel (similar
to Figure 3--8 on page 3--26) displays all errors that have occurred for the
selected analysis type. The Message panel is divided into five columns as
listed in Table 3--10. You can sort messages by clicking the column headers.
Double-click an error message to display the details of the error in a
dialog box.

To change the width of a column in the message view, position the cursor
over the divider to the right of the column heading; the cursor shape changes
to indicate that you can change the width. Then click and drag the divider
right or left to increase or decrease column width.
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Table 3- 10: Message view column descriptions (Advanced mode)

Column Description

Type Displays the type of error message: information, warning, error
detected, or error disappearance.

Program Displays the name of the program on which the error occurred.

ETR 290 Displays the ETR 290 priority level of the message (priority 1.1 to
3.8.2).

Message Displays a statement briefly describing the error and the PID on which
it occurred.

Time Displays the time and date of the message.

Report views using the Error report mode. The Error report mode displays
information about the transport stream analysis and errors organized by error
severity (Critical, Major, Minor, and Warning). You can specify the severity for
each test performed by the Analysis Server using the Message Level panel of the
Configuration Client. Refer to Message Level Panel on page 3--93 for more
information about setting error message levels.

When you select the Error mode for the Report view, the information displayed
in the Analysis Results area depends on the icon selected in the hierarchic view
panel:

� When you select a first-level icon (configuration folder), the default
Summary view is displayed (see Figure 3--5 on page 3--23).

� When you select a second-level icon (Error folder), the Error Graph panel is
displayed in the Analysis Results area. The Error Graph panel (see Fig-
ure 3--11) displays a graph of errors for each severity level. The summary
graph of the errors for all error severities is displayed at the top of the Error
Graph view.

Figure 3- 11: Error Graph panel for the Error report mode
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� When you select a third-level icon (error severity), the Message panel is
displayed in the Analysis Results area. The Message panel (similar to
Figure 3--8 on page 3--26) displays all errors that have occurred for the
selected error severity. The Message panel is divided into six columns as
listed in Table 3--11. You can sort messages by clicking the column headers.
Double-click an error message to display the details of the error in a
dialog box.

To change the width of a column in the message view, position the cursor
over the divider to the right of the column heading; the cursor shape changes
to indicate that you can change the width. Then click and drag the divider
right or left to increase or decrease column width.

Table 3- 11: Message view column descriptions (Error mode)

Column Description

Type Displays the type of error message: information, warning, error
detected, or error disappearance.

Program Displays the name of the program on which the error occurred.

ETR 290 Displays the ETR 290 priority level of the message (priority 1.1 to
3.8.2).

Advanced Displays the type of error (multiplex, syntax, timing, or rate).

Message Displays a statement briefly describing the error and the PID on which
it occurred.

Time Displays the time and date of the message.

To print some or all of the data for a Report view Configuration, select the
Configuration icon (first-level folder icon) and then select Print from the View
menu or press CTRL+P to open the Print window (shown below).

Printing Reports and
Messages
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The Print window lists all the items you can print from the selected Configura-
tion. All items preceded by a check mark will be printed when you click OK.
Click a Print window item to select or deselect the item for printing.

NOTE. A full report printout can be quite lengthy, depending on the complexity of

the input stream, the duration of the analysis, and the number of events and

errors encountered.

To print only the messages for one program, a single ETR 290 priority level, one
advanced analysis type, or one error type, select the corresponding report
hierarchy icon so the messages are displayed in the right report view section.
Then select Print from the View menu (or press CTRL+P).

The Analysis Server can save error message details in the Windows NT Event
Viewer Application log. This gives you the opportunity to save a permanent
record of analysis events, which would otherwise be lost when you pause
window updates (Freeze views in the View menu) or exit the application.

Turn Event Viewer logging on or off using the Report configuration panel of the
Configuration Client (refer to Report Panel on page 3--91).

When you open an Event viewer messages window from within a Message view,
you are accessing the Event Viewer Application log. To access the log directly,
perform the following steps:

1. Start the Event Viewer application from the Windows NT Start menu by
pointing to Programs | Administrative Tools (Common), and then
selecting Event Viewer.

2. When the Event Viewer window opens, select Application from the Log
menu.

Messages and the
Windows NT Event Viewer



Expert Client Reference

MTS 200 Series Real-Time Analyzer User Manual 3- 33

3. The Application Log can contain hundreds of entries. Use the vertical scroll
bar and arrows to see entries that will not fit in the window. As long as the
Analysis Server is running, the log is continuously updated. To open an
Event Detail window, double-click a log entry.

4. From the Event Viewer Application log window you can save the current
contents of the Application Log to a file for later use, you can clear the log to
make room for more entries, you can change the log size, and you can
specify how the Event Viewer acts when the log is full. Refer to the
Windows NT documentation (or the Event Viewer online help) for more
information.

NOTE. For best results, do not select any Event Viewer Log Wrapping setting

other than Overwrite Events as Needed. The Expert Client may freeze if the

application event log fills to capacity during stream analysis. Choose Log

Settings from the Log menu of the Event Viewer to verify the current log

wrapping option and to change the size of the application event log, if necessary.
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Using the Client Area

The Client area occupies the upper-right panel of the default Expert Client
window (see Figure 2--1 on page 2--2). The Client area can display several
different views which represent various aspects of the analysis of the input
stream.

By default, the Client area displays the Statistic view whenever you start
analysis. The Statistic view contains several panels, which display data about the
input stream and the programs carried in the stream. Refer to Statistic View on
page 3--36 for more information. The Client area can contain numerous other
analysis panels that you can access through the Hierarchic view icons. Refer to
Using the Hierarchic View on page 3--12.

By default, the individual Client area views are maximized. That means that each
view occupies the entire Client view. If more than one view is open at a time in
the Client view, you can switch among them by clicking the appropriate Client
area view tab as shown below.

Client area view panel tabs Statistic view panel tabs

You can use the Window menu to change how multiple open views in the Client
area are displayed, such as tiling or cascading the views. Refer to Window Menu

on page 2--11 for more information.

To simultaneously maximize the Statistic view and close other Client area views,
click the Restore standard views toolbar button.

The Client area control buttons appear at the right end of the Menu bar when the
Client area views are maximized as shown below.

Expert Client
control buttons

Client area
control buttons

Click the Minimize button ( ) to reduce the top Client area view to an icon
within the Client area and change all other Client area views to windows or icons
within the Client area, depending on their previous size. Each window and icon
then has its own control buttons.

Positioning and Sizing the
Client Area Views
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Click the Tile button ( ) to reduce all Client area views to windows or icons
within the Client area, depending on their previous status, if any. The sizing
buttons disappear from the menu bar because each icon and window has its own
sizing buttons.

Click the Close button ( ) to close the top (currently selected) view.

NOTE. Closing a Client area view clears all existing information. Unless you are

logging messages to the Event Viewer, all information in a Client area view is

lost when you close the view. Use the Report panel in the Configuration Client to

enable Event Viewer logging. Refer to Report Panel on page 3--91.

The Client area views use the following colors for error indicators:

� Gray signifies that no test is currently running.

A test is not performed for one of three reasons: the user probe is not set, the
test is disabled, or the input stream does not contain the applicable table.
(For example, MPEG-2 streams, do not contain SI tables; therefore,
ETR 290 tests 3.2 through 3.8 cannot be performed on non-DVB streams.)

� Green signifies that a probe is set and that the measurement has remained
within the user-specified limits.

� Red signifies that an error is occurring.

� Orange signifies that the monitored parameter is currently within the limits
you defined but that an error has occurred since monitoring began.

Error Indicators
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The Statistic view is a collection of different tabbed panels that display data
about the input stream and the programs carried in the stream. You can display
only one Statistic view panel at a time.

By default, the Program Allocation panel of the Statistic view appears in the
Client area after you begin analysis on the input stream. You can view a different
panel by clicking the corresponding tab on the bottom of the Statistic view panel
(see illustration on page 3--34).

When the Statistic view first opens, some of the panel tabs are hidden by the
horizontal scroll bar. You can click the scroll arrows to reveal the remaining tabs,
or you can click the thin split box and drag to the right to shorten the scroll bar.

Scroll arrows Split box

Bandwidth allocation tool tip displays. The Program Allocation, PID Allocation,
and Type Allocation panels of the Statistic view provide different views of how
the transport stream bandwidth is allocated. In each view, you can rest the mouse
cursor anywhere in a transport stream item row, and a Tool Tip (shown below) is
displayed. The information provided shows the minimum and maximum values
taken by the element since the last synchronization.

Statistic View
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Program Allocation panel. The Program Allocation panel (see Figure 3--12) shows
the bandwidth allocation of individual items in the input multiplex using a
graphical pie chart. The yellow slice of the pie chart represents PSI/SI informa-
tion; each remaining colored slice represents a program, null packets, or
unreferenced (ghost) packets. The accompanying color-coded list of programs
(matches the pie-chart colors) provides a numeric report of bandwidth usage. A
graphic bar displaying the current or average transport rate for each program or
service in the multiplex is displayed on the right.

Service or
program name

Portion of the input
stream used by the
service or program

Current or average
transport rate of the
service or program

Minimum transport rate
(Current Rate display

mode only)

Maximum transport rate
(Current Rate display

mode only)

Display current or
average rate button

Figure 3- 12: Program Allocation panel (Current Rate mode)
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You can double-click a slice of the pie chart to switch to the PID Allocation
panel (see Figure 3--12 on page 3--37) with the corresponding program or service
already selected. You can turn off the pie-chart display using the Graphics View
panel of the Settings window (select Settings from the Session menu).

The Reused rate is the rate of shared items (that is, PIDs shared between
programs). The Used rate is the transmission rate less the Null Packet rate.

You can set the Program Allocation and PID Allocation panels to display current
or average transport rates for the current configuration.

� Select Display current rate to display current transport rates. In this mode
the minimum and maximum transport rates for the current configuration are
displayed as well as the current transport rate. Current Rate is displayed on
both the Program Allocation and PID Allocation panels when this mode is
selected.

� Select Display average rate to display average transport rates. In this mode
the transport rates for the current configuration are averaged and only the
average rates are displayed. Average Rate is displayed on both the Program
Allocation and PID Allocation panels when this mode is selected.

You can set user-defined upper and/or lower transport rate error limits for
individual stream items so that the Analysis Server can alert you when the
transport rate is outside of the desired range. Use the Transport Rate Analysis
panel of the Configuration Client to set user-defined measurement limits. Refer
to Transport Rate Analysis Panel on page 3--87 for more information.
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When you set user-defined limits on a stream item, the appearance of the graphic
bar display changes. See Figure 3--13. In Figure 3--13, the low and limit levels
for PSI/SI have been set (using the Configuration Client) to 0.50 and 0.51 Mbps
respectively. The two blue bars represent these limits.

Low limit
level

High limit
level

Exceeding high
limit

Within limits

Below low
limit

Low value
indicator

High value
indicator

Figure 3- 13: Reading the Program Allocation panel bar graphs

When you set measurement limits inside the range of the measured minimal
and/or maximal rates, the graphic bar is green. When a limit has been violated,
the bar becomes red. When the rate returns to within limits, the bar becomes
green again, but the maximum and/or minimum value indicators become orange,
indicating that the respective limit was surpassed. Refer to Error Indicators on
page 3--35 for more information.
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PID Allocation panel. The PID Allocation panel (see Figure 3--14) gives a more
detailed, program-level view of input stream bandwidth allocation. Instanta-
neous, previous maximum, and previous minimum multiplex rates are shown by
PID for the selected program. Each PID icon corresponds to the stream item type
shown in the Hierarchic view.

Display current or
average rate button

Click a button to select
a service or program

Click the Type, PID,
Percent, or Rate column
headers to sort the display

Current or average
transport rate of the PID

Minimum transport rate
(Current Rate display

mode only)

Maximum transport rate
(Current Rate display

mode only)

Portion of the element
used by the PID

Figure 3- 14: PID Allocation panel (current rate mode)

You can select a program to view in the PID Allocation panel using one of the
following methods:

� Double-click the program slice in the Program Allocation panel to open the
PID Allocation panel for that program.

� Click the corresponding program or transport stream item button in the PID
Allocation panel.
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Additionally, you can view selected PIDs only by clicking the Selection button.
When you click the Selection button, the PIDs you referenced using the PID
Allocation View panel of the Settings window are displayed. Refer to PID

Allocation View Panel on page 2--23 for more information.

NOTE. You can add and remove PIDs directly from the PID Allocation panel by

dragging and dropping stream icons between the Hierarchic view and the PID

Allocation panel in the Client area. Doing so will automatically update the PID

Allocation View panel of the Settings window.

The banner over the displayed PIDs in the PID Allocation panel contains
information about the selected program or service. In the PID Allocation panel
shown in Figure 3--14, PSI/SI has an instantaneous transport rate of
0.504 Mbits/s and the rate has been between 0.412 and 0.602 Mbits/s for the
current configuration.

The area below the banner lists each PID in the program or service and, with
graphics and text, reveals additional information about the stream item identified
with that PID. If the program or service contains more than a few PIDs, you may
have to use the vertical scroll bar to view the information for every PID.

NOTE. You can sort the PID Allocation display by clicking the Type, PID,

Percent, or Rate column headers.

You can set the Program Allocation and PID Allocation panels to display current
or average transport rates for the current configuration.

� Select Display current rate to display current transport rates. In this mode the
minimum and maximum transport rates for the current configuration are
displayed as well as the current transport rate. Current Rate is displayed on
both the Program Allocation and PID Allocation panels when this mode is
selected.

� Select Display average rate to display average transport rates. In this mode
the transport rates for the current configuration are averaged and only the
average rates are displayed. Average Rate is displayed on both the Program
Allocation and PID Allocation panels when this mode is selected.

You can set user-defined upper and/or lower transport rate error limits for
individual stream PIDs so that the Analysis Server can alert you when the
transport rate is outside of the desired range. Use the Transport Rate Analysis
panel of the Configuration Client to set user-defined measurement limits. Refer
to Transport Rate Analysis Panel on page 3--87 for more information.



Expert Client Reference

3- 42 MTS 200 Series Real-Time Analyzer User Manual

When you set user-defined limits on a PID, the appearance of the graphic bar
display changes (shown below). When you set measurement limits inside the
range of the measured minimal and/or maximal rates, the graphic bar displays
the standard colors to indicate error conditions (the corresponding PID selection
button color will match the error condition). The display will show the current
rate in red when it violates either limit. When a limit has been violated, the
region of the bar between the limit and the actual min or max value becomes red;
when the rate returns to the preferred range, the region becomes orange. Refer to
Error Indicators on page 3--35 for more information.

Low rate error limit

Number of
low-limit errors

Number of
high-limit errors

High rate error limit

The number of low-limit errors detected (in this case, 1) appears immediately
below the left end of the rate bar while the number of high-limit errors appears
below the right end. The number of (low- or high-limit) errors reported is the
number of 500 ms samples in which the actual transport rate has been below or
above the specified limits.
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Continuity Counter panel. The Continuity Counter panel (see Figure 3--15) shows
the results of continuity counter monitoring for each PID in the selected program
or service. The data are displayed PID-by-PID, similar to the PID Allocation
view. If a continuity error is detected, a message is displayed in the Report view.

The Transport Syntactic Analysis panel of the Configuration Client controls
which PIDs are shown in this view. Refer to Transport Syntactic Analysis Panel

on page 3--76 for more information.

Click a button to select
a service or program Error indicators

Figure 3- 15: Continuity Counter panel

Select a program by clicking the corresponding button on the left edge of the
panel. Each program button can change color to indicate the presence or absence
of continuity counter errors in that program. The right portion of the panel shows
the error status and number of errors for each individual PID in the program. The
error indicators use colors to indicate error conditions. Refer to Error Indicators

on page 3--35 for more information.
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Type Allocation panel. The Type Allocation panel (see Figure 3--16) shows the
bandwidth allocation of each PID type in a pie-chart display. Each slice of the
pie chart represents a PID type (such as audio, video, or data).

The accompanying color-coded list of PIDs (matches the pie-chart colors)
provides a numeric report of bandwidth usage. A graphic bar displaying the
current transport rate for each PID in the multiplex is displayed on the right,
along with the minimum and maximum rates.

List of PID
types

Portion of the input
stream used by the
service or program

Current transport
rate of the PID

Minimum transport rate

Number of PIDs

Figure 3- 16: Type Allocation panel
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TP (Transport Packet) Error Indicator panel. The TP Error Indicator panel (see
Figure 3--17) reports the results of transport error indicator (TEI) monitoring per
ETR 290. The transport_error_indicator field of every transport packet header is
checked and the number of packets is counted with this bit-field set to 1 every
500 ms. The TP Error Indicator panel displays the last 150 seconds of the results
in graphical form.

The Transport Syntactic Analysis panel of the Configuration Client controls this
view. Refer to Transport Syntactic Analysis Panel on page 3--76 for more
information about activating the transport error indicator probe. You can also add
this probe using the 2.1 Transport error probe from the ETR290 panel of the
Configuration Client.

The horizontal (time) scale of the graph is linear. The vertical (errors/500 ms)
scale is logarithmic to show both very low and very high error rates.

The TEI indicator in the status bar uses color conventions for error reporting.
Refer to Error Indicators on page 3--35 for more information.

0 TEI

Figure 3- 17: TP (Transport Packet) Error Indicator panel
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Unsynchronized Packets panel. The Unsynchronized Packets panel (see Fig-
ure 3--18) reports the results of sync byte monitoring. The sync_byte field of
every transport packet header is checked and the number of packets without the
0x47 sync_byte is counted every 500 ms. The number of packets with sync bytes
are plotted on a graph with a logarithmic vertical scale to display both very low
and very high rates of error. The vertical units are UNP per 500 ms.

You must set the unsynchronized packet probe using the Multiplex Analysis
panel of the Configuration Client to perform sync byte monitoring. Refer to
Multiplex Analysis Panel on page 3--72 for more information.

The UNP indicator in the status bar uses color conventions for error reporting.
Refer to Error Indicators on page 3--35 for more information.

Figure 3- 18: Unsynchronized Packets panel
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ASI/M2S Distribution panel. The ASI/M2S Distribution panel (see Figure 3--19)
shows the statistical distribution of the gaps between consecutive data bytes. The
vertical axis represents the percentage of gaps in useful data (bytes) and the
horizontal axis represents number of NULL (dummy) bytes between data bytes.
In the Figure 3--19, over 70 percent of the packets in the transport stream being
analyzed have twelve NULL bytes between them.

By default, the display is auto-scaled. If you clear the Auto-scale check box, you
can select scales of 1%, 2%, 5%, 10%, or 20%.

The input transport stream mode can be one of two types (this mode is automati-
cally detected):

� Burst mode which provides single bytes separated with dummy bytes.

� Packet mode which provides continuous transmission of bytes separated
with continuous dummy bytes.

Figure 3- 19: ASI/M2S Distribution panel
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The ETR 290 view (see Figure 3--20) provides a high-level report of all
ETR 2901 recommended tests performed by the Expert Client. To open an
ETR 290 view, either select ETR 290 View from the View menu or click the
ETR 290 View toolbar button. The status bar includes indicators (PR1, PR2, and
PR3) to indicate the status of ETR 290 priority errors.

NOTE. ETR 290 priority 3 checks DVB-SI tables. In ATSC analysis mode, these

checks do not apply except for 3.4 Unreferenced_PID. When the ATSC analysis

mode is selected, the Expert Client uses six tests specific to ATSC/PSIP tables
based on the model of ETR 290 Priority 3 tests. Also, when MPEG-2 analysis

mode is selected, there are no Priority 3 tests.

In the ETR 290 view, test numbers are those used in the DVB measurement
guidelines, ETR 290, except for the priority 3 checks which apply only to the
DVB mode. In MPEG-2 mode, the priority 3 column does not appear and in
ATSC mode the column is customized for that mode. Colored indicator lights
show the status of each test. The error indicators follow color conventions for
error reporting. Refer to Error Indicators on page 3--35 for more information.

Figure 3- 20: ETR 290 view (DVB mode)

Positioning your pointer over the test name or LED displays a Tool Tip (as
shown below) describing the Analysis Server test or tests represented by that
ETR 290 priority LED. You can double-click an error indicator to open a
Message view in the Client area that displays the error messages pertaining to
that particular ETR 290 error condition.

1 ETR 290 is the DVB consortium working group that recommends the measurements
and controls performed on elements of a digital television chain. Refer to ETR 290
Analysis on page 3- 112 for additional information about the ETR 290 recommenda-
tions, priority levels, and tests.

ETR 290 View
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Tests 1.3.a(1), 1.5.a(1), 3.1.a(2), 3.1.b, 3.5.a(2), 3.5.b, 3.6.a(2), 3.6.b, and 3.8(1)
use error criteria that can be changed on the Section Rate Analysis panel of the
Configuration Client. Refer to Section Rate Analysis Panel on page 3--88 for
more information. The values you set in the Section Rate Analysis panel are
displayed in the Tool Tips when you position your pointer over the test name or
LED.

Tests 2.3.a, 2.3.b, 2.4, and 2.5 (PCR and PTS/DTS probes) are performed only
on PMTs and elementary streams that you specify using the Configuration Client
timing analysis panels. The ETR 290 view shows how many of the PMTs and
elementary streams (ES) in the input stream have been selected for monitoring.
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The Section Analysis view (see Figure 3--21) is available for all tables carried in
a transport stream, whether they are part of the system information tables (PSI,
DVB--SI, ATSC/PSIP, ISDB/ARIB) or part of other transport stream data. Set
section probes using the Configuration client.

Figure 3- 21: Section Analysis view

The Section Analysis view provides both a hierarchic and field view of the
selected table section. In the Section Analysis view hierarchy, related fields are
grouped and shown as folders and other icons. With some table types you can
expand and collapse the hierarchy as you would a Windows NT Explorer
directory hierarchy. Click a hierarchy icon to show the contents of the repre-
sented item in the right sub-view as shown below. You can also double-click the
same folder icon in the right sub-view to show the same information.

Click the Close Folder button ( ) to close an open folder in the hierarchy.
When more than one section of the selected sub-table exists, use the section
selection buttons to scroll among the sections.

Section selection buttons

Section Analysis View
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Although the normal numeric display is hexadecimal, it may be convenient in
some instances to see the decimal value of one or more fields. Press the F2
function key to toggle between decimal and hexadecimal display.

Opening a section analysis view. To display the results of a section analysis, select
View Section Analysis from the Hierarchic view shortcut menu. If an item in the
Hierarchic view represents several sub-tables (such as an NIT, SDT, or EIT), an
intermediate dialog box enables you to select one particular sub-table to analyze.
For an SDT, for instance, a dialog box (shown below) enables you to choose the
original_network_id and the transport_stream_id of the SDT sub-table.
Double-click the sub-table you need to display or highlight the sub-table and
click OK. You can click the column headers to reorder the listed sub-tables.

Printing a section analysis view.You can print a record of the current Section
Analysis view by clicking inside the view to select the view, and then choosing
Print from the View menu (or pressing CTRL+P).

NOTE. Before printing a view, check the Expert Client title bar to confirm that

the desired view is selected.



Expert Client Reference

3- 52 MTS 200 Series Real-Time Analyzer User Manual

The Section Rate view (see Figure 3--22) contains graphs that show the section
rate and time interval between sections of the selected table. Before you can open
a Section Rate view of a table, you must first set a rate probe on the desired table
using the Configuration Client. After the probe is set, select the corresponding
Hierarchic view icon, right-click to open the shortcut menu, and then select View
Section Rate. An intermediate dialog box lets you select a sub-table if necessary.

If a section rate error is detected the graph trace is red. The error indicator
corresponding to the error is displayed in red in the ETR 290 view if the rate
error is classified in the ETR 290 reference (for example, ETR 290 1.3.1 is a
PAT rate condition). To see which error occurred, double-click the Hierarchic
view icon corresponding to the Section Rate view or choose the View Report
command in the shortcut menu to open the associated report view.

The lower Sub-Table Max Interval graph displays interval errors in red when a
maximum section interval probe is set for the particular table type.

You can use the Graphics View panel of the Settings window (select Settings
from the Session menu) to set the scrolling mode for the graphs.

Figure 3- 22: Section Rate view

Section Rate View
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Setting graph scales.All scales on the rate and interval graphs are linear and by
default the Expert Client auto-scales the vertical scale on the graphs. To change
the vertical scale on a graph, clear the corresponding Auto-scale check box and
select an appropriate scale increment from the drop-down list box. The Section
Rate vertical scale in the graph ranges from zero to four times the selected scale
increment; the Sub-Table Max Interval scale ranges from zero to approximately
three times the scale increment. Both vertical scales begin at zero regardless of
the scale setting.

Histogram readout. The two section-analysis graphs on the right are histograms,
which show the relative frequency of section rates and intervals. Histograms are
a percentage value distribution since the beginning of the analysis. By default,
the histogram readout lists the maximum rate or interval measured. If you
position the cursor within a histogram, the cursor shape changes to resemble
cross hairs and the histogram readout changes to display the rate or interval value
at the cursor position.

The PCR Analysis view (see Figure 3--23) is a graphical display of PCR
precision and frequency. Before you can open a PCR Analysis view, you must
first set a probe on the desired program using the Configuration Client.

Bandwidth = 0.040 Hz

Figure 3- 23: PCR Analysis view

PCR Analysis View
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The upper PCR graph plots your selection of either the Jitter, Frequency offset,
or Drift rate of each clock reference of the selected program. The Jitter graph
displays two kinds of information: jitter (a high-frequency component) and
wander (a low-frequency component). Low-pass and high-pass filters are used to
isolate these frequency components. The Frequency Offset graph displays the
frequency error of the program clock reference (PCR). The Drift Rate graph
displays the rate of change of the first two low frequency effects extracted from
the signal.

The lower PCR Interval graph plots the time interval between consecutive PCR
references used by the program. Each graph contains numeric readouts of the
minimum and maximum values measured in the last 300 clock references. The
graphs on the right are histograms, which show the relative frequency of the
PCR data in the graphs on the left.

Red colored portions of the graphs and red Min or Max readouts indicate that the
data exceeds the PCR error limits. The default interval error limit is 100 ms in
MPEG-2 and ATSC mode and 40 ms in DVB mode. Any interval between
consecutive clock references that exceeds these values is reported as an error.
The default jitter error limit is �500 ns for all three modes. You can view or
change PCR error limits using the PCR Timing Analysis panel of the Settings
window. Refer to PCR Timing Analysis Panel on page 3--82 for more informa-
tion.

You can use the Graphics View panel of the Settings window (select Settings
from the Session menu) to set the scrolling mode for the graphs.

Settling filter. The Expert Client uses an internal Settling Filter to improve the
accuracy of PCR jitter analysis. The Settling Filter requires time to acquire a
minimum amount of data before the Expert Client can detect and report PCR
jitter errors. The amount of time required for the Settling Filter depends on the
Bandwidth setting in the PCR Timing Analysis panel of the Configuration
Client. Refer to PCR Timing Analysis Panel on page 3--82 for more information.

When you first set a PCR probe and open a PCR Analysis view, a message
appears in the upper histogram displaying how many seconds remain before the
Settling Filter completes its operation.
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Opening a PCR analysis view. Before you can open a PCR Analysis view, you
must first set a probe on the desired program using the Configuration Client.
After the probe is set, select the appropriate Hierarchic view PMT icon,
right-click to open the shortcut menu, and then click View PCR Analysis. If you
set Mask Discontinuities when you enabled the PCR probe with the Configura-
tion Client, each PCR discontinuity with a magnitude greater than 1 ms
(millisecond) is ignored. If no discontinuity mask is set, the discontinuity is
taken into account and the model needs a delay to resettle.

NOTE. The PCR interval and PCR jitter settings determine the thresholds for

errors reported on the ETR 290 view. The default settings are consistent with

ETR 290 recommendations. Do not change these settings if you plan to use

ETR 290 tests to judge DVB compliance of the input stream.

Setting graph scales. The scales on the PCR Analysis view graphs are linear and
by default the Expert Client auto-scales the vertical scale on the graphs. To
change the vertical scale on a graph, clear the corresponding Auto-scale check
box and select an appropriate scale increment from the drop-down list box. The
range of the Precision graph is approximately twice the selected increment; the
range of the Interval graph is from zero to approximately three times the selected
interval.

Histogram readout. The graphs on the right of the PCR Analysis view are
histograms, which show the relative frequency of the PCR data in the graphs on
the left. Histograms are a percentage value distribution since the beginning of the
analysis. The histogram readout lists the maximum measured result. If you
position the cursor within the histogram, the cursor shape changes to resemble
cross hairs and the histogram readout changes to display the interval value at the
cursor position. The histogram scales range from zero to approximately four
times the selected increment.
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The PTS/DTS Analysis view (see Figure 3--24) graphs the interval between
consecutive time stamps in the selected video or audio elementary stream. The
minimum and maximum intervals between any two of the last 300 time stamps
are also shown.

The PTS/DTS Interval graph displays each second of the PTS/DTS interval
analysis. The interval is computed with two real time of successive PES that
have PTS/DTS flags values other than zero. If the time between those two
packets is higher than 700 ms, an error is reported.

You can use the Graphics View panel of the Settings window (select Settings
from the Session menu) to set the scrolling mode for the graphs.

Figure 3- 24: PTS/DTS Analysis view

Opening a PTS/DTS analysis view. Before you can open a PTS/DTS Analysis
view, you must first set a probe on the desired elementary stream using the
Configuration Client. To open a PTS/DTS Analysis view of a video or audio
elementary stream, select the corresponding Hierarchic view icon, right-click to
open the shortcut menu, and then select View PTS/DTS Analysis.

NOTE. The PTS/DTS Interval setting determines the threshold for errors reported

on the ETR 290 view. The default setting is consistent with ETR 290 recommen-

dations. Do not change this setting if you plan to use ETR 290 tests to judge

DVB compliance of the input stream.

The Expert Client cannot display a PTS/DTS Analysis view for a scrambled
elementary stream.

PTS/DTS Analysis View
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Setting graph scales. The scales on the PTS/DTS Analysis view graphs are linear
and by default the Expert Client auto-scales the vertical scale on the graphs. To
change the vertical scale on a graph, clear the corresponding Auto-scale check
box and select an appropriate scale increment from the drop-down list box. The
PTS/DTS Interval vertical scale ranges from zero to approximately three times
the scale increment. The vertical scale begin at zero regardless of the scale
setting.

Histogram readout. The right graph is a histogram, which shows the relative
frequency of PTS/DTS intervals. Histograms are a percentage value distribution
since the beginning of the analysis. The histogram readout lists the maximum
interval measured. If you position the cursor within the histogram, the cursor
shape changes to resemble cross hairs and the histogram readout changes to
display the interval value at the cursor position.

The MIP Packet Analysis view (see Figure 3--25) provides both a hierarchic and
a field view of the selected MIP.

Figure 3- 25: MIP Packet Analysis view

MIP Packet Analysis View
(DVB-T Only)
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In the MIP Packet Analysis view hierarchy, related fields are grouped and shown
as folders and other icons. With some table types you can expand and collapse
the hierarchy as you would a Windows NT Explorer directory hierarchy. Click a
hierarchy icon to show the contents of the represented item in the right sub-view
as shown below. You can also double-click the same folder icon in the right
sub-view to show the same information.

Click the Close Folder button ( ) to close an open folder in the hierarchy.

Below the hierarchy view (which displays the MIP syntax) and the list view
(which displays the name, values, and interpretation for each item of the
analyzed MIP structure), the MIP Packet Analysis view displays the most
important values associated with the MIP.

The bar graphs on the left side report the intervals between MIPs and synchro-
nization time-stamps. Those measurements can be controlled by adding allowed
variation intervals using the Configuration Client.

Also displayed are the emitted mega-frame size (between brackets) and the
measured mega-frame size. If the measured mega-frame size differs from the
emitted size, it means that an error occurred between the emission point and the
reception point.

The bar graphs on the right side display the current values of the transmitter
functions; they appear only when the corresponding transmitter is selected.
Those bar graphs can be given allowed variation intervals (those intervals can
also be defined from the mega-frame syntax settings box in the Configuration
Client).

Opening an MIP packet analysis view. To open a MIP Packet Analysis view, select
the appropriate Hierarchic view MIP icon, right-click to open the shortcut menu,
and then select View MIP Packet Analysis.

NOTE. Before the Expert Client can recognize an MIP, DVB-T must be selected

in the Analysis panel of the Configuration Client. Refer to Analysis Panel on
page 3--69 for more information.
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Setting user-defined intervals.On the bottom-left side of the view there are bar
graphs, which report the intervals between MIPs and synchronization time-
stamps. You can control these measurements by adding user-defined intervals.

You can set user-defined intervals using the Mega Frame Timing Analysis panel
to set the STS interval (refer to Analysis:Advanced:Timing:Mega Frame Panel

on page 3--86) or use the Mega Frame Rate Analysis panel to set the MIP
interval (refer to Mega Frame Rate Analysis Panel on page 3--90).

On the bottom-right side of the view there are bar graphs that display the current
values of the transmitter functions. These bar graphs appear only when the
corresponding transmitter is selected. You can control these measurements by
adding user-defined intervals.

You can set user-defined intervals for the transmitters using the Mega Frame
Syntactic Analysis panel to set the interval (refer to Mega Frame Syntactic

Analysis Panel on page 3--80).
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Depending on the type of protocol in use, the Analysis Server can monitor the
data transfer between two Internet or MAC addresses. This is done only on
Multiprotocol Encapsulation sections, which are the only sections in which IP
headers can be detected and read properly.

If the probed stream contains multiprotocol encapsulated datagrams, an
interpretation of the IP (and TCP/UDP if present) headers is displayed, along
with the sender and receiver addresses, and the total amount of data exchanged
on that session. The Expert Client assumes that packets which have the same IP
source/destination couple and the same TCP/UDP ports belong to the same
session. A session line may disappear from the view when no corresponding
packets are sent for a certain period of time (40 seconds usually).

Opening an IP monitoring view. Before you can open an IP Monitoring view, you
must first set a probe on the desired DSM-CC stream using the Configuration
Client. To open an IP Monitoring view (see Figure 3--26), select the appropriate
Hierarchic view DSM-CC icon, right-click to open the shortcut menu, and then
click IP Traffic.

NOTE. Before the Analysis Server can recognize a multiprotocol encapsulation

section, SIDAT 360 data broadcasting analysis must be selected in the Analysis

panel of the Configuration Client. Refer to Analysis Panel on page 3--69 for
more information.

There is only one IP Monitoring view for the Expert Client. Therefore, if you add

a probe on another stream, the results will be added to the same view.

IP monitoring can be tremendously bandwidth- and CPU-consuming. The

section rate of such streams is usually very high.

Figure 3- 26: IP Monitoring view

IP (Internet Protocol)
Monitoring View
(SIDAT 360 Only)
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Configuration Client Reference

The Configuration Client is used to configure the analyses performed by the
Analysis Server. The results of the analyses are displayed in the Expert Client.

The Configuration Client has the following characteristics:

� Multiple configuration panels (at the right side of the Configuration Client
window) are used to group related probes.

� A hierarchic navigation panel (at the left side of the Configuration Client
window) is used to display the Configuration Client panels.

� The Report Message Level panel allows you to define the level of more than
300 monitored MPEG-2, DVB, ATSC,and ARIB parameters.

� You can start, stop, and restart Analysis Servers using the Configuration
Client; you can also restart a remote MT200 Series test system using the
Configuration Client.

NOTE. Only one Configuration Client at a time can set parameters on an

Analysis Server. If a Configuration Client is already connected to an Analysis

Server, you can view the current settings, but you cannot change them. Also,

Analysis Servers can be password protected so that your configuration settings

cannot be changed without first supplying a password.

This section describes the Configuration Client and explains each of the analysis
settings.

� Changing Configurations page 3--62

� Saving and Restoring Configurations page 3--63

� Managing Remote Test Systems page 3--65

� Configuration Client Display Elements page 2--14

� Configuration Settings page 3--67

See Analysis Reference, beginning on page 3--1, for details about the probes
enabled by the test system and how to set, modify, and remove them.

See Capturing a Transport Stream Event on page 3--97 for information about
capturing user-defined transport stream error events.
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Changing Configurations

To change the current Analysis Server configuration, perform the following
procedure:

1. Double-click the Configuration Client icon in the Tektronix MPEG Test
System program group window.

2. Select Connection from the Session menu.

3. Select the IP address or host machine name of the test system running the
Analysis Server you want to configure. You can enter an IP address or host
machine name directly into this box, if the IP address or host name does not
appear in the drop-down list.

4. Select the input from the I/O drop-down list box.

5. Click Connection, and the Configuration Client is displayed showing the
current settings for the Analysis Server displayed in the address bar.

All modifications made to this Analysis Server will be reflected in all of the
Expert Clients connected to the Analysis Server.

6. Select the appropriate configuration category from the Configuration Client
Navigation panel to open the associated configuration panel.

7. Change configuration settings using standard Windows techniques such as
the following:

� Click the appropriate option button to select among options

� Select or clear a check box

� Select from a list of several alternatives

� Enter a new value in a text box

NOTE. Most of the configuration panels have a Restore Default button that you

can click to return all settings on the displayed panel back to the factory-default

settings.

8. When you have changed all the appropriate settings on one or more
configuration panels, click the Apply toolbar button or select Apply from the
Session menu to confirm and apply all configuration changes.

NOTE. Configuration settings are saved to the Windows NT registry and

automatically persist from session to session.
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Saving and Restoring Configurations

Through the Configuration menu, you can perform the following functions:

� Save all of the current Analysis Server configuration settings as a named
profile in the Windows NT registry

� Load a registry profile to restore a previously saved configuration

� Restore the standard, factory-default analysis configuration

To save the current Analysis Server configuration in the Windows NT registry,
perform the following procedure:

1. Select Save Configuration as from the Session menu to open the Save
Configuration As window (shown below).

2. Save the current configuration using one of the following methods:

� Enter a unique name in the Profile name box and click Save to create a
new configuration profile.

� Highlight a name on the List of existing profiles and click Save to
overwrite an existing named profile with the current Analysis Server
settings displayed in the Configuration Client.

To restore the default Analysis Server configuration, select New Configuration

from the Session menu and click Apply. All settings will now be restored to the
default state (no probes set, and MPEG-2 analysis type).

Saving the Current
Configuration

Restoring the Default
Configuration
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To restore an Analysis Server configuration that has been saved in the Windows
NT registry, perform the following procedure:

1. Select Load Configuration from the Configuration menu to open the Load
Configuration window.

2. Highlight the name of the profile that you want to restore (by clicking on the
name in the Profiles list) and then click Load.

3. Click the Apply toolbar button or select Apply from the Session menu.

NOTE. You must click the Apply toolbar button or select Apply from the Session

menu before your configuration changes will be applied to the Analysis Server

input.

Some configuration changes require that you restart the Analysis Server before

the configuration changes can be applied. A message box that allows you to

restart the Analysis Server appears when applicable.

To delete a saved Analysis Server configuration, you must use the Registry
Editor program, Regedt32.exe. Perform the following procedure to delete an
existing configuration profile:

1. Open the Windows NT Start menu and select Run. The Run window (shown
below) opens.

2. Type regedt32 in the Open text box and click OK to open the Registry
Editor window.

Loading a Saved
Configuration

Deleting a Saved
Configuration
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3. Select the HKEY_LOCAL_MACHINE on Local Machine window and
double-click the folder icons to open the path to the test system profiles. The
profiles are in the following directory path:

HKEY_LOCAL_MACHINE\Software\Tektronix\MTS\Configuration
Client\1.0\Profiles

4. Highlight the name of the configuration profile to delete and press DEL (or
select Delete from the Registry Editor Edit menu). A warning message
appears; click Yes to confirm the deletion.

5. Exit the Registry Editor.

Managing Remote TestSystems

You can shut down and/or restart a remote test system from the Configuration
Client using the following procedure:

CAUTION. To avoid potential loss of data, use the Shut Down Server option only

when necessary.

1. If not already connected, connect to an Analysis Server running on the test
system you want to shut down or restart.

2. From the Session menu, select Shut Down Server. The Shutdown dialog
box appears (shown below).
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3. Make changes to the Shutdown dialog box using the option information
provided in the following list:

� The Message box contains a default shutdown message that you can edit.
This message will appear in the System Shutdown message displayed on
the test system indicated in the address bar.

� Select the Kill applications without saving data option to close all
applications on the MT200 system indicated in the address bar without
saving changes.

� Select the Reboot after shutdown option to restart the MT200 system
indicated in the address bar after it has shut down.

� Use the Delay box to specify a delay period before the MT200 system
indicated in the address bar shuts down. You can specify a delay period
from 0 to 600 seconds. This number will appear in the System Shutdown
message displayed on the MT200 system indicated in the address bar.

4. Click OK to close the Shutdown dialog box and send a message to the test
system indicated in the address bar, alerting the user of that device that it
will be shut down within a specified period. The following illustration shows
an example of the message that is displayed on the MT200 system being
shut down.

S

The System Shutdown message box shows the message and the name of the host
machine that initiated the shutdown, an active clock showing the hours:min-
utes:seconds left until the machine shuts down, and the message you specified in
the Shutdown dialog box.
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Configuration Settings

This section describes and explains each of the analysis settings on the various
configuration panels. Each hierarchy item in the Navigation panel opens a
different configuration panel. Shown below is a fully expanded hierarchy with
page numbers listed where the associated configuration panel is described.

Each configuration panel contains a Restore Default button. Click this button to
restore the settings for the displayed panel back to their default settings.

NOTE. DVB-T analysis mode must be selected from the Analysis configuration

panel before the Mega Frame Syntactic, Timing, or Rate panels become

available. Refer to Analysis Panel on page 3--69.

Page 3--68

Page 3--69

Page 3--71

Page 3--72

Page 3--74

Page 3--76

Page 3--78

Page 3--80

Page 3--82

Page 3--84

Page 3--86

Page 3--87

Page 3--88

Page 3--90

Page 3--91

Page 3--93

Page 3--95

Page 3--102
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Select Hardware in the Navigation panel to display the Hardware configuration
panel (see Figure 3--27). Use the Hardware panel to configure the I/O port to
which you are connected.

Figure 3- 27: Hardware configuration panel

The panel displays the current configuration of the test system Input/Output type.

You can select from the following options in the Hardware panel:

Output activation. Select this option to loop the input signal to the output
connector.

Trigger configuration.You can configure the test system to use the rising or
falling edge of a signal connected to the trigger input.

Number of consecutive correct synchronization bytes to test. Select the number of
consecutive correct synchronization bytes to test before indicating the Analysis
Server is synchronized to the input (3, 5, 7 or 9 correct synchronization bytes).

Number of bad consecutive synchronization bytes to test. Select the number of
consecutive bad synchronization bytes to test before indicating that synchroniza-
tion has been lost (1, 3, 5 or 7 bad synchronization bytes).

Hardware Panel
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Select Analysis in the Navigation panel to open the Analysis configuration panel
(see Figure 3--28).

Figure 3- 28: Analysis configuration panel

The Analysis panel contains the following configuration options:

Analysis type. The Analysis Type setting determines which standard the test
system uses to monitor the input stream.

� Select MPEG-2 (the default) if the stream you are analyzing complies with
the MPEG standard.

� Select DVB to analyze stream compliance with DVB standards.

Two of the Analysis Options settings, DVB-T and SIDAT 360, are available
only when you select the DVB analysis type. Three of the configuration
panels (Mega Frame Syntax, Mega Frame Timing, and Mega Frame Rate)
are available only when you select the DVB analysis type and the DVB-T
analysis option.

� Select ATSC to analyze the stream to the ATSC standards.

� Select ISDB to analyze the stream to ISDB standards.

Analysis Panel
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Analysis options. The first two analysis options are available for all three analysis
types.

� Select Ghost scanning to attempt to define all ghost packets2 found in the
stream. For example, if the test system identifies a ghost packet as a PMT,
the test system positions the icon under the PAT as shown in the following
illustration. You can then perform on the ghost sections all the analyses
allowed on PMT sections, such as Section syntax analysis and PCR analysis.

A PMT Ghost

� Select Smoothing time to adjust the period over which the system averages
the transport rates reported in the Statistic view Program Allocation, PID
Allocation, and Type Allocation panels. The default value is one second; you
can enter any integer value from 1 to 10. Selecting a longer smoothing time
reduces the range over which reported transport rates vary.

� Select AC-3 to perform analysis on Dolby AC--3 audio parameters when you
are monitoring MPEG--2 or DVB streams containing embedded AC--3 audio.

� Select GI-Digicypher to interpret Digicipher II video streams as MPEG
video elementary streams (instead of private data), and to perform PCR and
PTS analyses on these streams.

The following analysis options are available only when you select DVB analysis
(in the Analysis type portion of this configuration panel).

� Select DVB-T to enable Mega Frame analysis. Three of the configuration
panels (Mega Frame Syntax, Mega Frame Timing, and Mega Frame Rate)
are available only when you select the DVB-T analysis option.

� Select SIDAT 360 data broadcasting analysis to enable SIDAT analysis and
the two SIDAT 360 Profiles options. You can enable both options simulta-
neously. Refer to SIDAT 360 Analyses on page 3--111 for more information.

� Select Multiprotocol Encapsulation to enable protocol encapsulation
testing for SIDAT 360 analysis.

� Select Data Carousel to enable monitoring of data carousel presence.

2 One or more packets found in the transport stream but not referenced in any

appropriate table.
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Select Analysis:ETR 290 in the Navigation panel to open the ETR 290 configu-
ration panel (see Figure 3--29).

NOTE. ETR 290 probes in the Probes List box can appear in italics on this panel.

If an ETR 290 probe is listed in italics in the Probe List, then at least one probe

of the corresponding ETR 290 recommendation is not set. This can happen if you

have already set specific probes for the ETR 290 recommendation using the

Advanced configuration panels in the Navigation panel.

Use this panel to activate all probes for a selected ETR 290 recommendation.

Figure 3- 29: ETR 290 configuration panel

The ETR 290 panel contains the following configuration options:

Probe Type. The Probe Type box contains a list of the available ETR 290 probes.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probes List. The Probes List box contains a list of the selected ETR 290 probes.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

ETR 290 Panel
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Select Analysis:Advanced:Multiplex in the Navigation panel to open the
Multiplex Analysis configuration panel (see Figure 3--30).

NOTE. The Multiplex Analysis panel is one of several panels used for setting and

configuring test system probes. The probes available on this panel apply to the

entire input stream multiplex and are appropriate for the current Analysis

configuration panel selections.

Figure 3- 30: Multiplex Analysis configuration panel

The Multiplex Analysis panel contains the following configuration options:

Probe type. The Probe Type box contains a list of the available multiplex probes.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probes list. The Probes List box contains a list of the selected multiplex probes.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Multiplex Analysis Panel
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Available multiplex probes. Table 3--12 lists all of the probes that you can control
through the Multiplex Analysis panel. Some probes are only available for certain
analysis types.

Table 3- 12: Multiplex analysis probes

Probe title Analysis type ETR 290 level

Absence of referenced PID All 1.6

Program not defined in PAT All —

Same PID in elementary stream and in PMT All —

Scrambling without CAT All 2.6.1

Ghost packet All 3.4

Unsynchronized packet All 1.2

Table ID PAT
CAT
NIT
TSDT
SDT
EIT
RST
TDT
TOT
MGT
TVCT
CVCT
STT
RRT

All
All
All
All
DVB only
DVB only
DVB only
DVB only
DVB only
ATSC only
ATSC only
ATSC only
ATSC only
ATSC only

1.3.2
2.6.2
3.1.1
—
3.5.2
3.6.2
3.7
3.8.2
—
—
—
—
—
—

Inter SI consistency DVB and DVB-T —

Mega Frame Size DVB-T only —

Terrestrial descriptor consistency DVB-T only —

Program paradigm ATSC only —

Scrambled ES without CA descriptor ATSC only —

Absence of mandatory EIT ATSC only —

Refer to Multiplex Probe Descriptions beginning on page 3--128 for detailed
information about the Multiplex Analysis probes.
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Select Analysis:Advanced:Syntax in the Navigation panel to open the Syntactic
Analysis panel as shown in Figure 3--31. The Syntactic Analysis panel contains
options that affect private section interpretation and syntax error reporting.

Figure 3- 31: Syntactic Analysis configuration panel

The Syntactic Analysis panel contains the following configuration options:

General configuration. There are two possible general configuration settings:

� The Map private section as DVB section option appears only when you have
set the analysis type to DVB through the Analysis panel (refer to Analysis

Panel on page 3--69).

When you select Map private section as DVB section (a check appears in
front of the option), the test system interprets all private sections encountered
in the stream as DVB SI sections. The option is not present in the standard
MPEG-2 configuration.

� The Maximum number of errors by entity setting allows you to set the
maximum number of errors the test system detects before stopping analysis
for one entity. This limits the number of syntax errors reported by the test
system for each entity. This option is convenient when you are analyzing
non-compliant streams that contain many errors.

Syntactic Analysis Panel
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NOTE. The Map private section as DVB section option is cleared when you first

specify DVB monitoring on the Analysis panel; select this option if necessary to

force the test system to interpret PIDs 0x10 through 0x14 as SI. The Map private

section as DVB section option must be cleared before you can load private

syntax files.

Private syntax.You can load private syntax definition (.cta) files through the
Private Syntax portion of the panel. These files, generated with the Private
Syntax Interpreter application, make it possible to analyze proprietary or
non-standard tables and descriptors contained in the input stream. Use the
following procedure:

1. Click Modify in the Private Syntax group. The Syntax Selection dialog box
is displayed.

2. From the List of available syntax, highlight a definition file you want to add
and click Add, or you can add all of the definition files by selecting
Add All.

3. When you have added (or removed) all of the private syntax files, click OK

to close the dialog box and return to the Configuration Client.

4. Click the Apply button to include the private syntax files into the Analysis
Server indicated in the address bar.

Refer to Appendix C: Using the Private Syntax Interpreter for more information
about using the Private Syntax Interpreter and generating user-defined private
syntax definition files.
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Select Analysis:Advanced:Syntax:Transport in the Navigation panel to open the
Transport Syntactic Analysis configuration panel as shown in Figure 3--32. Use
this configuration panel to set and configure transport syntax probes.

Figure 3- 32: Transport Syntactic Analysis configuration panel

The Transport Syntactic Analysis panel contains the following configuration
options:

Probe type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probe list. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Transport Syntactic
Analysis Panel
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Available transport syntax probes. Table 3--13 lists all of the probes that you can
control through the Transport Syntactic Analysis panel. Some probes are only
available for certain analysis types. Refer to Probe Operating Conventions on
page 3--107 for instructions on setting, changing, and removing probes.

Table 3- 13: Transport syntax probes

Probe title Analysis type ETR 290 level

Null packet with PUSI All —

Reserved PID All —

PID 0x47 All —

Reserved (PAT, CAT, and Null packet) PID with TSC All 1.3.3

PMT PID with TSC All 1.5.2

Continuity counter indicator All 1.4

PCR/OPCR flags All —

Null packet with ADF All —

ADF flags All —

Transport error indicator All 2.1

PAT PID with AFC & DI ATSC only —

PMT PID with AFC & DI ATSC only —

PSIP tables PID with TSC ATSC only —

PSIP tables PID with ADF ATSC only —

MGT PID with PUSI & pointer field ATSC only —

Refer to Transport Syntax Probe Descriptions beginning on page 3--136 for
detailed information about any of the transport syntax probes.
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Select Analysis:Advanced:Syntax:Section in the Navigation panel to open the
Section Syntactic Analysis configuration panel (shown below). Use this
configuration panel to set and configure syntax probes for private, PSI, SI, and
PSIP tables.

Figure 3- 33: Section Syntactic Analysis configuration panel

The Section Syntactic Analysis panel contains the following configuration
options:

Probe type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probe list. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Section Syntactic
Analysis Panel
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Available section syntax probes. Table 3--14 lists all of the probes that you can
control through the Section Syntactic Analysis panel. Some probes are only
available for certain analysis types. Refer to Setting Probes on page 3--107 and
Removing Probes on page 3--109 for instructions on setting and removing
probes.

Table 3- 14: Section syntax probes

Probe title Analysis type ETR 290 level

Section number or version number All —

CRC All 2.2

Section syntax All —

Refer to Section Syntax Probe Descriptions beginning on page 3--140 for detailed
information about any of the section syntax probes.
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Select Analysis:Advanced:Syntax:Mega Frame in the Navigation panel to open
the Mega Frame Syntactic Analysis configuration panel as shown in
Figure 3--34. Use this configuration panel to set and configure mega frame
syntax probes.

NOTE. The Mega Frame Syntactic Analysis panel is available only when you

have specified DVB-T analysis from the Analysis panel (refer to Analysis Panel
on page 3--69).

Figure 3- 34: Mega Frame Syntactic Analysis configuration panel

This panel contains the following configuration options:

Probe type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probe list. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Mega Frame Syntactic
Analysis Panel
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Available mega frame syntax probes. Table 3--15 lists all of the probes that you
can control through the Mega Frame Syntactic Analysis panel. Some probes are
only available for certain analysis types. Refer to Setting Probes on page 3--107
and Removing Probes on page 3--109 for instructions on setting and removing
probes.

Table 3- 15: Mega Frame syntax probes

Probe title Analysis type ETR 290 level

CRC DVB-T only —

Syntax DVB-T only —

Time offset DVB-T only —

Frequency offset DVB-T only —

Power DVB-T only —

Refer to Mega Frame Syntax Probe Descriptions beginning on page 3--142 for
information about any of the Mega Frame syntax probes.
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Select Analysis:Advanced:Timing:PCR in the Navigation panel to open the PCR
Timing Analysis configuration panel as shown in Figure 3--35. Use the PCR
Timing Analysis panel to configure and set PCR probes one program at a time
and, if desired, use unique error limits for each individual program. You can also
set probes on all stream programs at once, but you must then use the same
measurement error limits for all programs.

Figure 3- 35: PCR Timing Analysis configuration panel

NOTE. The test system uses an internal Settling Filter to improve the accuracy of

PCR jitter analysis. The Settling Filter must acquire at least 60 seconds of data

before the test system can detect and report PCR jitter errors. Wait 60 seconds

after setting a PCR probe to judge the PCR jitter performance or compliance.

The PCR Timing Analysis panel contains the following configuration options:

Program number.Use the Program Number box to select individual programs or
all programs to probe. Refer to Probe Operating Conventions on page 3--107 for
instructions on setting, changing, and removing probes.

PCR Timing Analysis
Panel
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Table identity. The Table Identity box contains a list of the selected programs.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

NOTE. The PCR Interval and the PCR Jitter Max and Min settings determine

thresholds for errors reported on the ETR 290 view. The default settings are

consistent with ETR 290 recommendations. Do not change these settings if you
plan to use ETR 290 tests to judge DVB compliance of the input stream.

PCR interval. These settings specify the maximum permissible interval between
consecutive PCRs. When a PCR probe is active, the test system reports an error
when the interval between two consecutive PCRs for the monitored program
exceeds the applicable (DVB or MPEG-2) value. The default for DVB mode is
40 ms; the default for MPEG-2 is 100 ms.

PCR jitter. The Max and Min settings specify the maximum permissible deviation
from the expected PCR value. When a PCR probe is active, the test system
reports an error when the deviation falls outside of the Max and Min values. The
default for all analysis modes is +500 ns/–500 ns.

The Frequency offset setting determines the threshold for frequency offset errors.
The default for all analysis modes is 30 ppm.

The Drift rate max setting determines the threshold for frequency drift rate
errors. The default for all analysis modes is 10 ppm/hr.

Mask discontinuities.Under normal circumstances, the test system uses every
PCR value in the stream to build the accuracy model that is used to judge the
jitter of each newly decoded PCR. Occasional discontinuities (large PCR errors
due to looped input, for example) can prevent creation of a valid model and
hinder PCR analysis. Select Mask discontinuities to ignore very inaccurate
PCRs, both for error reporting and for calculating the PCR jitter model.

Refer to Timing Probe Descriptions on page 3--144 for more information about
PCR analysis and PCR probes.

Bandwidth. The Bandwidth setting controls the PCR Jitter measurement
bandwidth used in the PCR analysis display. Refer to PCR Analysis View on
page 3--53.

The default value is 0.04 Hz and you can enter values between 0.01 and 1 Hz.
Use the drop-down selection box to select one of the defined values from the
ETR 290 standard: 0.01 (MGf1), 0.1 (MGf2), or 1 (MGf3) Hz.

NOTE. Setting lower bandwidth values will increase the time required for the

Settling Filter of the Expert Client to compute PCR Jitter measurements.
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Select Analysis:Advanced:Timing:PTS/DTS in the Navigation panel to open the
PTS/DTS Timing Analysis configuration panel as shown in Figure 3--36. Use
this panel to set and configure PTS/DTS probes on one or more of the un-
scrambled video and audio elementary streams in the multiplex.

Figure 3- 36: PTS/DTS Timing Analysis configuration panel

The PTS/DTS Timing Analysis panel contains the following configuration
options:

Program number.Use the Program Number box to select individual programs or
all programs to probe. Selecting a program number activates the With referenced
elementary stream PID box. Refer to Probe Operating Conventions on
page 3--107 for instructions on setting, changing, and removing probes.

Table identity. The Table Identity box contains a list of the selected programs.
Refer to Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

PTS/DTS Timing Analysis
Panel
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With referenced elementary stream PID. This box is activated when you select a
program in the Program number box. Use this box to select elementary stream
PIDs to reference with the selected program.

NOTE. The PTS/DTS Interval setting determines thresholds for errors reported

on the ETR 290 view. The default settings are consistent with ETR 290 recom-

mendations. Do not change these settings if you plan to use ETR 290 tests to

judge DVB compliance of the input stream.

PTS/DTS interval. This box allows you to change the PTS/DTS interval if
necessary. The default value is 700 ms.
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Select Analysis:Advanced:Timing:Mega Frame in the Navigation panel to open
the Mega Frame Timing Analysis configuration panel as shown in Figure 3--37.
Use this panel to set the STS interval probe. Refer to Probe Operating Conven-

tions on page 3--107 for instructions on setting, changing, and removing probes.

NOTE. The Mega Frame Timing Analysis panel is available only when you have

specified DVB-T analysis type from the Analysis panel (refer to Analysis Panel
on page 3--69).

Figure 3- 37: Mega Frame Timing Analysis configuration panel

The STS interval probe is used to check that the difference between two
consecutive Synchronization Time Stamps carried in the MIP remains within an
interval you define, and to report warnings every time the limits are exceeded.

The STS interval probe has two parameters: the Min and Max values allowed
(expressed in 100 nanosecond units). Typically the STS interval should remain
within the (0.5, 0.61) seconds interval.

You must enter a Min and/or Max value to add the STS interval probe.

Mega Frame Timing
Analysis Panel
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Select Analysis:Advanced:Rate:Transport in the Navigation panel to open the
Transport Rate Analysis configuration panel as shown in Figure 3--38. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

NOTE. The Analysis Servers automatically perform transport rate analysis

whenever you analyze an input stream. These analyses appear in the Program

Allocation, PID Allocation, and Type Allocation panels of the Statistic view.

Use this Transport Rate Analysis panel to set probes on selected stream items for

transport rates that fall below or exceed limits that you define. You must enter a

limit value to add a probe.

Figure 3- 38: Transport Rate Analysis configuration panel

The Transport Rate Analysis panel contains the following configuration options:

Rate interval check in. This box contains the list of transport stream items
available for you to probe.

Probe list. This box contains the list of transport rate probes that are set (or that
will be set when you apply your changes).

Rate interval check.Use the Low limit and High limit boxes to set user-defined
transport rate interval values. You must enter a limit value to add a probe.

Transport Rate Analysis
Panel
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Select Analysis:Advanced:Rate:Section in the Navigation panel to open the
Section Rate Analysis configuration panel as shown in Figure 3--39. Use this
panel to specify the maximum acceptable interval between consecutive sub-table
sections of each table type and the minimum interval between consecutive
sections. User-defined intervals appear on the ETR 290 Detailed view. Refer to
ETR 290 Panel on page 3--71 for more information.

NOTE. The Analysis Type setting in the Analysis configuration panel controls

which stream items appear in the Probe Type list. Refer to Analysis Panel on
page 3--69.

Figure 3- 39: Section Rate Analysis configuration panel

The Section Rate Analysis panel contains the following configuration options:

Probe type. This box contains the list of available section rate probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Probe list. This box contains the list of user-defined section rate probes. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Section Rate Analysis
Panel
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NOTE. The two Intervals settings determine the threshold for errors reported on

the ETR 290 view. The default settings are consistent with ETR 290 recommen-

dations. Do not change these settings if you plan to use ETR 290 tests to judge

DVB compliance of the input stream.

Intervals. The Intervals box contains the following two available options:

� When you select a section rate probe from the Probe Type list, the ETR 290
recommended value for the Maximum interval between consecutive
sub-tables is displayed. You can enter an alternative value if necessary.

� The Minimum interval between consecutive sections with the same table ID,
table ID extension box shows that 25 ms is the minimum permissible
interval between consecutive sections. You cannot change this interval.
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Select Analysis:Advanced:Rate:Mega Frame in the Navigation panel to open the
Mega Frame Rate Analysis configuration panel shown in Figure 3--40. Use this
panel to set the MIP interval probe.

NOTE. The Mega Frame Rate Analysis panel is available only when you have

specified DVB-T analysis type on the Analysis panel (refer to Analysis Panel on
page 3--69).

Figure 3- 40: Mega Frame Rate Analysis configuration panel

Use the MIP interval probe to check that the difference between the Analysis
board time stamps (the arrival time of the packets) of two consecutive MIPs
remains within a user-defined interval, and to report warnings every time the
limits are exceeded.

The MIP interval probe has two parameters: the Min and Max values allowed
(expressed in 100 nanosecond units). Typically the MIP interval should remain
within the (0.5, 0.61) seconds interval.

You must enter a Min and/or Max value to add the MIP interval probe. Refer to
Probe Operating Conventions on page 3--107 for instructions on setting,
changing, and removing probes.

Mega Frame Rate Analysis
Panel



Configuration Client Reference

MTS 200 Series Real-Time Analyzer User Manual 3- 91

Select View:Report in the Navigation panel to open the Report configuration
panel as shown in Figure 3--41. The Report panel allows you to set options for
the way in which error messages are displayed in the Expert Client Report view.

Figure 3- 41: Report configuration panel

The Report View panel contains the following configuration options:

Log messages. Select the Log messages in event viewer option to log all events
detected by the test system to the Windows NT Event Viewer. Clear the option to
prevent RTA error and message logging. Event Viewer is selected in the default
configuration.

For further information about the Event Viewer, refer to Messages and the Event

Viewer on page 3--32. Also consult the Windows NT online Help and the Event
Viewer online Help.

Report Panel
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Messages. The Messages portion of the panel contains display and logging
options that affect all messages.

� The Maximum number of configurations option sets the maximum number
of configurations the Report window displays. The default number of
configurations is 10. Select Put all messages in the same configuration to
limit the number of Report window configurations to one.

� The Maximum number of messages by sub-part of the report view option
allows you to limit the number of messages that any Message view can
contain. The maximum includes those messages that have scrolled off the
top of the current message window or window pane; use the vertical scroll
bar to see the messages that will not fit in the display window (you may have
to press F3 to pause updates when monitoring a stream with many errors).
When a Message view reaches the specified maximum, the oldest message is
discarded as each new message appears. The default maximum is 50
messages.

This setting does not affect the capacity of the Windows NT Event Viewer
application log.

� Select Only one message with the same event ID in Event Viewer to limit
the amount of message detail logged to the Event Viewer.

The RTA posts only one general message for each event ID in the Message
views. In reality, a Message view entry can represent many error or
information messages. In the standard configuration, all information or error
detail represented by the general message is logged to the Event Viewer.

Double-clicking an error message in the Expert Client Message view opens a
window that provides event details. If the Only one message with the same
event ID in Event Viewer option is selected, only one message would appear
in the Event viewer messages window for each event ID.

NOTE. When you monitor a stream that contains many items with many errors,

logging all details can delay the appearance of messages in the Message views

and quickly fill the Event Viewer application log. To log only general messages

in the Event viewer, select the Only one message with the same event id in Event

Viewer option.
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Select View:Message Level in the Navigation panel to open the Report Message
Level configuration panel as shown in Figure 3--42.

Figure 3- 42: Report Message Level configuration panel

The Report Message Level panel allows you to specify how the test system
reports each error in the Report View of the Expert Client:

� Critical

� Major

� Minor

� Warning

� Information (Info)

Message Level Panel
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The Report Message Level panel provides the following information (you can
sort this information by clicking the column headers):

� Message. This column lists each test performed by the MTS200 test system.

� ETR290. This column lists the priority level of each ETR290 test performed
by the Analysis Servers.

� Advanced. This column lists the type of error that each failed test reports.

� Report Level. This column lists the level of error that each failed test reports.

Setting error message report levels.Use one of the following techniques to set the
error level reported in the Expert Client:

� Right click the Report Level column of the test you want to modify, and then
select the reporting level you want to use from the shortcut menu (shown
below).

� Left-click in the Report Level column of the test you want to modify to step
through each error level in the list.

Restoring default error report levels.Use one of the following techniques to
restore the default the error level reported in the Expert Client for one or all error
messages:

� Click Restore Default to restore the default error reporting level for all tests.

� Choose Default from the shortcut menu selection to restore the default value
for an individual test.
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Select Data Storage:Event Configuration in the Navigation panel to open the
Event Configuration panel as shown in Figure 3--43. The Event Configuration
panel allows you select the method of initiating data storage, the conditions that
will stop data storage, and how much of the input stream is to be captured. You
will use the Event Configuration panel in conjunction with the Filtering panel to
configure the capture of a transport stream event.

Figure 3- 43: Event Configuration configuration panel

The capture file will be stored on the single shot partition of the Data Store disks
(C:\CARB0\MONO).

You specify the file name and the size of the captured input file using the
procedure described in Capturing a Transport Stream Event, beginning on
page 3--97. The captured input file is saved as a *.TRP file, which you can later
analyze using the optional MPEG-2 DVB/ATSC/ISDB-S/ARIB System
Analyzer application.

NOTE. To enable a manual transport stream capture using the Expert Client, you

must enable the Manual stop of acquisition event in the Message list as shown in

Figure 3--43 and ensure that the Current Input Used Size value is not zero (but

less than the Overall Available Size value).

Event Configuration Panel
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The Event Configuration panel displays the current settings used to capture
transport stream input. This panel has the following options:

Overall available size. This indicates the amount of disk space (in kilobytes)
available to create an event trace file. Each Analysis board has one memory
board. The disk space available is shared among the number of inputs installed
on each analysis board. You specify how much disk space can be used for each
input using the Current input used size option described below.

Current input size used. This is the amount of disk space (in kilobytes) reserved
for the one or more event traces taken from the input of the MTS200 system to
which you are connected. You must enter an amount greater than 0 KBytes to
enable data storage.

Set the file size using the slider bar (the size is updated in the text box to the
right). You need to apply your changes and restart the Analysis Server on the
connected input for the changes to take effect.

Continuous capture. This option determines whether the test system will perform
multiple input stream captures on the selected input, or whether only one event is
saved.

If this option is selected, each enabled event will trigger an new input transport
stream capture. Each new captured input file increments the number ‘n’ in the
file name. If the first captured input file is fileName.trp, the second file name
will be fileName_1.trp.

If this option is not selected, only the first enabled event will trigger an input
stream capture. To reset event capturing after some input has been captured,
return to this panel, disable and re-enable the event, and then press the Apply
button.

Include time stamping extra information. This option allows you to add extra time
stamp information to captured data. When this option is selected, each captured
packet header includes a time stamp from the test system.
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Message. This area lists the following information (you can sort the information
in this area by clicking the column headers):

� Message. This column lists all of the tests performed by the test system.

� ETR290. This column lists the ETR290 priority level for each ETR290 test
performed by the test system.

� Advanced. This column lists the test type for the test indicated in the row.
For instance, the ATSC PSIP packet with AFC test is a test on the Syntax of
the transport stream.

� Report Level. This column lists the error level you have specified for the test
indicated in the row. You set the error level using the Report Message Level
panel.

� Enabled. This column indicates whether the indicated error will generate a
input stream capture. If an input fails the test, the error will trigger an input
stream capture. Enabled is displayed with a disk icon.

� File. This column indicates the file name for the captured input based on the
error that triggered the capture.

Capturing a Transport Stream Event. The MTS200 system allows you to capture a
user-defined transport stream event. The Event Configuration panel of the
Configuration Client controls the selection of transport stream events on which
the test system can trigger a capture.

NOTE. You can manually capture transport streams using the Expert Client.

Refer to Manually Capturing a Transport Stream on page 3--10.

To enable a manual transport stream capture using the Expert Client, you must
enable the Manual stop of acquisition event in the Message list as shown in

Figure 3--43.
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To capture a user-defined transport stream event, perform the following steps:

1. Launch the Configuration Client and connect to the transport stream input
you are monitoring.

a. Double-click the Configuration client icon in the Tektronix MPEG Test
System program group window, or select Configuration client from the
Start menu.

b. In the Server list box, select the IP address or host machine name of the
analysis server analyzing the import stream from which you will capture
input.

c. If the host machine you are connecting to has multiple inputs, select the
appropriate input from the I/O list box.

2. Open the Event Configuration panel of the Configuration Client.

3. Use the Current Input Used Size slide bar to set the size of the capture file in
kilobytes. You can set the capture size to a value up to the amount listed in
the Overall Available Size box (determined by the available room on the
SCSI drives).

NOTE. You must set a capture size greater than 0 KB to enable a capture.

4. Use the Message list to select the transport stream event(s) you want to
trigger the capture.

From the Event Configuration panel, click the event row in the Enable
column to enable the error condition to trigger data capture. A disk icon in
the Enabled column indicates that the selected error will trigger input data
capture.

Left-clicking in the Enabled column toggles the test between enabled and
disabled states. You can also right-click and select Enabled from the
shortcut menu as shown below.
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NOTE. An error condition must be detected by the Analysis Server to cause data

to be captured. Always confirm that the related analysis or probe is enabled

before enabling data acquisition. To confirm that a ETR 290 test is enabled,

open the ETR 290 view and verify that the test indicator is colored green,

orange, or red (not gray).

5. To specify the filename and other parameters of the capture, right-click the
filename column for the test you are enabling, and then select Configure
from the shortcut menu.

6. In the displayed Event Settings dialog box (see Figure 3--44), enter the name
of the file you want to use when a portion of the stream is captured.
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The captured file will be stored on the single shot partition of the Data Store
disks (C:\Carb0\Mono), unless you specify an alternate location by entering
the full path to the file in the Filename text box.

Figure 3- 44: Event Settings dialog box

7. Use the Before Event and After Event boxes to set the amount of transport
stream data captured before and/or after you initiated the capture event. For
example, if you set the Before Event value to 1024 and the After Event
Value to 2048, the capture file will included 1024 kBytes of data from before
you initiated the capture and 2048 kBytes of data from after you initiated the
capture.

8. Click Center Trace if you want to save the same amount of data before and
after the capture occurs. The size of the file will be the size you set in the
Current Input Used Size selection box in the Event Configuration panel in
step 3.

9. Click the appropriate Max button to save data up to the amount you set in
the Current Input Used Size selection box in the Event Configuration panel
in step 3, before or after the capture event occurs.

10. Click OK after you finish configuring the Event Settings dialog box.

11. Open the Filtering panel of the Configuration Client to select which PIDs to
capture.

12. Click Apply before exiting the Configuration Client to enable the new Event
Configuration settings.

13. Click Restart now to restart the Expert Client.

The transport stream data will continue to move through the capture buffer until
a transport stream event occurs (one you selected in the Event Configuration
panel) that triggers a capture.
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Select Data Storage:Filtering in the Navigation panel to open the Filtering panel
as shown in Figure 3--45. You will use the Event Configuration panel in
conjunction with the Filtering panel to configure the capture of a transport
stream event. The Filtering panel allows you to specify which PIDs of the input
stream you want to be captured.

Figure 3- 45: Filtering configuration panel

The Filtering panel contains the following configuration options:

No PID filtered. Select No PID filtered to capture the entire contents of the
transport stream.

PID based filtering. Select PID based filtering to capture selected PIDs of the
stream. After you select the PID based filtering option, you can select specific
PID numbers from the upper list box or you can select groups of PIDs such as
PSI, SI, PSIP or specific programs from the lower list box to add to the Selected
PIDs list. Click the associated Add button to add items from either list box to the
Selected PIDs list.

Filtering Panel
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Select Security in the Navigation panel to display the Security panel (see
Figure 3--46). The Security panel allows you to set a password for an Analysis
Server configuration that protects your current settings from being changed. This
password applies only to the input indicated in the Address bar.

Figure 3- 46: Security configuration panel

To set a password on an Analysis Server to which you are connected, use the
following procedure:

1. Select the Password required option (it is not selected by default).

2. Enter the password and confirm it using the text boxes provided. The
password is case sensitive.

3. Click the Apply button.

Security Panel
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After setting a password, any Configuration Client that tries to connect to the
Analysis Server will see the following Password dialog box. If you do not know
the password, you can still open the Configuration Client for the indicated
Analysis Server by clicking Read Only. However, you will be unable to apply
changes to any settings.
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Analyses Reference

This section describes Analysis Servers and the default and user-controlled
analyses performed by the MTS200 Series MPEG test system. This section also
describes the generic procedure you will use to set, remove, and modify probes.
This information is provided in the following sections:

� Analysis Servers page 3--105

� Default Analyses page 3--106

� User Controlled Analyses (Probes) page 3--107

� ETR 290 Probe Descriptions page 3--112

� Multiplex Probe Descriptions page 3--128

� Syntax Probe Descriptions page 3--134

� Transport Syntax Probe Descriptions page 3--136

� Section Syntax Probe Descriptions page 3--140

� Mega Frame Syntax Probe Descriptions page 3--142

� Timing Probe Descriptions page 3--144

� Transport Rate Probe Descriptions page 3--147

� Section Rate Probe Descriptions page 3--148

� Mega Frame Rate Probe Descriptions (DVB-T only) page 3--150

Analysis Servers

An Analysis Server is the process that performs the actual analyses on a transport
stream input. The Analysis Server sends analysis results to the Expert client and
is configured by the Configuration client.

Analysis Servers conduct very few full-time, default analyses on inputs. The
only default analyses performed are fundamental to monitoring and analyzing
transport streams and cannot be disabled. Refer to Default Analyses on
page 3--106 for a description of these default analyses.

You set and control all remaining analyses, which are called probes. The term
probes, differentiates analyses that you set and control from the default analyses
performed by the Analysis Servers.

See the following sections for further information:
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� See Configuration Client Reference (beginning on page 3--61) for more
information about the Configuration client.

� See Probe Operating Conventions on page 3--107 for more information
about using the Configuration client to set probes and probe limits.

Default Analyses

Analysis Servers always check for synchronization and monitors transport rates.

If the Analysis Server cannot synchronize to an input, a general error is reported
in the Report view. This error is the same as ETR 290 error 1.1, TS_sync_loss.

NOTE. If the Analysis Server cannot synchronize with the input stream, no other

tests or analyses can be conducted.

Analysis Servers calculate the average bit rate of each PID in the input stream
and display the results in the Expert Client Program Allocation, PID Allocation,
and Type Allocation panels of the Statistic View. The analysis is automatic and
cannot be disabled.

Use the Transport Rate Analysis panel of the Configuration Client to set probes
on selected stream PIDs for transport rates that fall below or exceed limits of
your choosing (see page 3--147). Refer to Transport Rate Analysis Panel on
page 3--87 for information about using the panel.

Synchronization

Transport Rate
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User Controlled Analyses (Probes)

You control all probes using the the Configuration Client. Refer to Configuration

Client Reference on page 3--61 for detailed descriptions of each panel.

This section describes basic procedures you will use to set, modify, and remove
probes on the test system. It also describes the options available in the Configu-
ration Client Analysis panel.

The following information pertains to all user-controlled analyses (probes):

� Probes are not part of the default analyses. To restore operation to only the
default analyses, select New Configuration from the Configuration Client
Session menu and click Apply. See Saving and Restoring Configurations on
page 3--63 for procedures on saving and loading configurations.

Alternatively, you can select Restore Default for each panel in the Configu-
ration Client, and then apply your changes by clicking the Apply button.

� An Analysis Server for a particular input stores probe settings and uses those
settings whenever analyzing an stream at that input. If a probe is set when
you stop analysis and power the instrument down, it is also set the next time
you use the test system.

� To maximize system performance (especially with input streams that contain
many errors), limit the number of probes set at any one time.

Setting Probes. The following procedure uses the Multiplex Analysis panel of the
Configuration Client as an example. You can set probes on other configuration
panels using the same basic steps.

1. Start the Configuration Client by double-clicking the icon the program group
window.

2. Connect to the Analysis Server on your local test system by entering
localhost in the Server text box (or to connect to a remote Analysis
Server, select the host machine name or IP address on which the remote
Analysis Server is running from the Server drop-down list box).

3. Select the appropriate input from the I/O drop down list box.

Probe Operating
Conventions
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4. Select the desired probe in the Probe Type list of the Multiplex Analysis
panel (see Figure 3--47).

Figure 3- 47: Multiplex Analysis panel, Probe Type list box

5. Make any additional selections required for the particular probe. Additional
configuration settings for the selected probe appear below the Probe Type list
when you select the probe, as shown in the following illustration.

a. In this example, when you select Absence of referenced PID, the In box
appears that allows you to select the absence table to analyze. When you
select an item in the In box, a For box appears that allows you to select
the table.

b. When you select an item in the For box, a With PID or With program
number box appears that allows you to select PIDs or program numbers
for PMTs. A Delay box appears that allows you to set the delay from
1 to 10 s.

6. Click Add to add the probe to the Probe List.

7. Click the Apply button on the Configuration Client toolbar to activate the
probe (and all other changes made since you opened the Configuration Client
or last clicked Apply) or click OK to activate the probe (and all new
settings) and close the Configuration Client.
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Changing Current Probe Settings. The following procedure uses the Multiplex
Analysis panel as an example. You can change current probe limits on other
configuration panels without removing and resetting the probe using the same
functional steps.

1. Select (select) the probe name in the Probe List.

2. Change the limit settings as desired.

3. Click Add. The error limit change appears in the Probe List.

4. Click Apply to change the probe error limits, or click OK to change the
limits and to close the Configuration Client.

NOTE. You must click Apply or OK to put the changed probe limits into effect.

Removing Probes. The following procedure uses the Multiplex Analysis panel as
an example. You can remove probes on other configuration panels using the
same functional steps.

1. Remove the probe or probes from the Probe List.

� To remove a single probe from the list, select the probe in the Probe List
and then click Remove. (You can also remove a probe by double-click-
ing the Probe List entry.)

� To remove several probes from the list at one time, select each probe
name in the Probes List and then click Remove. To select several
contiguous names, click the first name and then hold the SHIFT key down
while selecting the last name; to select non-contiguous names, hold the
CTRL key down while making your selections.

� To remove all probes from the Probes List, click either Remove All or
Restore Default.

2. To confirm your selections, use one of the following techniques:

� Click OK to deactivate the probes and close the Configuration Client.

� Click Apply to confirm your selections and deactivate the probes while
leaving the Configuration Client open

NOTE. Removing a probe from the Probe List does not end the probe/analysis;

you must also click Apply.
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Use the Analysis panel of the Configuration Client to select the analysis type and
analysis options. Refer to Analysis Panel on page 3--69 for detailed information
about the Analysis panel settings.

NOTE. Before configuring or initiating probes, always select the appropriate

analysis type and analysis options using the Analysis panel of the Configuration

Client. Your selections on the Analysis panel determine which analyses are

available on other configuration panels.

Analysis Type. The Analysis Type setting determines the standard used to
monitor the input stream. You can select from MPEG-2 (the default), DVB, and
ATSC analysis types.

Analysis Options.You can enable the following analysis options:

� Ghost scanning. Select this option to identify data in unreferenced PIDs that
would be hidden as ghost PIDs.

� The Analysis Server calculates transport rates every 500 ms, but uses a
smoothing period for transport rate averaging. In the default configuration,
the Analysis Server averages the reported transport rate over one second, or
two 500 ms sample periods. You can increase the smoothing period up to 10
seconds using the Analysis panel of the Settings window. Refer to Analysis

Panel on page 3--69 for more information.

� Smoothing time. The Analysis Server calculates transport rates every
500 ms, but uses a smoothing period for transport rate averaging. In the
default configuration, the Analysis Server averages the reported transport
rate over one second, or two 500 ms sample periods. You can increase the
smoothing period up to 10 seconds using the Analysis panel of the Settings
window. Refer to Analysis Panel on page 3--69 for more information.

� AC-3. Select this option to perform analysis on Dolby AC-3 audio
parameters when you are monitoring MPEG-2 or DVB transport streams
containing embedded AC-3 audio.

� GI-Digicypher. Select this option to interpret Digicipher II video streams as
MPEG video elementary streams (instead of private data). This allows you to
perform PCR and PTS analyses on these streams.

Analysis Types and
Analysis Options
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NOTE. The remaining analysis options are available only when you select the

DVB analysis type.

� DVB-T. Select this option to enable Mega Frame analysis. Three of the
Settings panels (Mega Frame Syntax, Mega Frame Timing, and Mega Frame
Rate) are available only when you select the DVB analysis type and the
DVB-T analysis option.

� SIDAT 360 data broadcasting analysis.Select this option to enable SIDAT
360 analysis and to enable the two SIDAT 360 options: Multiprotocol
Encapsulation and Data Carousel.

SIDAT 360 Analysis. SIDAT 360 is a set of analyses that allow you to analyze the
following two main types of standard DVB Data Broadcasting streams:
Multiprotocol Encapsulation and Data Carousel.

Multiprotocol Encapsulation streams usually carry IP packets, and Data Carousel
streams may carry application-specific data modules that are broadcast cyclically,
such as teletext pages.

Selecting SIDAT 360 data broadcasting analysis from the Analysis panel of the
Configuration Client sets a probe that checks the validity and consistency of the
related data_broadcast_descriptor carried in the SDT or the EIT. The three
different types of tables carried on those streams have the same probing facilities
as standard DVB tables, except for defining the maximum and minimum allowed
rates.

Additionally, when you select the Multiprotocol Encapsulation option, you can
use the IP Monitoring view to monitor the IP traffic on the input stream. Refer to
IP Monitoring View on page 3--60 for more information about the view.
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ETR 290 Probe Descriptions

The Configuration Client ETR 290 panel allows you to set and configure
ETR 290 probes. Refer to ETR 290 Panel on page 3--71 for information about
using the ETR 290 panel. This section describes the list of probes set using the
ETR 290 recommendations selected from the ETR 290 panel.

The DVB Measurement Guidelines (ETR 290) provides guidelines for measure-
ment in Digital Video Broadcasting (DVB) satellite, cable, and terrestrial digital
television systems. The document is designed to define a number of measure-
ment techniques, such that the results obtained are comparable when the
measurements are carried out in compliance with the appropriate definition.
Chapter 5 of ETR 290 recommends and defines tests at the Transport Stream
level. The discussion for the probes included for each recommendation are
arranged according to the assigned ETR 290 priority level:

� First priority: necessary for decodability (basic monitoring)

� Second priority: recommended for continuous or periodic monitoring

� Third priority: application-dependent monitoring

You can configure Analysis Servers to perform most first, second, and third
priority ETR 290 measurements. Table 3--16 lists the measurements recom-
mended in ETR 290 and indicates how the Analysis Servers perform each one.

Tests 3.3, 3.9, and 3.10 are related to the T-STD (the hypothetical Transport
Stream System Target Decoder defined in the MPEG-2 standard) and are too
computation-intensive to be performed by the Analysis Servers.

You can perform T-STD analysis with the optional MTS200 Series System
Analyzer if you first capture part of the input stream to thedata store disk drives.
Refer to the System Analyzer user manual for more information about perform-
ing T-STD analysis.
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Table 3- 16: ETR 290 tests

Test number Test name Automatic
User-
requested

Not
performed

1.1 TS sync loss �

1.2 Sync byte error �

1.3 PAT error �

1.4 Continuity count error �

1.5 PMT error �

1.6 PID error �

2.1 Transport error �

2.2 CRC error �

2.3 PCR error �

2.4 PCR accuracy error �

2.5 PTS error �

2.6 CAT error �

3.1 NIT error �

3.2 SI repetition rate �

3.3 Buffer error �

3.4 Unreferenced PID �

3.5 SDT error �

3.6 EIT error �

3.7 RST error �

3.8 TDT error �

3.9 Empty buffer error �

3.10 Data delay error �

The remainder of this section describes each ETR 290 recommendation
performed by the test system. The discussions for each recommendation
indicates how errors are defined for each test and the probes you need to set
using the individual panels, should you choose to do so. However, when you
select a recommendation from the ETR 290 panel, all the probes necessary to
test to the recommendation are set automatically.
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Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte, whose content is
always the hexadecimal value 0x47. In the MPEG-2 decoder, the synchronization
byte serves for synchronization with the packetized transport stream. DVB
recommendations define synchronism such that a sequence of at least five
synchronization bytes have to be detected by the MPEG-2 decoder. Synchroniza-
tion is lost if the synchronization byte in a sequence of at least three TS packets
are not detected according to the DVB recommendations. This status is referred
to as TS_Sync_Loss.

TS_Sync_Loss is the only ETR 290 parameter that is always monitored by the
Analysis Server.

Error Precondition. In the DVB Measurement Guidelines (ETR290), the
preconditions for a TS_Sync_Loss message is as follows:

Indicator Precondition Reference

TS_Sync_Loss Loss of synchronization with consideration of
hysteresis parameters

ISO/IEC 13818-1:
Sub clause 2.4.3.3 / annex
G.01

Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte, whose content is
always the hexadecimal value 0x47. In the MPEG-2 decoder the synchronization
byte serves for synchronization with the packetized transport stream. If the
synchronization byte is missing or contains errors too often, the decoder will not
be able to synchronize to the transport stream. The MPEG test decoder checks
the synchronization byte of every packet in the transport stream for correct
contents.

Error Precondition. The precondition for a Sync_Byte_Error message is defined
in ETR 290 as follows:

Indicator Precondition Reference

Sync_byte_error Sync_byte not equal 0x47 ISO/IEC 13818-1:
Sub clause 2.4.3.3

Analysis Server Configuration. To configure the Analysis Server to monitor for
Sync_byte errors, activate the following probe:

ETR 290 Probe name Configuration panel

1.2 Unsynchronized Packet Error Multiplex Analysis

TS_Sync_Loss (1.1)

Sync_byte_error (1.2)
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The Program Association Table (PAT) contains a list of all programs and PIDs
contained in the transport stream and of associated PMTs (Program Map Tables),
which contain detailed program descriptions. The PAT is of key importance for
decoding TV and audio programs. If the PAT is not available or contains an
error, the MPEG-2 decoder will not be able to select and decode a program from
the transport stream multiplex.

The syntactic structure of a PAT is comprehensively defined in MPEG-2 systems
(ISO/IEC 13818--1). The PAT is exclusively transmitted in packets with PID
0x0000. The table may be divided into a maximum of 256 sections with the table
index (table_id) of each section being 0x00.

Error Precondition. The preconditions for a PAT_Error message are defined in
ETR 290 as follows:

Indicator Precondition Reference

PAT_error PID 0x0000 does not occur at least every 0.5
seconds

A PID 0x0000 does not contain a table_id 0x00
(that is, a PAT)

Scrambling_control_field is not 00 for PID
0x0000

ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4

Analysis Server Configuration. To configure the Analysis Server to monitor for
PAT errors, activate the following probes:

ETR 290 Probe name Configuration panel

1.3.a(1) Maximum Interval Between Consecutive PAT
Sections

Section Rate Analysis

1.3.a(2) Table ID Error (PAT) Section Syntactic Analysis

1.3.a(3) Reserved PID with TSC Error Transport Syntactic
Analysis

PAT_error (1.3)
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Each packet of the transport stream is preceded by a header consisting of four
bytes. The fourth byte of the header contains the count of a four-bit continuity
counter. The count must be increased by one for every packet of the transport
stream that has the same PID. The count may consist of values ranging from 0 to
15; beyond 15, it will start from 0 again (modulo-16 counter). The continuity
counter serves to recognize packets of a video or audio program that are either
missing or repeated more than once.

The MPEG-2 standard also tolerates counter discontinuity, provided this is
indicated by a discontinuity indicator in the optional adaptation field (AF) of the
same packet. This method is used primarily for the suppression of error messages
when changing programs preceded by remultiplexing of the transport stream.

In the case of null packets (packets that do not contain any useful data but have a
PID of 0x1FFF), continuity is not checked, since the value of the continuity
counter in zero packets is not defined in the MPEG-2 standard.

Error Precondition. The preconditions for a Continuity_Count_Error_Error
message are defined in ETR 290 as follows:

Indicator Precondition Reference

Continuity_count_error Incorrect packet order

A packet occurs more than twice

Lost packet

ISO/IEC 13818-1:
Sub clauses 2.4.3.2,
2.4.3.3

Analysis Server Configuration. To configure the Analysis Server to monitor for
continuity count errors, activate the following probe:

ETR 290 Probe name Configuration panel

1.4 Continuity Counter Error Transport Syntactic
Analysis

Continuity_count_error
(1.4)
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The PMT (Program Map Table) is a table for detailed program descriptions
referenced in the PAT. As essential information for the MPEG-2 decoder, it
contains the PIDs of all packets of the individual TV, audio, and data streams
(elementary-stream PIDs) as well as the PIDs of packets serving for the
transmission of PCR values associated with the program. Like the PAT, the PMT
is of key importance for decoding TV and audio programs. If PMT is not
available or contains an error, the MPEG-2 decoder will not be able to select and
decode a program from the transport stream multiplex.

The syntactic structure of a PMT is defined in MPEG-2 systems (ISO/IEC
13818-1). In contrast to the PAT, the PIDs of the individual PMTs are variable;
MPEG-2 permits values ranging from 0x0010 to 0x1 FFE (compare to DVB
ETS 300468: 0x0020 to 0x1 FFE). The table may be divided into a maximum of
256 sections with one section for each program. The table index (table_id) of
each section must be 0x02.

Error Precondition. ETR290 states the preconditions for a PMT_Error message as
follows:

Indicator Precondition Reference

PMT_error Sections with table_id 0x02 (that is, a PMT) do
not occur at least every 0.5 sec on the PID,
which is referred to in the PAT

Scrambling_control_field is not 00 for all PIDs
containing sections with table_id 0x02
(i.e. a PMT)

ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4, 2.4.4.8

Analysis Server Configuration. To configure the Analysis Server to monitor for
PMT errors, activate the following probes:

ETR 290 Probe name Configuration panel

1.5.a(1) Maximum Interval Between Consecutive PMT
Sections

Section Rate Analysis

1.5.a(2) PMT PID with TSC Error Transport Syntactic
Analysis

PMT_error (1.5)
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The PMT (Program Map Table) entries reveal the elementary-stream PIDs that
are contained in the transport-stream multiplex. To decode a program with the
corresponding PID, these packets must be contained in the transport stream, and
for the MPEG-2 decoder to function error-free these packets also need to be
transmitted at certain intervals. The DVB Measurement Guidelines speak of a
user-specified period, which means that it can be freely selected by the user. The
default value used by the RTA is 1 second; you can change this value when you
set the “Absence of reference PID” probe through the Multiplex Analysis
configuration panel of the Settings window (refer to Multiplex Analysis Panel on
page 3--72).

Error Precondition. ETR 290 states the precondition for a PID_Error message as
follows:

Indicator Precondition Reference

PID_error Referred PID does not occur for a user-specified
period

ISO/IEC 13818-1:
Sub clause 2.4.3.8

Analysis Server Configuration. To configure the Analysis Server to monitor for
PID errors, activate the following probe:

ETR 290 Probe name Configuration panel

1.6 Absence of Referenced PID Error Multiplex Analysis

The second byte of every packet header in the transport stream contains the
transport_error_indicator, which is a flag that serves to indicate bit errors in the
following packet. This flag is generated and inserted by the Viterbi or Reed-Sol-
omon decoder at the receiver end if the decoder is no longer capable of correct-
ing all bit and byte errors in the transport stream.

Because it is not possible in the case of a set transport_error_indicator to predict
which bit or byte contains an error, this packet must not be evaluated by an
MPEG-2 decoder. For this reason, the MPEG test decoder only indicates the
Transport_Error, which means that the packet is not checked for further transport
stream errors.

Error Precondition. ETR 290 states the precondition for a Transport_error
message as follows:

Indicator Precondition Reference

Transport_error Transport_error_indicator in the TS-Header is
set to 1.

ISO/IEC 13818-1:
Sub clauses 2.4.3.2 /
2.4.3.3

PID_error (1.6)

Transport_error (2.1)
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Analysis Server Configuration. To configure the Analysis Server to monitor for
non-zero Transport_Error_indicator fields, activate the following probe:

ETR 290 Probe name Configuration panel

2.1 Transport Error Indicator Transport Syntactic
Analysis

If program-specific information (PSI tables such as PAT, CAT, PMT, NIT, EIT,
SDT, BAT, and TOT) is transmitted, a value for checking the check sum of this
section is inserted at the end of each table section. The CRC (Cyclic Redundancy
Check) is used for calculating the check sum at the transmitter and receiver end.
Combined with the additionally transmitted CRC value, the check sum for each
table section must be zero.

If the resulting check sum does not equal zero, the MPEG-2 decoder must reject
the information contained in this table.

If a CRC_error is detected, it cannot be predicted which part of the information
contained in the table is not correct. In this case, the MPEG test decoder signals
the CRC_error, but the transport stream is not checked for further errors, which
are derived from the faulty content of this table (for example, a search for PMT
PIDs from a PAT or ES PIDs from a PMT).

Error Precondition. ETR 290 states the precondition for a CRC_Error message as
follows:

Indicator Precondition Reference

CRC_error CRC error occurred in CAT, PAT, PMT, NIT, EIT,
BAT, SDT or TOT table

ISO/IEC 13818-1:
Sub clause 2.4.4 / annex B

ETS 300 468:
Sub clause 5.2

Analysis Server Configuration. To configure the Analysis Server to monitor for
CRC errors, activate the following probe:

ETR 290 Probe name Configuration panel

2.2 CRC Error Section Syntactic Analysis

CRC_error (2.2)
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In every transport stream, coded time values derived from the system time clock
are transmitted so that the MPEG-2 decoder can link its own timing to the coder
system timing in order to decode the input stream. Each program contained in
the transport stream may have its own independent program system timing. The
Program Map Table (PMT) identifies the PID of the transport packets that
contain the PCR (Program Clock Reference) values used by the particular
program.

The specified packets contain the optional Adaptation Field in which 42 bit PCR
values are transmitted. The 42 bits contain two parts: a 33 bit PCR base and a
9-bit PCR extension. The following formulas hold for the bit structure:

PCR base (i) = (system clock frequency × t(i) DIV 300 ) % 233

PCR extension (i) = (system clock frequency × t(i) DIV 1 ) % 300

PCR (i) = (PCR base (i) × 300 ) + PCR extension (i)

A 42-bit PCR value coded this way starts again from count 0 after the elapse of
233 × 300 clocks (corresponding to a time period of approximately 26.5 hours at
27 MHz).

The MPEG-2 standard also tolerates discontinuity of PCR values following one
another, provided this is indicated by the discontinuity indicator in the optional
adaptation field (AF) of the same packet. This method is primarily used for the
suppression of PCR error messages when changing programs preceded by
remultiplexing of the transport stream.

Error Precondition. ETR 290 states the preconditions for a PCR_Error message as
follows:

Indicator Precondition Reference

PCR_error PCR discontinuity of more than 100 ms
occurring without specific indication

Time interval between two consecutive PCR
values more than 40 ms

ISO/IEC 13818-1:
Sub clauses 2.4.3.4 /
2.4.3.5

ISO/IEC 13818-4:
Sub clause 9.11.3

ETR 154: Sub clause 4.5.4

The specified intervals are the default values of the RTA. You can change the
intervals, however, on the PCR Timing Analysis panel of the Configuration
Client.

PCR_error (2.3)
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Analysis Server Configuration. To configure the Analysis Server to monitor for
PCR errors, activate the following probe:

ETR 290 Probe name Configuration panel

2.3.a PCR Timing Analysis1 PCR Timing Analysis

2.3.b PCR Discontinuity

1 This probe also monitors the selected program(s) for PCR_accuracy errors.

The DVB Measurement Guidelines also recommend additional monitoring of the
accuracy of the PCR values transmitted. Accuracy of PCR values may be
impaired by inaccurate calculation of the 42-bit PCR word width or by errors
during modification of PCR values in a remultiplex.

NOTE. The term accuracy in this case does not refer to absolute frequency

accuracy of the 27 MHz system timing, but to the fluctuation width of the PCR

values of a program, which is caused by the above mentioned errors.

Error Precondition. ETR 290 states the precondition for a PCR_accuracy_Error
message as follows:

Indicator Precondition Reference

PCR_accuracy_error PCR accuracy of selected program is not
within ±500 ns

ISO/IEC 13818-1:
Sub clause 2.4.2.2

Analysis Server Configuration. To configure the Analysis Server to monitor for
PCR_accuracy errors, activate the following probe:

ETR 290 Probe name Configuration panel

2.4 PCR Timing Analysis1 PCR Timing Analysis

1 This probe also monitors the selected program(s) for PCR errors.

PCR_accuracy_error (2.4)



Analyses Reference

3- 122 MTS 200 Series Real-Time Analyzer User Manual

Presentation Time Stamps (PTS values) in the PES headers are transmitted by
transport stream packets of a program. They enable the MPEG-2 decoder to
identify the exact time that a transmitted data block (picture for video streams
and beginning of an audio sequence for audio streams) is to be presented. The
time stamps are transmitted with a word width of 33 bits and relate to the
27 MHz system timing sequence transmitted in the transport stream together
with the PCR values.

Error Precondition. ETR 290 states the precondition for a PTS_Error message as
follows:

Indicator Precondition Reference

PTS_error PTS repetition period more than 700 ms ISO/IEC 13818-1:
Sub clauses 2.4.3.6 /
2.4.3.7 / 2.7.4

Analysis Server Configuration. To configure the Analysis Server to monitor for
PTS errors, activate the following probe:

ETR 290 Probe name Configuration panel

2.5 PTS/DTS Timing Analysis PTS/DTS Timing Analysis

If encrypted data are contained in a packet of the transport stream, this must be
indicated in the packet header (2nd byte) within the field that is two bits wide
and is labeled transport_scrambling_control. The individual values indicate the
following:

Value (binary) Description

00 No encrypted data contained in the packet

01, 10, 11 Defined by user

If encrypted data are to be transmitted, the MPEG-2 standard recommends the
additional transmission of the tables containing the encryption data (Conditional
Access Table, CAT) in separate packets with (0x0001) as PID and 0x01 as table
index.

The MPEG-2 standard prescribes that packet header including the optional
adaptation fields must not be transmitted in encrypted form. According to DVB
specifications (ETS 300 468), the same applies to tables containing service
information (SI tables PAT, PMT, NIT, EIT, BAT, TDT, TOT, and SDT). The
only exception to this rule is the EIT (Event Information Table) when program
overviews are transmitted.

PTS_error (2.5)

CAT_error (2.6)
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Error Precondition. ETR 290 states the preconditions for a CAT_Error message as
follows:

Indicator Precondition Reference

CAT_error Packets with transport_scrambling_control not
00 present, but no section with table_id = 0x01
(that is, a CAT) present

Section with table_id other than 0x01 (that is,
not a CAT) found on PID 0x0001

ISO/IEC 13818-1:
Sub clause 2.4.4

Analysis Server Configuration. To configure the Analysis Server to monitor for
CAT errors, activate the following probes:

ETR 290 Probe name Configuration panel

2.6(1) Scrambling without CAT Error Multiplex Analysis

2.6(2) CAT Table ID Error Section Syntactic Analysis

These types of service information (SI) are also inserted into the transport stream
as additional data (multiplex) and contain items such as the current date, time,
and description of the TV program. Each of these tables is transmitted in the
form of packets with a given packet number (PID) and must be contained in the
transport stream at certain intervals according to the DVB specification.
However, not every SI has a different PID; packets for TDT and TOT as well as
SDT and BAT have identical PIDs. These tables are differentiated by an entry in
the table header, the so-called table index (table_id). This table_id enables an
MPEG-2 decoder working in compliance with the DVB standard to identify the
type of service information with which it is dealing.

Table 3--17 on page 3--124 is an overview of the service information according to
ETS 300 468. In the standard configuration, the RTAs use these values. You can
change the maximum interval for each table type using the Section Rate Analysis
configuration panel of the Settings window (refer to Section Rate Analysis Panel

on page 3--88). Do not change Maximum interval settings, however, if you plan
to use ETR 290 tests to judge DVB compliance of the input stream.

NIT_error (3.1)
SDT_error (3.5)
EIT_error (3.6)
RST_error (3.7)
TDT_error (3.8)
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Table 3- 17: Overview of service information defined in ETS 300 468

Service Information PID [hex] Table_id [hex] Max. interval [sec]

NIT 0x0010 0x40, 0x41, 0x42 10

SDT 0x0011 0x42, 0x46 2

BAT 0x0011 0x4A 101

EIT 0x0012 0x4E to 0x4F,
0x50 to 0x6F

22

RST 0x0013 0x71 —

TDT 0x0014 0x70 30

TOT 0x0014 0x73 30

Stuffing Table 0x0010 to 0x0013 0x72 —

1 Only if present.

2 For the current transport stream multiplexer.

Error Precondition. ETR 290 states the preconditions for NIT_error, SDT_error,
EIT_error, RST_error, or TDT_error messages as follows:

Indicator Precondition Reference

NIT_error Section with table_id other than 0x40 or 0x41 or 0x72
(that is, not an NIT or ST) found on PID 0x0010

No section with table_id 0x40 or 0x41 (for example
an NIT) in PID value 0x0010 for more than 10 sec

ETS 300 468:
Sub clause 5.2.1

ETR 211: Sub clauses
4.1, 4.4

SDT_error Sections with table_id = 0x42 (SDT, actual TS) not
present on PID 0x0011 for more than 2 sec

Sections with table_ids other than 0x42, 0x46, 0x4A
or 0x72 found on PID 0x0011

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4

EIT_error Sections with table_id = 0x4E (EIT-P/F, actual TS)
not present on PID 0x0012 for more than 2 sec

Sections with table_ids other than in the range
0x4E -- 0x6F or 0x72 found on PID 0x0012

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4

RST_error Sections with table_id other than 0x71 or 0x72 found
on PID 0x0013

ETS 300 468:
Sub clause 5.1.3

TDT_error Sections with table_id = 0x70 (TDT) not present on
PID 0x0014 for more than 30 sec

Sections with table_id other than 0x70, 0x72 (ST) or
0x73 (TOT) found on PID 0x0014

ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4
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Analysis Server Configuration. To configure the Analysis Server to monitor for SI
Table ID errors, activate the following probes:

ETR 290 Probe name Configuration panel

3.1.a(1) NIT Table ID Error Section Syntactic Analysis

3.5.a(1) SDT and BAT Table ID Error Section Syntactic Analysis

3.6.a(1) EIT Table ID Error Section Syntactic Analysis

3.7 RST Table ID Error Section Syntactic Analysis

3.8.2 TDT Table ID Error Section Syntactic Analysis

To configure the Analysis Server to monitor for NIT, SDT, EIT, RST, and TDT
Repetition errors, activate the following probes:

ETR 290 Probe name Configuration panel

3.1.a(2) NIT actual section rate probes Section Rate Analysis

3.1.b NIT other section rate probes Section Rate Analysis

3.5.a(2) SDT actual section rate probes Section Rate Analysis

3.5.b SDT other rate probes Section Rate Analysis

3.6.a(2) EIT actual section rate probes Section Rate Analysis

3.6.b EIT other rate probes Section Rate Analysis

3.8.1 All TDT section rate probes Section Rate Analysis

The ETR211 standard prescribes minimum and maximum intervals for the
repetition of individual packets; Table 3--18 lists the values for service informa-
tion (SI). The RTA uses these values in the standard configuration. You can
change the maximum interval for each table type using the Section Rate Analysis
panel of the Settings window (refer to Section Rate Analysis Panel on page
3--88). Do not change Maximum interval settings, however, if you plan to use
ETR 290 tests to judge DVB compliance of the input stream.

Table 3- 18: SI repetition rates according to DVB

Service information
Maximum interval
(complete table)

Minimum interval
(individual sections)

PAT 0.5 s 25 ms

CAT 0.5 s1 25 ms1

PMT 0.5 s 25 ms

NIT 10 s 25 ms

SDT 2 s2 25 ms

BAT 10 s1 25 ms1

SI_repetition_error (3.2)
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Table 3- 18: SI repetition rates according to DVB (cont.)

Service information
Minimum interval
(individual sections)

Maximum interval
(complete table)

EIT 2 s2 25 ms

RST — 25 ms

TDT 30 s 25 ms

TOT 30 s 25 ms

1 If present.

2 For current transport stream multiplex.

Error Precondition. ETR 290 states the precondition for an SI_repetition_Error
message as follows:

Indicator Precondition Reference

SI_repetition_error Repetition rate of SI tables outside of
specified limits

ETS 300 468:
Sub clause 5.1.4

ETR 211:
Sub clause 4.4

Analysis Server Configuration. To configure the Analysis Server to monitor for SI
Repetition errors, activate the following probes:

ETR 290 Probe name Configuration panel

3.2 Max/Min Interval Between Consecutive
SI Sections (All SI tables, all PIDs)

Section Rate Analysis
(Select Add all)
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The transport stream multiplex is permitted to contain only packets with
program-specific information (PSI and SI tables), packets with certain PIDs that
are reserved in the MPEG-2 standard, and packets that are identified in a
Program Map Table (PMT).

Error Precondition. ETR 290 states the precondition for an Unreferenced_PID
message as follows:

Indicator Precondition Reference

Unreferenced_PID PID (other than PAT, CAT, CAT_PIDs,
PMT_PIDs, NIT_PID, SDT_PID,
TDT_PID, EIT_PID, RST_PID, re-
served_for_future_use PIDs, or PIDs user
defined as private data streams) not
referred to by a PMT within [0.5] seconds

ETS 300 468:
Sub clause 5.1.3

Notice that according to the DVB Measurement Guidelines, if a program is
changed (a new PMT), an unreferenced PID may appear in the transport stream
during a transition period of no more than 0.5 s.

Analysis Server Configuration. To configure the Analysis Server to monitor for
Unreferenced PID errors, activate the following probe:

ETR 290 Probe name Configuration panel

3.4 Ghost Packets Error Multiplex Analysis

Unreferenced PID (3.4)
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Multiplex Probe Descriptions

This section discusses each of the multiplex analyses in the order that they are
listed in the Configuration Client Multiplex Analysis panel. Refer to Multiplex

Analysis Panel on page 3--72 for information about using the configuration
panel. Each section describes the errors detected by each of the multiplex probes
and where the error is displayed in the Expert Client.

Table 3--19 lists all of the multiplex analyses, the associated ETR 290 recom-
mendation, and the analysis type setting required for the probe to be available
(refer to Analysis Panel on page 3--69).

Table 3- 19: Multiplex analyses

Analysis probe ETR 290 Analysis type

Absence of referenced PID 1.6 All

Program not defined in PAT — All

Same PID in elementary stream and in PMT — All

Scrambling without CAT 2.6(1) All

Ghosts packet 3.4.a All

Unsynchronized packet 1.2 All

Table ID PAT
CAT
NIT
TSDT
SDT
EIT
RST
TDT
TOT
MGT
TVCT
CVCT
STT
RRT

1.3.a(2)
2.6(2)
3.1.a(1)
—
3.5.a(1)
3.6.a(1)
3.7
3.8(2)
—
—
—
—
—
—

All
All
All
All
DVB only
DVB only
DVB only
DVB only
DVB only
ATSC only
ATSC only
ATSC only
ATSC only
ATSC only

Inter SI consistency — DVB and DVB-T

Mega Frame size — DVB-T only

Terrestrial descriptor consistency — DVB-T only

Program paradigm — ATSC only

Scrambled ES without CA descriptor — ATSC only

Absence of mandatory EIT — ATSC only
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Error Condition: reports an error if the time interval between a PID reference in a
PAT, CAT, PMT, or DCT and the appearance of that PID in the stream exceeds
the period of delay (1 to 10 seconds) you specify.

Associated ETR 290 recommendation: PID_error, 1.6.

How/where an error is reported in the Expert Client: In the ETR 290 view and as a
general error message in the Report view.

Error Condition: Reports an error if a PMT program number is not defined in the
PAT.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Error Condition: Reports an error if a PMT and an elementary stream are
identified with the same PID.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Error Condition: Reports an error if packets with non 00 transport_scram-
bling_control exist in the stream but no section with table_id 0x01 (a CAT) is
found.

Associated ETR 290 recommendation: CAT_error, 2.6.1.

How/where an error is reported in the Expert Client: In the ETR 290 view and as a
general error message in the Report view.

Error Condition: Reports an error if a PID (other than one of the defined or
reserved values) appears in the stream but is not referenced in a PMT within
0.5 seconds.

Associated ETR 290 recommendation: Unreferenced_PID, 3.4.

How/where an error is reported in the Expert Client: In the ETR 290 view, as a
general error message in the Report view, as a Ghost icon in the Hierarchic view,
and as a Ghost service/program in several Statistic view panels.

Absence of Referenced
PID Probe

Program Not Defined in
PAT Probe

Same PID in Elementary
Stream and in PMT Probe

Scrambling without CAT
Probe

Ghosts Packet Probe
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Error Condition: Reports an error if the transport packet header Sync_byte is
not 0x47.

NOTE. If synchronization is lost, no other analyses are possible.

Associated ETR 290 recommendation: Sync_byte_error, 1.2.

How/where an error is reported in the Expert Client: As a general error message in
the Report view, the UNP indicator on the application window status bar, the
Unsynchro Packets panel of the Statistic View, and the ETR 290 level 1.2
indicator.

Error Condition: Reports an error if the Table ID of the PSI/SI selected is not
corrected.

Associated ETR 290 recommendation: See the table below.

Table 3- 20: Table ID analyses

Table ID analysis error ETR 290

PAT error: PAT 0 with table_id different to 0x0 1.3.a(2)

CAT error: PID 0x1 with table_id other than 0x1 2.6.2

NIT error: PID 0x10 with table_id other than 0x40, 0x41, or 0x72 (ST) 3.1.a(1)

SDT error: PID with 0x11 table_id other than 0x42, 0x46, 0x4A (BAT),
or 0x72 (ST)

3.5.a(1)

EIT error: PID with 0x12 table_id other than 0x4E -- 0x6F or 0x72 (ST) 3.6.a(1)

RST error: PID with 0x13 table_id other than 0x71 or 0x72 (ST) 3.7

TDT error: PID with 0x14 table_id other than 0x71 or 0x72 (ST)
or 0x73 (TOT)

3.8(2)

How/where an error is reported in the Expert Client: As an error message in the
Report view, the ETR 290 PR1, PR2, and PR3 indicators on the application
window status bar, and the ETR 290 views of the Statistic View.

This analysis probe appears only when the analysis type setting is set to DVB
(refer to Analysis Panel on page 3--69). Refer to the InterSI sections on
page 3--131 for more information about the InterSI probe.

Error Condition: Reports an error if the Analysis Server detects problems between
PSI and SI tables.

Associated ETR 290 recommendation: None.

Unsynchronized Packet
Probe

Table ID Probe

Inter SI Consistency
Probe

(DVB only)
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How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Setting the InterSI probe activates two types of analysis:

� Intra analysis, which detects problems within PSI or SI tables.

� Inter analysis, which detects problems of coherence between SI tables.

InterSI analyses within tables.When the InterSI probe is set, the RTA checks the
PMT, NIT, BAT, EIT and SDT for the presence of mandatory descriptors and
checks all descriptors for compliance with DVB standards.

The RTA also checks the following specific characteristics of the NIT and EIT:

� In the NIT, the transport_stream_id and the network_id must be unique for a
given network_id.

� In the EIT, the field event_id must be unique for a given service_id,
transport_stream_id, and original_network_id.

� If an EIT is of type “schedule,” then the running_status field must be set to
“undefined.”

� If EIT is of type “following,” then the running_status field shall not be set to
“running.”

InterSI analyses between tables.When the InterSI probe is set, the Analysis
Server monitors the NIT, SDT, EIT, and BAT for inter-table compatibility and
reports errors if the tables do not satisfy the following conditions:

� The transport_stream_id and original_network_id fields of the NIT should be
referenced in an SDT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the NIT must be present in an SDT.

� The transport_stream_id, and original_network_id fields of the EIT must be
declared in the NIT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the BAT must be present in an SDT.



Analyses Reference

3- 132 MTS 200 Series Real-Time Analyzer User Manual

� There should be an EIT referencing the service_id, transport_stream_id, and
original_network_id fields of the SDT.

� If the EIT_schedule_flag field of the SDT is set to 1, then an EIT schedule
for service_id, transport_stream_id, and original_network_id must be
present.

� If the EIT_schedule_flag of the SDT is set to 0, then an EIT schedule should
not be present for service_id, transport_stream_id, or original_network_id.

� If the EIT_present_following_flag of the SDT is set to 1, then an EIT
present/following for service_id, transport_stream_id, and original_net-
work_id must be present.

� If the EIT_present_following_flag of the SDT is set to 0, then an EIT
present/following should not be present for service_id, transport_stream_id,
or original_network_id.

This analysis probe appears only when the analysis type setting is set to DVB
and DVB-T is selected (refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Mega Frame Size probe detects inconsis-
tency between the indicated size of the Mega Frames in the MIP and the
measured size (calculated from the packet rate and the PIA time stamps).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

This analysis probe appears only when the analysis type setting is set to DVB
and DVB-T is selected (refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the parameters carried in the MIP match those
carried in the terrestrial delivery system descriptor (if present in the NIT).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Mega Frame Size Probe
(DVB-T only)

Terrestrial Descriptor
Consistency Probe

(DVB-T only)
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This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects problems of
consistency with the method specified by the program paradigm. Refer to
Appendix D: ATSC Program Paradigm for more information.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view and as a specific report of the ES or table concerned. The
messages are logged in the multiplex folder.

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the CA descriptor is not found where
expected for an ES PID.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view and in the specific report of the stream in the Hierarchic
window.

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the mandatory EIT (0, 1, 2, 3) are not all
present.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view. The messages are logged in the multiplex folder.

Program Paradigm Probe
(ATSC only)

Scrambled ES Without CA
Descriptor Probe

(ATSC only)

Absence of Mandatory EIT
Probe

(ATSC only)
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Syntax Probe Descriptions

The MTS200 Series MPEG test system provides the following levels of syntax
analyses (the page references indicate where the discussions for that probe type
begin):

� Private syntax analysis (beginning on page 3--135)

� Transport syntax analyses (beginning on page 3--136)

� Section syntax analyses (beginning on page 3--140)

� Mega Frame syntax analyses (DVB-T only) (beginning on page 3--142)

Refer to Appendix C: Using the Private Syntax Interpreter for more information
about using the Private Syntax Interpreter and generating user-defined private
syntax definition files.

When the RTAs detect a section syntax error, the error indicator above the Expert
Client Hierarchic view icon turns red and a general error message appears in the
Report view. You can also double-click the Hierarchic view icon to open a
Message view particular to the affected table. The Expert Client also displays the
presence and nature of each section syntax error in the section analysis view
(refer to Section Analysis View on page 3--50).

Use the Configuration Client Transport Syntactic Analysis, Section Syntactic
Analysis, and Mega Frame Syntactic Analysis panels to set, modify, and remove
probes that check transport stream syntax:

� Refer to Transport Syntactic Analysis Panel on page 3--76 for information
about using the Transport Syntactic Analysis panel.

� Refer to Section Syntactic Analysis Panel on page 3--78 for information
about using the Section Syntactic Analysis panel.

� Refer to Mega Frame Syntactic Analysis Panel on page 3--80 for information
about using the Mega Frame Syntactic Analysis panel.
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Private Syntax Probe Descriptions

This section describes the private syntax options available on the Analysis panel
of the Configuration Client.

The Configuration Client Syntactic Analysis panel contains general configura-
tion and private syntax options that affect private section interpretation and
syntax error reporting:

� The Map private section as DVB section option appears only when you have
set the analysis type to DVB using the Analysis panel (refer to Analysis,
beginning on page 3--105 and Analysis Panel on page 3--69).

When you select Map private section as DVB section (a check appears in
front of the option), the RTA attempts to interpret all private sections
encountered in the stream as DVB SI sections.

� The Maximum number of errors by entity setting allows you set the
maximum number of errors the Analysis Server detects before stopping the
analysis for an entity. This limits the number of syntax errors reported by the
Analysis Server for each entity. This option is convenient when you are
analyzing non-compliant streams that contain many errors.

You can load user-defined private syntax definition (.cta) files using the Private
Syntax portion of the Configuration Client Syntactic Analysis panel. The files
you load, generated with the Private Syntax Interpreter, allow you to analyze
proprietary or non-standard tables and descriptors contained in the input stream.
To load one or more Private syntax definition files, use the following procedure:

1. Click Modify in the Private Syntax group. The Syntax Selection dialog box
is displayed.

2. Select the private syntax definition file you want to load from the List of
available syntax list box and click Add. The file name is added to the List of
selected syntax list box.

3. Repeat step 2 for each file you want to load into the Analysis Server
configuration.

4. Click OK when you are finished, and then apply your changes in the
Configuration Client.

Refer to Appendix C: Private Syntax Interpreter for more information about
using the Private Syntax Interpreter and generating user-defined private syntax
definition files.

Private Syntax and
General Syntactic

Information

Including Private Syntax
Definition Files
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Transport Syntax Probe Descriptions

Table 3--21 lists the transport syntax analyses, the associated ETR 290 recom-
mendation, and the analysis type selected when the probe is available (refer to
Analysis Panel on page 3--69).

Table 3- 21: Transport syntax analyses

Analysis probe ETR 290 Analysis type

Null packet with PUSI none All

Reserved PID none All

PID 0x47 none All

Reserved (PAT, CAT, or Null Packet) PID with TSC 1.3.a(3) All

PMT PID with TSC 1.5.a(2) All

Continuity counter 1.4 All

PCR/OPCR flags none All

Null packet with ADF none All

ADF flags none All

Transport error indicator 2.1 All

PAT PID with AFC & DI — ATSC only

PMT PID with AFC & DI — ATSC only

PSIP tables PID with TSC — ATSC only

PSIP tables PID with ADF — ATSC only

MGT PID with PUSI & pointer field — ATSC only

Error Condition: Reports an error if a null packet (PID 0x1FFF) is received with
the bit PUSI (payload_unit_start_indicator) set to 1. If the PUSI bit is set to 1, it
indicates that the payload of this transport stream packet will commence.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Error Condition: Reports an error if any PID value is not equal to the following:
0x0000 (PAT), 0x0001 (CAT), 0x0002 (TSDT), or in the interval
0x0010--0x1FFF (user-defined).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Null Packet with PUSI
Probe

Reserved PID Probe
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Error Condition: Reports an error if a packet with PID 0x47 is received.

NOTE. The PID 0x47 error is not a violation of the MPEG-2 standard. However,

you may want to detect PID 0x47 since it can lead to troubles during decoding if

the decoder incorrectly interprets the PID as a sync byte.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports an error if a PID 0x0000 (PAT), 0x0001 (CAT), or
0x1FFF (null/stuffing) packet has a transport_scrambling_control field that does
not equal 00.

Associated ETR 290 recommendation: PAT_error, 1.3.3.

How/where an error is reported in the Expert Client: In the ETR 290 view, as a
general error message in the Report view, and in the item Message view, if any.

Error Condition: Reports an error if a PMT PID (described by the PAT) has a
transport_scrambling_control field that does not equal 00. MPEG standards do
not allow scrambled PMT.

Associated ETR 290 recommendation: PMT_error, 1.5.2.

How/where an error is reported in the Expert Client: In the ETR 290 view, as a
general error message in the Report view, and in the PMT Message view (if it is
open in the Client view).

Error Condition: Reports an error if the Analysis Server detects an incorrectly
incremented transport packet continuity_counter. Except for null packets and in
cases of duplicate packets or discontinuities, the continuity counter of each
successive payload-carrying packet of the same PID must increment by one,
from 0x0 to 0xF (module 16).

Associated ETR 290 recommendation: Continuity_count_error, 1.4.

NOTE. The Continuity Counter panel displays detected errors on a per-service

basis. Refer to Continuity Counter panel on page 3--43 for more information

about this panel.

How/where an error is reported in the Expert Client: The ETR 290 view, the
Continuity Counter panel of the Statistic view, and the appropriate Message
view(s).

PID 0x47 Probe

Reserved (PAT, CAT, and
Null Packet) PID with

TSC Probe

PMT PID with TSC Probe

Continuity Counter Probe
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Error Condition: Reports an error if the Analysis Server detects a transport packet
adaptation field PCR_flag set to 0, and if the OPCR_flag is set to 1 (cannot have
an OPCR without a PCR).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: An error message in the
appropriate Message view(s).

Error Condition: Reports an error if the Analysis Server detects a null packet that
has an adaptation field.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a general error message in
the Report view.

Error Condition: Reports an error if the Analysis Server detects no coherence
between the adaptation field control and the adaptation field length. The
Analysis Server detects three error conditions:

� The adaptation_field_control is 00.

� The adaptation_field_control is 10, but the adaptation_field_length is not
equal to 183.

� The adaptation_field_control is 11, but the adaptation_field_length is not in
the range of 0 through 182.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports an error if the Analysis Server detects a transport_er-
ror_indicator field (of a transport packet header) is equal to 1, which indicates
that at least one uncorrectable bit error exists in the associated transport packet.

Associated ETR 290 recommendation: Transport_error, 2.1.

How/where an error is reported in the Expert Client: The ETR 290 view, the TEI
indicator on the status bar, and the TP Error Indicator panel of the Statistic View
(refer to TP Error Indicator Panel on page 3--45).

PCR/OPCR Flags Probe

Null Packet with ADF
Probe

ADF Flags Probe

Transport Error Indicator
Probe
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This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects no coherence
between the adaptation field control and the discontinuity indicator (if the AFC =
10 or 11, the DI must be set to 1) within the PAT.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects no coherence
between the adaptation field control and the discontinuity indicator (if the AFC =
10 or 11, the DI must be set to 1) within a PMT.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects PSIP table packet
PID with a transport_scrambling_control field that does not equal 00.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

PAT PID with AFC & DI
Probe

(ATSC only)

PMT PID with AFC & DI
Probe

(ATSC only)

PSIP Tables PID with TSC
Probe

(ATSC only)
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This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects PSIP table packet
PID that has an adaptation field.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3--69).

Error Condition: Reports an error if the Analysis Server detects no coherence
between the payload_unit_start_indicator and the pointer field (if the PUSI is 1
then the pointer field must be set to 0).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Section Syntax Probe Descriptions

Table 3--22 lists the section syntax analyses, the associated ETR 290 recommen-
dation, and the analysis type selected when the probe is available (refer to
Analysis Panel on page 3--69).

Table 3- 22: Section syntax analyses

Analysis probe ETR 290 Analysis type

Section number or version number — All

CRC 2.2 All

Section syntax — All

The RTA notes the presence and nature of each section syntax error in the section
analysis view. Refer to Section Syntactic View on page 3--50 for information
about the section analysis view.

PSIP tables PID with ADF
Probe

(ATSC only)

MGT PID with PUSI &
Pointer Field Probe

(ATSC only)
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Error Condition: Reports an error if one or more of the following section and
version numbering errors are found in a PSI, SI, PSIP, ISDB-S/ARIB table
section:

� Sections received out of order; for example section number 1 arrives before
section number 0

� All sections with the same version number do not have the same last section
number

� The version number is improperly incremented

� The version number increments before the last section of the previous
version number has been received

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports an error if the Analysis Server detects a CRC error in a
PSI, SI, or PSIP table.

Associated ETR 290 recommendation: CRC_error, 2.2.

How/where an error is reported in the Expert Client: In the ETR 290 view, and as a
syntax error in the appropriate Message view(s).

Section syntax probes perform a complete analysis of every field in all sections
of the selected table type.

Error Condition: Reports an error if the section syntax of the PSI, SI, PSIP,
ISDB-S/ARIB section selected is not corrected.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As coloration of the associated
Hierarchic view icon error indicator(s), and as a syntax error in the appropriate
Message view(s).

The RTA also notes the presence and nature of each section syntax error in the
section analysis view. Refer to Section Analysis View on page 3--50 for informa-
tion about the section analysis view.

Section Number or
Version Number Probe

CRC Probe

Section Syntax Probe
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Mega Frame Syntax Probe Descriptions

Table 3--23 lists the Mega Frame syntax analyses, the associated ETR 290
recommendation and the analysis type selected when the probe is available.

Table 3- 23: Section syntax analyses

Analysis probe ETR 290 Analysis type

CRC — DVB-T

Syntax — DVB-T

Time offset — DVB-T

Frequency offset — DVB-T

Power — DVB-T

NOTE. To access the Mega Frame syntax analyses, you must select the DVB

analysis type with the DVB-T analysis option. Refer to Analysis Panel on
page 3--69 for information about using the Analysis panel.

Use the Configuration Client Mega Frame Syntactic Analysis panel to set and
remove probes that monitor Mega Frame syntax. Refer to Mega Frame Syntactic

Analysis Panel on page 3--80 for information about using the Mega Frame
Syntactic Analysis panel.

This section describes the Mega Frame syntax analyses in the order that they are
listed in the Mega Frame Syntactic Analysis panel.

Error Condition: Reports an error if the computed Mega Frame CRC and the
Mega Frame CRC carried in the MIP do not match.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports an error if every field of Mega Frame syntax is not
valid.

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

CRC Probe

Syntax Probe
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Error Condition: Reports warnings if the value carried in the time offset function
of a transmitter exceeds the user-defined limits. Three parameters are required for
the probe: transmitter ID (entered in hex), and the minimum and maximum
values (entered in 100 nanosecond units).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports warnings if the value carried in the frequency offset
function of a transmitter exceeds the user-defined limits. Three parameters are
required for the probe: transmitter ID (entered in hex), and the minimum and
maximum values (entered in Hertz).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Error Condition: Reports warnings if the value carried in the power function of a
transmitter exceeds the user-defined limits. Three parameters are required for the
probe: transmitter ID (entered in hex), and the minimum and maximum values
(entered in 0.1 dBm units).

Associated ETR 290 recommendation: None.

How/where an error is reported in the Expert Client: As a syntax error in the
appropriate Message view(s).

Time Offset Probe

Frequency Offset Probe

Power Probe
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Timing Probe Descriptions

Analysis Servers provide the following levels of timing analyses (the page
references indicate where the discussions for that probe type begin):

� PCR timing analyses (beginning on page 3--144)

� PTS/DTS timing analyses (beginning on page 3--145)

� Mega Frame timing analysis (DVB-T only) (beginning on page 3--146)

PCR probes monitor the clock references of a selected program for regularity and
precision. When you set a PCR probe in the standard configuration, the RTA
reports a PCR error if one of the following conditions is detected:

� The interval between consecutive PCR packets is greater than 100 ms in
MPEG-2 mode or greater than 40 ms in DVB mode

� The PCR inaccuracy is greater than �500 ns

NOTE. The default PCR error limits used by the Analysis Server are consistent

with ETR 290 recommendations. You can change the error limits, if necessary,

using the PCR Timing Analysis configuration panel in the Settings window (refer

to PCR Timing Analysis Panel on page 3--82).

Setting PCR Probes.Use the PCR Timing Analysis panel to configure and set
PCR probes one program at a time and, if desired, use unique error limits for
each individual program. You can also set PCR probes on all stream programs at
once, but you must then use the same measurement error limits for all programs.

Refer to PCR Timing Analysis Panel on page 3--82 for information about using
the PCR Timing Analysis panel to set PCR probes.

NOTE. The test system uses an internal settling filter to improve the accuracy of

PCR jitter analysis. The Settling Filter must have at least 60 seconds of data

before before the Analysis Server can detect and report PCR jitter errors. Wait

60 seconds after setting a PCR probe to judge the PCR jitter performance or

compliance.

PCR Timing Analyses
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PCR error reporting in the Expert Client.When a PCR error occurs, the colored
indicator above the affected Hierarchic view PMT icon turns red and a general
error message appears in the Report view. The message also appears on the PMT
Message view if it is open in the Client window.

The test system also indicates PCR errors in the ETR 290 and PCR Analysis
views.

PTS/DTS probes monitor the time stamps of selected elementary streams for
compliance with the ETR 290 recommended interval of no more than 700 ms
(default setting; you can set a different value) between consecutive PES packets
with non-zero PTS/DTS flags.

NOTE. You can set PTS/DTS probes only on unscrambled elementary streams.

Refer to PTS/DTS Timing Analysis Panel on page 3--84 for information about
using the PTS/DTS Timing Analysis panel.

Setting PTS/DTS Probes.You can use either of the following two methods to set
PTS/DTS probes:

� Select an audio or video elementary stream icon in the Hierarchic view,
right-click to open the shortcut menu, and then select PTS/DTS Probe or
View PTS/DTS Analysis. To remove the PTS/DTS probe, select PTS/DTS
Probe a second time from the selected icon shortcut menu in the Hierarchic
view.

When you select View PTS/DTS Analysis, a PTS/DTS Analysis view opens
in the Client view and the PTS/DTS probe is enabled. Refer to PTS/DTS

Analysis View on page 3--56 for information about using the PCR Analysis
view.

� Use the PTS/DTS Timing Analysis panel of the Settings window (shown on
the previous page) to configure and set PTS/DTS probes one program at a
time and, if desired, use unique error limits for each individual elementary
stream. You can also set PTS/DTS probes on all elementary streams at once,
but you must then use the same measurement error limits for all programs.

Refer to PTS/DTS Timing Analysis Panel on page 3--84 for information
about using the PTS/DTS Timing Analysis panel.

PTS/DTS Timing Analyses
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PTS/DTS error reporting in the Expert Client.When a PTS/DTS error occurs, the
colored indicator above the affected Hierarchic view elementary stream icon
turns red and a general error message appears in the Report view. The message
also appears on the elementary stream Message view if it is open in the Client
window.

In addition, the RTA also indicates PTS/DTS errors in the ETR 290 and
PTS/DTS Analysis views.

The only specific timing analysis performed on DVB-T streams (in addition to
the regular MPEG-2/DVB rate analyses) is the STS interval check.

Use the STS interval probe to check that the difference between two consecutive
Synchronization Time Stamps carried in the MIP remains within a user-defined
interval, and to report warnings every time the limits are exceeded.

The STS interval probe has two parameters: the Min and Max values allowed
(expressed in 100 nanosecond units). Typically the STS interval should remain
within the (0.5, 0.61) seconds interval.

Set the STS interval probe using the Mega Frame Timing Analysis configuration
panel in the Settings window (refer to Mega Frame Timing Analysis Panel on
page 3--80).

Mega Frame Timing
Analysis (DVB-T Only)
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Transport Rate Probe Descriptions

When performing transport rate analysis on an input, the RTA calculates the
average bit rate of each PID in the input stream. Transport rate analysis is
automatic and cannot be disabled.

The RTA calculates transport rates every 500 ms, but uses a smoothing period for
transport rate averaging. In the default configuration, the RTA averages the
reported transport rate over one second, or two 500 ms sample periods. You can
increase the smoothing period up to 10 seconds using the Analysis panel of the
Settings window. Refer to Analysis Panel on page 3--69 for more information.

In addition to calculating transport rates for every PID in the stream, the
Analysis Server can also monitor selected PIDs and alert you when the transport
rate of the selected PID(s) violates user-specified high and low error limits.

The RTA displays the results of transport rate analysis in the Program Allocation,
PID Allocation, and Type Allocation panels of the Statistic View.

Program Allocation Panel. The Program Allocation panel of the Expert Client
Statistic view shows the bandwidth allocation of the input multiplex. Both the
numeric data and the pie chart update every 500 ms to give a near-instantaneous
report of input stream composition. Double-click on a slice of the pie chart to
change to the PID Allocation panel with the corresponding program already
selected.

Refer to Program Allocation panel on page 3--37 for more information.

PID Allocation Panel. The PID Allocation panel of the Statistic view provides a
more detailed, program-level view of input stream bandwidth allocation. The
panel also indicates whether or not transport rate error limits are set and shows
rate errors when they occur. Click a button on the left side of the panel to select a
service and see the instantaneous, previous maximum, and previous minimum
multiplex rates for every PID in the service. As in the Program Allocation panel,
all values update every 500 ms.

Refer to PID Allocation panel on page 3--40 for more information.

Type Allocation Panel. The Type Allocation panel of the Statistic view shows the
bandwidth allocation of each PID type in a pie chart display. Each slice of the pie
chart represents a PID type (such as audio, video, or data). The number of PIDs,
the allocation percentage, the minimal and maximal rate and its current value are
displayed for each pie chart slice.

Refer to Type Allocation panel on page 3--44 for more information.

Viewing Transport Rate
Analysis Results
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Use the Configuration Client Transport Rate Analysis panel to set probes on
selected stream PIDs for transport rates that fall below or exceed the limits that
you specify. You must enter a high- or low-limit value to add a probe.

Refer to Transport Rate Analysis Panel on page 3--87 for information about
using the Transport Rate Analysis panel.

Section Rate Probe Descriptions

Use the Configuration Client Section Rate Analysis panel to specify the
maximum acceptable interval between consecutive sub-table sections of each
selected table type.

NOTE. The Intervals settings determine the threshold for errors reported on the

ETR 290 view. The default settings are consistent with ETR 290 recommenda-

tions. Do not change these settings if you plan to use ETR 290 tests to judge

DVB compliance of the input stream.

Refer to Section Rate Analysis Panel on page 3--88 for information about using
the Section Rate Analysis panel.

To open a dynamic Section Rate analysis view in the Expert Client, select an
icon in the Hierarchic view, right click to open the shortcut menu, and then select
View Section Rate.

Refer to Section Rate View on page 3--52 for more information about using the
Section Rate view.

Setting Transport Rate
Probes
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Table 3--24 lists each of the section rate probes, the associated ETR 290
recommendation for each applicable probe, and the analysis type setting when
the probe is available (refer to Analysis Panel on page 3--69).

Table 3- 24: Section rate analyses

Analysis probe ETR 290 Analysis type

Maximum interval between consecutive PAT sub-table sections 1.3.a(1) All

Maximum interval between consecutive CAT sub-table sections — All

Maximum interval between consecutive TSDT sub-table sections — All

Maximum interval between consecutive PMT sub-table sections 1.5.a(1) All

Maximum interval between consecutive NIT sub-table sections.
Two probes are available: NIT actual and NIT other.

3.1.a(2) DVB and
DVB-T

Maximum interval between consecutive SDT sub-table sections.
Two probes are available: SDT actual and SDT other.

3.5.a(2) DVB and
DVB-T

Maximum interval between consecutive EIT sub-table sections.
Four probes are available for DVB and DVB-T analysis: EIT actual
present-following, EIT other present-following, EIT actual
schedule, and EIT other schedule.
One EIT probe is available for ATSC/PSIP analysis.

3.6.a(2) DVB, DVB-T,
and ATSC

Maximum interval between consecutive BAT sub-table sections — DVB and
DVB-T

Maximum interval between consecutive TDT sub-table sections 3.8(1) DVB and
DVB-T

Maximum interval between consecutive TOT sub-table sections — DVB and
DVB-T

Maximum interval between consecutive SIT sub-table sections — DVB and
DVB-T

Maximum interval between consecutive DIT sub-table sections — DVB and
DVB-T

Maximum interval between consecutive MGT sub-table sections 3.5 ATSC

Maximum interval between consecutive TVCT sub-table sections 3.6.1 ATSC

Maximum interval between consecutive CVCT sub-table sections 3.6.2 ATSC

Maximum interval between consecutive STT sub-table sections 3.3 ATSC

Maximum interval between consecutive RRT sub-table sections 3.7 ATSC

Maximum interval between consecutive EIT sub-table sections — ATSC

Minimum interval between consecutive sections with the same
table ID, table ID extension

3.2 All

Maximum interval between consecutive BIT sub-table sections — ISDB only

Maximum interval between consecutive DCT sub-table sections — ISDB only

Maximum interval between consecutive DLT sub-table sections — ISDB only

Maximum interval between consecutive SDTT sub-table sections — ISDB only
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Error Condition: Reports an error if the maximum interval between consecutive
sub-table sections of the specified stream item exceeds the value set on the
Section Rate Analysis panel of the Settings window. Refer to Table 3--24 for a
list of section rate probes.

Associated ETR 290 recommendation: Refer to Table 3--24 for a list of associated
ETR 290 recommendations for each stream item.

How/where an error is reported in the Expert Client: In the ETR 290 view, as a
general error message in the Report view, and in the appropriate Message
view(s).

Error Condition: Reports an error if the minimum interval between consecutive
table sections with the same table ID is less than 25 ms.

Associated ETR 290 recommendation: SI_repetition_error, 3.2.

How/where an error is reported in the Expert Client: In the ETR 290 view and as
an error message in the appropriate Message views(s).

NOTE. You cannot change the minimum interval setting from the default (25 ms).

Mega Frame Rate Probe Descriptions (DVB-T only)

The only specific rate analysis performed on DVB-T streams (in addition to the
regular MPEG-2/DVB rate analyses) is the measurement of the intervals between
two consecutive MIPs.

Use the MIP interval probe to check that the difference between the PIA time
stamps (the arrival time of the packets) of two consecutive MIPs remains within
a user-defined interval, and to report warnings every time the limits are
exceeded.

The MIP interval probe has two parameters: the Min: and Max: values allowed
(expressed in 100 nanosecond units). Typically the MIP interval should remain
within the (0.5, 0.61) seconds interval.

Set the MIP interval probe using the Mega Frame Rate Analysis configuration
panel in the Settings window (refer to Mega Frame Rate Analysis Panel on
page 3--90).

Maximum Interval
Between Consecutive

Sub-tables Probe

Minimum Interval Between
Consecutive Sections

Probe
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Appendix A: What to Do if an Application Locks Up

In the event an application locks up or freezes, perform the following steps to
close the application.

1. Press CTRL+ALT+DEL to open the Windows NT Security dialog box.

2. Click Task Manager to open the Windows NT Task Manager.

3. Click the Applications tab, and then highlight the locked-up application
(usually the status of the application will indicate Not responding).

4. Click End Task.

5. In some circumstances, a window opens prompting you to wait, end the task,
or cancel your “end task” instruction. Follow the window instructions; if you
click End Task, the application should close immediately.

6. If the above procedure fails to close the application, press CTRL+ALT+DEL

again to return to the Windows NT Security dialog box.

7. Click Shut Down. This opens the Shutdown Computer dialog box.

8. Select Shutdown and Restart; then click OK.

CAUTION. To avoid data loss, do not power off the computer without first exiting

Windows NT. Only use the manual reset if the computer does not respond.

If the above procedures do not close the application or restart the computer,
manually power off the computer, and then proceed with a normal power on. To
ensure that all parameters are reset, perform a complete power cycle following an
application lock up.
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Appendix B: Networking

This appendix provides the following information:

� Network requirements for the Tektronix MTS200 Series MPEG Test System

� Network installation procedures for configuring the TCP/IP and SNMP
parameters of your test system

� Network troubleshooting techniques for solving basic networking issues
common to many network installations

See theMTS200 Series MPEG Test System Hardware and Software Installation

Technical Reference that came with your test system for procedures on reinstal-
ling the application software.

Network Requirements

The Transmission Control Protocol/Internet Protocol (TCP/IP) protocol stack is
pre-loaded on Tektronix MTS200 Series MPEG Test Systems. The open nature
of TCP/IP allows you to create networks using various protocols and signaling
techniques. This section lists the physical and network requirements for using
test systems over a network.

The following list describes the physical requirements for networking test
systems:

� Ethernet network or subnetwork to the test system

� 10Base-T / 100Base-T network drop to your local test system

� Network interface card (NIC) and driver

Host machines do not have requirements beyond basic connectivity between two
points; the network adapter at a network management station can be of any type
that allows it to communicate over a TCP/IP network. The routers installed in
the network convert data to the appropriate format for the protocols used in your
network.

Physical Requirements



Appendix B: Networking

B- 2 MTS 200 Series Real-Time Analyzer User Manual

To use the test system over a network, you must install it in a TCP/IP network.
TCP/IP networks have specific addressing and routing requirements that your
network administrator will typically have already configured. Use this section as
a checklist for the TCP/IP parameters that your network administrator assigns to
your test system.

� Unique IP address

� Unique host name

� Subnet mask (if you are installing the test system in a network with multiple
subnets)

� Default gateway IP address (if your environment uses multiple networks or
subnets)

� DNS server IP address(es) (if you use the DNS service to resolve Internet
addresses; some networks use multiple DNS servers)

� WINS server IP address(es) (if your system uses WINS to resolve computer
names to IP addresses; some networks use multiple WINS servers)

NOTE. In order to use test systems over a network, your network administrator

needs to assign your host machine an IP address: you cannot use the test system

with Dynamic Host Configuration Protocol (DHCP).

Network Installation

This section describes how to set the parameters listed in Minimum Network

Requirements, and how to configure test systems to be managed in an SNMP-
based network management environment. The information in this section will
not replace the value added by networking professionals and describes only basic
network installation procedures.

Each network uses specific values for such parameters as IP addresses and
default gateways, so the parameter values used in the examples for this section
are for illustrative purposes only unless otherwise specified. You can configure
test systems as stand-alone instruments which need only minimal network
parameters set, or you can configure them to be installed into a LAN or WAN
(local or wide area network, respectively).

Minimum Network
Requirements

Setting TCP/IP Parameters
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Display the Microsoft TCP/IP Properties dialog box.

1. Click the Start button on the taskbar, point to Settings and then Control

Panel. (Alternatively, right-click the Network Neighborhood icon and
select Properties from the shortcut menu. Skip to step 3.)

2. Double-click the Network icon.

3. Select the Protocols tab from the Network dialog box as shown in
Figure B--1.

Figure B- 1: Network dialog box showing TCP/IP Protocol item

4. Highlight TCP/IP Protocol from the Network Protocol selection box, and
then click Properties.

The TCP/IP Properties dialog box is displayed showing the IP Address tab. See
Figure B--2 on page B--4.
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Set IP Address tab parameters.

5. Set the following IP Address tab parameters as shown in Figure B--2 and
described below:

a. Select the Intel EtherExpress Pro Adapter (it should be the only option
available for test systems).

b. Select Specify an IP Address.

c. Enter the IP address for your test system. If not already specified, obtain
the IP address from your network administrator. IP addresses must be
unique.

d. If necessary, enter the subnet mask value and default gateway, both of
which, you obtain from your network administrator.

Figure B- 2: IP tab parameters

Incorrect values for any one of these parameters can make your test system
behave unpredictably over a network. See IP Parameters beginning on
page B--9 for more information about these values.

6. Click Apply, and then click the DNS tab.
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Set DNS tab parameters.

7. Set the following DNS values as indicated in Figure B--3:

NOTE. Do not set DNS parameters unless your network uses the DNS service.

Setting these parameters when your network does not use this service will make

your host machine run very slowly when trying to resolve network addresses.

a. Enter your host machine name provided by your network administrator
into the Host name text box. Host/domain name pairs must be unique.

b. Enter the name of the domain of which your test system is a member in
the Domain text box as directed by your network administrator.

c. Click Add in the DNS Service Search Order group, and then enter the IP
address of the Domain Name System server in the TCP/IP DNS Server
dialog box.

d. Click Add to accept your changes and dismiss the TCP/IP DNS Server
dialog box.

Figure B- 3: DNS tab parameters

It should not be necessary to configure the parameters on the WINS Address
or the Routing tabs.
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8. Click OK when you are finished configuring the IP Address and DNS tab
parameters and are certain that all of the values correct.

9. Restart your test system or network management station for the TCP/IP
changes to take effect.

SNMP is a communication protocol built on the top of UDP/IP. It implements a
set of commands consisting of operations and variables. Equipment or applica-
tions (such as the MTS200 test system) that support SNMP present a set of
variables that you can modify or consult as well as a set of notifications. All of
these parameters are grouped into a Management Information Base (MIB).

MIBs are specifications containing definitions of management information so
that network systems can be remotely monitored, configured, and controlled.

Accessing the MIB files. The Tektronix MIB is a textual description of the
Analysis Server objects (functions and parameters) that can be monitored and
controlled via SNMP. The MIB text files are installed at the following location:

C:\Mib\

The MIB files are used by the real-time analysis applications and the OpenMux
(MTS205 and MTS215, Option OM only) applications.

The MIB file pairs for each application, for example, the RTAv1.mib and
RTAv2.mib files, are used for SNMPv1 and SNMPv2 systems respectively.

The operations in SNMP are limited to retrieving the value of management
information, modifying the value of management information, and reporting an
event.

Retrieval. The most common type of retrieval operation requires that the
identities are those that exactly match the identity of returned variables. This
retrieval operation is called GET.

For instance, from a DOS prompt window you can run the following command
to check that the Analysis Server is running on the first input:

getone -v2c <machineName> rta0 rtaStartStop.0

Where <machineName> is the network name of the test system for which you are
trying to determine the Analysis Server status.

SNMP Network
Management
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Modification. There is one modification operation, which is called SET. The
operand for SET is a list of pairs. Each pair consists of the identity of a variable
and its desired value. Use this operation to configure and control a managed
system.

For instance, from a DOS prompt window you can run the following command
(all on one line) to stop analysis on the first input of a named test system:

setany -v2c <machineName> rta0 rtaStartStop.0
-i stop

Where <machineName> is the network name of the test system for which you are
trying to start the Analysis Server.

To restart the Analysis Server, use the same syntax, but change the -i switch
parameter to start.

setany -v2c <machineName> rta0 rtaStartStop.0
-i start

Event Reporting. The SNMP event reporting operation is called TRAP. It
specifies an event and a list of pairs. A pair consists of the identity of a variable
and its value or values. This operation reports the occurrence of events on a
managed system to a list of managers configured to receive events.
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Network Troubleshooting

Networks are based on standards; however, there are many unique characteristics
of each network (LAN or WAN) that make it difficult to troubleshoot without a
thorough knowledge of the specific network. Consequently, in-depth network
troubleshooting should be performed by an expert who knows your network
characteristics.

This section provides some basic procedures that can eliminate some of the more
common sources of network errors. The information in this section is organized
as indicated in the following list:

� Basic Requirements

� IP Parameters

� Common Troubleshooting Procedures

� Sources of Information

If you cannot resolve problems using the procedures described in this section,
see your network administrator.

Fulfill the following requirements before troubleshooting your host machines:

� Configure your MTS200 Series for use on the network as described in
Network Requirements on page B--1.

� Ensure that any applications that you may have loaded on your test system
since receiving it are not using the ports assigned to the test system
components.

Basic Requirements
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The illustrations in this section depict how each IP parameter (IP address, subnet
mask, and default gateway) can negatively impact network connectivity.

Incorrect IP address. If the IP address for your test system is incorrect (not
unique), then you may, or may not be able to communicate over the network. In
Figure B--4, TVTest_1 uses the same IP address as Rennes. If Rennes is started
first, TVTest_1 will recognize the IP address conflict and will not load TCP/IP;
consequently, the test system will not be reachable over the network.

If your IP address is incorrect, and the IP address does not exist on your subnet,
you may be able to communicate from the device (test system or monitoring
station), but you may not be able to communicate with the device.

Test system:
TVTest_1

Test system:
TVTest_2

Test system:
Rennes

IP address: 128.181.99.62IP address: 128.181.99.62 IP address: 128.193.99.2

No TCP/IP
communication

Figure B- 4: Incorrect IP address

IP Parameters
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Incorrect subnet mask. Subnets and subnetting networks is complex and requires
a thorough understanding of IP addressing. Call your network administrator if
you think your networking problem involves subnets. Figure B--5 shows a
simple (and fairly common) subnet mask problem.

In Figure B--5, the subnet mask for TVTest_1 indicates that the network address
is contained in the first two bytes of the IP address. In dotted decimal notation,
the network address is 128.181. This information allows the device to communi-
cate with any other device with the same network address without being routed
through a default gateway.

Test system:
TVTest_1

Test system:
TVTest_2

Test system:
Rennes

IP address: 128.181.99.62IP address: 128.181.99.82 IP address: 128.181.99.72

_

Subnet mask: 255.255.0.0Subnet mask: 255.255.255.0Subnet mask: 255.255.255.0

Test system:
Carnac

IP address: 128.181.96.201

Subnet mask: 255.255.255.0

Router No TCP/IP
communication

Figure B- 5: Incorrect subnet mask

TVTest_1 cannot communicate with Carnac, because, according to the subnet
mask on TVTest_1, Carnac and TVTest_1 are logically on the same network.
Consequently, messages sent from TVTest_1 to Carnac are never routed.
Because these two devices do not share a medium, TVTest_1 will never find the
correct address for the network card on Carnac and will not be able to reach
Carnac.

TVTest_1 can communicate with TVTest_2 and Rennes because these three
devices share a medium, so messages from TVTest_1 do not need to be routed.
TVTest_1 is therefore able to find the correct addresses for TVTest_2 and
Rennes in spite of having an incorrect subnet mask.
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Incorrect default gateway IP address. The default gateway you have specified in
the TCP/IP Properties dialog box is the device that “knows about” your
subnetwork and others on your network. When you send messages (for instance
traps from your test system) to a device on another subnet, the default gateway is
able to route the message to the appropriate subnet. If the IP address specified in
the TCP/IP Properties dialog box is incorrect, messages to devices on other
subnets will not reach their destination (because they never made it to the default
gateway).

Test system:
TVTest_1

Test system:
TVTest_2

Test system:
Rennes

IP address: 128.181.99.62IP address: 128.181.99.82 IP address: 128.181.99.72

_

Subnet mask: 255.255.255.0Subnet mask: 255.255.255.0Subnet mask: 255.255.255.0

Default gateway: 128.181.99.10Default gateway: 128.181.99.1Default gateway: 128.181.99.1

Test system:
Carnac

Gateway
(router)

IP address: 128.181.99.1

IP address: 128.181.96.201

Subnet mask: 255.255.255.0

Default gateway: 128.181.96.1

Gateway
(router)

IP address: 128.181.96.1

WAN

No TCP/IP
communication

Figure B- 6: Incorrect default gateway IP address
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Many of the procedures performed in the following sections are common tasks.
Use these procedures when called for in the following sections.

Stopping and restarting the MPEG Analysis Services.Usually the analysis servers
start automatically when the test system starts. However, sometimes what may at
first seem to be a network problem can be cleared simply by stopping and
restarting the MPEG Analysis Service.

Use the following procedure to perform this task:

1. From the NT desktop, point to Start, click Settings, and then select Control
Panel from the submenu.

2. Double-click the Services icon. The Services Dialog box is displayed.

3. Scroll down in the list box until you can see MPEG Analysis Service.

4. Highlight this item, and then click the Stop button.

5. Click Yes, in the message box that appears. Notice the server icons in the
system tray (the lower left of the standard test system desktop) disappearing.

6. After the services are stopped, click Start to restart the server processes. The
Server Manager icon and the Analysis Server icons for all of your inputs will
reappear in the system tray.

Finally, you can restart your test system, which will automatically restart the
Server Manager and Analysis Server processes.

Common Troubleshooting
Procedures
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Pinging a host machine.One of the utilities provided with all TCP/IP installations
is Ping.exe. (Look in the C:\winnt\system32\ directory.) This utility allows
you to send communication packets to and record the response from an indicated
host machine. This, in essence, determines whether or not your packets arrived at
the destination. To run ping, use the following procedure:

1. Select Run from the Start menu. The Run dialog box appears.

2. Type one of the following into the Run text box:

ping machineName

ping IPaddress

In the examples, machineName and IPaddress represent the host machine
name and IP address, respectively, of the networked device you are trying to
ping.

3. Click OK.

A DOS window appears indicating whether or not the destination is
responding to the ping. In Figure B--7 the destination machine (Oxford4) is
not responding.

Figure B- 7: Ping.exe command window

Ping only runs briefly, and the DOS window closes when the process is
complete.
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Tracing the route of TCP/IP packets. Sometimes it is helpful to know how far your
packets made it on the way to a destination machine and which devices the
packets pass through on the way. The utility that provides this functionality is
tracert.exe. Tracert can also indicate a congested point in the network. To run
tracert, use the following procedure:

1. Select Run from the Start menu. The Run dialog box appears.

2. Type one of the following into the Run text box:

tracert machineName

tracert IPaddress

In the examples, machineName and IPaddress represent the host machine
name and IP address, respectively, of the networked device you are trying to
reach.

3. Click OK.

A DOS window appears (see Figure B--8) indicating the progress of your
packets. The far right column indicates the IP address of the nodes on the
network that successfully pass your tracert packets. This information
indicates the last good node on the path to the destination device.

Figure B- 8: Tracert.exe command window
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Finding IP addresses for devices on your network.At times, you may need to find
or confirm the IP address of a computer on your network (or, conversely, the
network name if all you have is an IP address). You may want to find this
information to ensure that IP addresses and network names you use in the Hosts
file are correct. The utility that will display this information is nslookup.exe.
Use nslookup as described below:

1. Point to the Start button and then select MSDOS. The command line
interface appears.

2. Enter one of the the following and press Enter, where machineName or IP
address is the network name or IP address, respectively, of the device you
are trying to lookup.

� nslookup machineName

� nslookup IP address

The network name and IP address of the device you are trying to lookup is
displayed. If your network uses DNS, the IP address and network name of
the DNS server is also displayed. See Figure B--9.

Figure B- 9: Command prompt with nslookup results
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If you need more information about network troubleshooting, some potential
resources are listed below.

NOTE. These resources may provide you with more information. Most of this

information is supplied as is, with no warranty as to its fitness, written or

implied. The best source of network troubleshooting help is your network

administrator.

� Cisco Systems, Inc. http://www.cisco.com/

This site is particularly useful for networks that use Cisco devices. (This
URL was valid as of November, 1999.)

� Dulaney, E; Lawrence, S; Scrimger, R; Tilke, A; White, J; Williams, R;
Wolford, K. MCSE Training Guide: TCP/IP. Indianapolis, IN.
New Riders, 1998

This is a training guide for Microsoft Certified Systems Engineer certifica-
tion, and covers TCP/IP and network troubleshooting.

� Taylor, E. Network Troubleshooting Handbook. New York, NY.
McGraw-Hill, 1999

Sources of Information
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Appendix C: Using the Private Syntax Interpreter

You can use the Private Syntax Interpreter to create and compile private syntax
definitions for use with the MTS200 MPEG Test System. When you load the
compiled definition through the Syntactic Analysis panel of the Configuration
client, the Analysis Server uses the definition to monitor and analyze the syntax
of the corresponding private sections or private data descriptors that are
contained in the input stream. Refer to Syntactic Analysis Panel on page 3--74 for
more information.

Using the Private Syntax Interpreter, you can construct private syntax definitions
of short private sections (section_syntax_indicator = 0), long private sections
(section_syntax_indicator = 1), and private data descriptors.

These are the basic steps you use to construct and use private syntax definitions:

1. Open the desired private syntax template or existing file

2. Change parameters of existing syntax items (such as fields, loops, and
if-then branches)

3. Add and edit syntax items in the template or existing file as necessary

4. Save the private syntax definition to a text file

5. Compile the text file to create a binary data file for use with the Analysis
Server (the Analysis Server results are displayed in the Expert client)

6. Load the binary data file into the Analysis Server using the Syntactic
Analysis panel of the Configuration client

This appendix contains the following information:

� Private Syntax Interpreter Interface page C--2

� Editing Private Syntax Definitions page C--12

� Compiling Private Syntax Definitions page C--21

� Analyzing Private Syntax with the Expert Client page C--21

� Private Data Reference page C--23
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Private Syntax Interpreter Interface

This section provides information describing how to start the Private Syntax
Interpreter application and how to use the elements of the application display.

Once you have logged in to the test system, you can start the Private Syntax
Interpreter application using one of the following two methods:

� Select Private Syntax Interpreter from the Windows NT Start menu

� Double-click the Private Syntax Interpreter icon in the Tektronix MPEG

Test System window

The Private Syntax Interpreter application window is shown below.

Client
area

Menu bar

Toolbar

Status bar

Title bar

Message
view

Starting the Application

Elements of the
Application Window
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The Private Syntax Interpreter window contains the following elements:

� Title Bar. In addition to identifying the Private Syntax Interpreter applica-
tion, the title bar indicates which private syntax text file is open, or if more
than one text file is open, the title bar indicates which text file is currently
selected.

� Menu Bar. The menu bar provides access to the various Private Syntax
Interpreter command menus. Refer to Menu Bar on the following page for
descriptions of the menu functions available within the menu bar.

� Toolbar. The toolbar contains graphical command buttons for many of the
most-used menu commands. Refer to Toolbar on page C--6 for more
information.

� Client Area. The Client area provides the workspace for creating and editing
private syntax table or descriptor definitions.

� Message View. The Message view provides a place for operational messages
to be displayed. This area is not displayed except when appropriate (refer to
Message View on page C--11 for more information). You can manually
display this area by selecting Messages from the View menu.

� Status Bar. The status bar displays first-level help messages about the Private
Syntax Interpreter menus and icons pointed to by the mouse (as shown
below).

Status bar message

Menu command
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Menu Bar. The menu bar contains the Private Syntax Interpreter menus. Listed
below are the functions available in each of the menus.

� File Menu. The File menu contains standard Windows NT file management
commands. Table C--1 describes the menu selections available in the File
menu.

Table C- 1: Menu bar File menu

Menu selection Function

New Create a new table/descriptor text file

Open Open an existing table/descriptor text file

Close Close the active table/descriptor text file

Close all Close all table/descriptor text files

Save Save the active table/descriptor text file

Save as Save the active table/descriptor text file with a new name

Print Print the active document

Print setup Change the printer and printing options

Exit Exit the application; will prompt to save documents

� Edit Menu. The Edit menu is present only when a private syntax editing
window is open. This menu contains commands for editing the various
syntax components and for compiling the syntax definition. Table C--2
describes the menu selections available in the Edit menu.

Table C- 2: Menu bar Edit menu

Menu selection Function

Undo Undo the last action

Add field Add a new field to the active table/descriptor text file

Add condition Add a new condition to the active table/descriptor text file

Add loop Add a new loop to the active table/descriptor text file

Add descriptor Add a new descriptor to the active table/descriptor text file

Compile Compile the active table/descriptor text file

Delete Delete the selection

Copy Copy the selection and put it on the Clipboard

Paste Paste the Clipboard contents
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� View Menu. The View menu contains commands for changing the appear-
ance of the Private Syntax Interpreter application window. Table C--3
describes the menu selections available in the View menu.

Table C- 3: Menu bar View menu

Menu selection Function

Toolbar Display or hide the toolbar

Status bar Display or hide the status bar

Messages Display or hide the message view

� Window Menu. The Window menu, present only when one or more syntax
windows are open in the Client area, contains commands for managing the
various syntax windows. Table C--4 describes the menu selections available
in the Window menu.

Table C- 4: Menu bar Window menu

Menu selection Function

Cascade Arrange the Client area windows so that they overlap

Tile Arrange the Client area windows as non-overlapping tiles

Arrange icons Arrange the icons at the bottom of the Client area if you have reduced
the Client area windows to icons

� Help Menu. The Help menu provides access to Private Syntax Interpreter
online help and version information. Table C--5 describes the menu
selections available in the Help menu.

Table C- 5: Menu bar Help menu

Menu selection Function

Help topics Open the Private Syntax Interpreter help window

About Private Syntax
Interpreter

Display program information, version number, and copyright
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Toolbar. The toolbar command buttons are shortcuts to various menu commands.
Table C--6 describes the functions available in the toolbar.

Table C- 6: Private Syntax Interpreter toolbar buttons

Button Equivalent menu command Function

File menu: New Create a new table/descriptor text file

File menu: Open Open an existing table/descriptor text file

File menu: Save Save the active table/descriptor text file

Edit menu: Add Field Add a new field to the active table/descriptor text
file

Edit menu: Add Condition Add a new condition to the active table/descriptor
text file

Edit menu: Add Loop Add a new loop to the active table/descriptor text
file

Edit menu: Add Descriptor Add a new descriptor to the active table/descriptor
text file

Edit menu: Compile Compile the active table/descriptor text file

The Table/Descriptor window (shown below) is used for assembling and editing
tables or descriptors syntax. The window is divided into two portions: the
Hierarchic view and the Characteristics view. The Characteristics view displays
different panels depending on which Hierarchic view icon is selected.

Table/Descriptor Window
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Hierarchic View. The Hierarchic view displays all the items related to making a
table/descriptor pattern as well as the labels associated to each item. An item can
be the root of the table/descriptor pattern, a field of the private syntax, a loop of
items, a conditional branch of items, or a descriptor space reservation.

Table/descriptor

Fields

Loop

Condition

Descriptor

Table C--7 lists the icon types found in the Hierarchic view and the meaning of
their associated labels.

Table C- 7: Hierarchic view icons and label descriptions

Icon type Description

Table/descriptor This icon gathers the characteristics of the table/descriptor when
located at the top of the tree. The label is then the name of the
table/descriptor.

If not at the top of the tree, the descriptor icon represents a space
reserved for a descriptor and the label indicates the length in bytes.

Field The field icon labels are the unique field ID for the associated field.

Loop The loop icon label indicates the number of iterations of this branch.

Condition The condition icon label indicates the validity of the conditional
branch.

True The true icon indicates the conditional branch in case the previous
condition expression is valid.

False The false icon indicates the conditional branch in case the previous
condition expression is valid.
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Table Panel. The Table panel (shown below) appears in the Characteristics view
when you select the root icon in the Hierarchic view.

After you have defined the type of private syntax by selecting Table or
Descriptor, enter the Id (decimal) value (table ID or descriptor tag) of the
private syntax you are editing.

NOTE. Table or descriptor ID decimal values cannot exceed 255. In addition,

decimal values cannot be one of the following because they are reserved:

0 (PAT); 1 (CAT); 2 (TSDT); 66 and 70 (SDT); 200 and 201 (VCT).

The General Name, Specific Name, and General Description fields are
optional fields to let you enter more information about the private syntax you are
editing.
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Field Panel. The Field panel (shown at the top of the following page) appears in
the Characteristics view when you select a field icon in the Hierarchic view. This
panel allows you to enter the unique Field Id. The panel provides the Length in
bits of the field. In addition, the Name and Description fields give more
information about the selected field icon.

The Data Type selection determines the interpretation of field data bits
according to their type and order of transmission. Select the appropriate
interpretation from the drop-down list (bslbf, rpchof, tbsv, or uimsbf).

The Valid Condition field declares the condition under which a field shall be
considered valid or not.

At the bottom of the Field panel appears the list of Interpretations, which is a
list of pairs (expression, interpretation). They are checked following the
top-to-bottom order that they are listed. The interpretations indicate what
descriptor will appear to the right of the item in the Section Analysis view of the
Configuration client application.
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Expression Panel. The Expression panel (shown below) appears in the Character-
istics view when you select a Condition, Loop, or Descriptor icon not located at
the top of the Hierarchic view.

When you select a Condition icon in the Hierarchic view, the expression field is
the test of the condition. The calculation of this field will determine whether the
condition is true or false.

When you select a Loop icon in the Hierarchic view, the expression field
indicates the number of iterations of the loop.

When you select a Descriptor icon in the Hierarchic view, the expression field
indicates the space in bytes occupied by this item.
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The Message view (as shown below) appears on the bottom of the application
window when you compile the private syntax you are editing.

If any errors occur during compiling, the Message view displays appropriate
error messages. If you double-click on an error message that contains the text:
ERROR LINE <number>, the application highlights the erroneous item in the
Hierarchic view.

Message View
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Editing Private Syntax Definitions

The editing of a private syntax definition consists of creating, modifying, and
saving the pattern of a syntax definition. This pattern is made of syntax fields
organized around loops, conditional branches, and space reservation for
descriptors.

Private syntax definitions reside in text (.txt) files. The application uses standard
Windows NT file management techniques to create, open, and save private
syntax definition files.

To create a new private syntax definition, select New from the File menu or click
the New toolbar button (refer to Toolbar on page C--6). The following New

Table/Descriptor dialog box appears.

Select Table short section to define a new short private section syntax with the
section_syntax_indicator field set to 0.

Select Table long section to define a new long private section syntax with the
section_syntax_indicator field set to 1.

Select Descriptor to define a private syntax descriptor.

Click OK to open a section or descriptor template in the Private Syntax
Interpreter. Client area.

CAUTION. Always save new syntax definitions under a new, unique filename. It is

possible to modify and replace the default template files (InitDr, InitLg, and

InitSt). Do not do so without saving a backup of the original template. Refer to

Saving a Private Syntax File on page C--20 for instructions.

To open an existing private syntax definition, select Open from the File menu or
click the Open toolbar button (refer to Toolbar on page C--6). The standard
Windows NT Open dialog box appears. Enter or select the file name and then
click OK to open the private syntax definition window in the Client area.

Creating a New Private
Syntax Definition File

Editing an Existing Private
Syntax Definition File
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When you create or open a private syntax definition, a Private Syntax Definition
window appears within the application window. The Private Syntax Definition
window is divided into two portions: the Hierarchic view and the Characteristics
view. The Characteristics view contains the parameters that define the selected
Hierarchic view icon. The Characteristics view displays different definition
panels depending on which Hierarchic view icon is selected.

To completely expand the Hierarchic view, press the numeric keypad asterisk (*)
key. To expand hierarchy items designated with a + symbol, click the symbol.
The long private section, short private section, and descriptor template hierar-
chies expand as shown below.

The private syntax hierarchies are consistent with the ISO/IEC presentation of
section syntax (refer to Table C--13 on page C--24). Use standard Windows NT
mouse and cursor-key techniques to navigate within the hierarchies.

Table long section Table short section Descriptor

Private Syntax Definition
Window
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The hierarchy is a collection of syntax fields organized around loops and
conditional branches as well as descriptors. The hierarchy root is a table item and
is the only mandatory hierarchy item.

Section/descriptor

Fields

Loop

Condition

Descriptor

To add a new item to the section or descriptor, select (highlight) the hierarchy
item that is to be the parent of the new item. Then choose Add Field from the
Edit menu or click the Add Field toolbar button (refer to Toolbar on
page C--6). Table C--8 lists the position in the hierarchy that added items appear.

Table C- 8: Hierarchy position of added items

Selected item Position of added item

Section/descriptor Right after the selected item if it is a descriptor; at the end of the hierarchy
if the table is a root item

Field Immediately following the selected field

Condition Immediately following the conditional branch

(Condition) True Last item of the true conditional branch

(Condition) False Last item of the false conditional branch

Loop Last item of the loop branch

You can copy or delete existing hierarchy items using the Edit menu Delete,
Copy, and Paste commands. You can also move existing hierarchy items by
performing a drag-and-drop action on the item.

Adding and Editing
Hierarchy Items
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When you add a field hierarchy item, the Field panel appears in the Characteris-
tics view as shown above. The default parameters for added field items are listed
in Table C--9.

Table C- 9: Default parameters for added private syntax fields

Field parameter Default value

Field ID Field <n>1

Length 8 bits

Data type bslbf

Description Field <n>1

Name Field <n>1

Valid condition True

Interpretations

Expression Default

Interpretation Undefined
1 The number <n> starts at 0 for the first added field and increments with each new

field insertion.
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Data Types. The four available data types are defined in Table C--10. These are
the different data types supported by digital television standards and the
application.

Table C- 10: Private syntax data type definitions

Data type Definition

bslbf Bit string, left bit first

rpchof Remainder polynomial coefficients, highest order first

tbsv Text bit string value

uimsbf Unsigned integer, most significant bit first

Expressions.An interpretation expression is a Boolean combination of operators
and terminals. Table C--11 defines the operators you can use.

You can express conditional values in either hexadecimal or decimal base; that
is, the following expressions are equivalent:

program_number == 422
program_number == 0x1A6

Table C- 11: Private syntax expression operators and terminals

Type Definition

Operators

<
>
<=
>=
==
!=
+
--
*
/
||
&&
!

less than
greater than
less than or equal
greater than or equal
equal
different
addition
subtraction
multiplication
division
OR
AND
NOT

Terminals

integer
field ID
TRUE
FALSE
API_COMPUTE_CRC_32
API_GET_VALIDITY
Default

Unique identifier of a field

Computed value of the CRC32 for the section
True if CRC32 is OK
For always applicable interpretation
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Table C--12 lists examples of interpretation expressions with their definitions.

Table C- 12: Private syntax example interpretation expressions

Expression Definition

CRC_32==API_COMPUTE_CRC_32 Value of field CRC_32 is equal to the computed
CRC32 value of the section

private_section_length<=4093 private_section_length field value is less than or
equal to 4093

(section_length--9)/4 Number equal to the section_length field value
minus 9, all divided by 4

Adding Interpretations. The Analysis Servers check the conditions in this list to
determine the interpretation text to display on the Expert client Section Analysis
view. To add an entry to the interpretations list, right-click on the background of
the interpretations box and then choose New from the resulting menu.

A new, default interpretation appears immediately after the selected item.
Because the Analysis Server checks conditions in top-to-bottom order, you may
want to move the new condition/interpretation pair below one or more of the
existing entries.

Default
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Changing Interpretation Order. To change the interpretation order within a field,
right-click on the background of the list of interpretations box, and choose
Move Up orMove Down from the menu.

Default

The selected condition/interpretation moves down one position as shown below.
You can reselect the item and repeat the command to move the item to the
bottom of the list.

Default

Editing an Expression/Interpretation. Click once on an expression/interpretation
line to select it. Click on the expression or interpretation portion of the selected
expression/interpretation to position the cursor at the end of the expression or
interpretation and to enable text entry as shown below. You can then double-click
a word to select it.

Once you have selected the expression or interpretation text to edit, you can
right-click to open a shortcut menu. You can use the Cut, Copy, Paste, Delete,
and Select All commands to edit the selected text. The Undo command lets you
undo the previous text-editing action.
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Adding a New Conditional Branch. To add a new conditional branch, select
Add Condition from the Edit menu or click the Add Condition toolbar button
(refer to Toolbar on page C--6). The default Valid condition is TRUE.

Valid condition if:

Adding a New Loop. To add a new loop, select Add Loop from the Edit menu or
click the Add Loop toolbar button (refer to Toolbar on page C--6). The default
Number of iterations is 1 loop.

Number of iterations: Loops

Adding a New Descriptor. To add a new descriptor, select Add Descriptor from
the Edit menu or click the Add Descriptor button (refer to Toolbar on
page C--6). The default Descriptor Size is 8 bytes.
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Changing the Hierarchy. Items or branches of the hierarchy can be moved within
the hierarchy by selecting and dragging the associated icon.

Items or branches of the hierarchy can be copied from one position to another by
holding the CTRL key down while dragging the selected icon.

To delete selected items or branches from the hierarchy, select Delete from the
Edit menu or press the DEL button on your keyboard.

To save a private syntax definition in text file format, select Save from the File
menu or click the Save toolbar button (refer to Toolbar on page C--6).

When you save a new syntax definition file, the standard Windows NT Save As

dialog box appears. Enter a file name with a .txt extension and then click OK.

To save an existing syntax definition file under a new name, select Save As from
the Edit menu.

NOTE. If you are using an existing syntax definition as a template for a new

definition, it is good practice to always select Save As to create the new file

before you make any changes to the original definition.

Saving a Private Syntax
File
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Compiling Private Syntax Definitions

To compile a private syntax definition, select Compile from the Edit menu or
click the Compile toolbar button (refer to Toolbar on page C--6).

The Message view opens at the bottom of the Private Syntax Interpreter window.
If there is no compiling error, a file containing the private syntax table, with the
extension .cta, is created in the same directory as the table file.

Analyzing Private Syntax with the Expert Client

Once you have created, saved, and compiled a private syntax definition, use the
following procedure to monitor private data sections or descriptors in the input
stream:

1. Open the Configuration client and connect to the input on which the private
data sections you want to monitor are encoded.

2. Select Analysis:Advanced:Syntax in the Navigation frame to open the
Syntactic Analysis configuration panel (shown below).
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3. Click Add. A standard Windows Open window appears, with only .cta files
displayed.

4. Change the the appropriate directory, if necessary, and then select the desired
binary syntax definition file (either double-click the file name or highlight
the file name and click Open).

5. Repeat steps 3 and 4 for every private syntax definition you want to use.

6. Click Apply on the bottom of the Syntactic Analysis configuration panel to
confirm your additions; click OK to confirm the additions and close the
Settings window.

7. Start the Expert client and connect to the input you want to analyze.

8. Open a section analysis view of the appropriate table. Refer to Section

Analysis View on page 3--50 for instructions.

Red folder icon and
error indicator

Unique interpretation for
item in Name column

You can run the Private Syntax Interpreter and the Expert client applications
simultaneously. You can therefore use the following technique to experiment
with the effects of different private syntax definition parameters on known
sections or descriptors:

1. Load the private syntax description in the Configuration client and begin
analysis as described above. Open a section analysis window to see how the
Analysis Server analyzes and reports the contents of the private section or
descriptor.

2. Edit the private syntax text file as necessary.

3. Compile the syntax definition. The new definition overwrites the original
definition.

4. Stop and then restart Analysis Server:

a. Right-click the Analysis Server icon for the input you are analyzing in
the system tray and select Stop from the shortcut menu.

b. Wait for the green highlight to disappear, and then repeat the step,
selecting Start from the shortcut menu.
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When you restart analysis, the Analysis Server reads the new contents of the
binary definition (.cta) file.

5. Open a section analysis window in the Expert client to see how the Analysis
Server analyzes and reports the contents of the private section or descriptor.

Private Data Reference

The Private Syntax Interpreter application builds tables and descriptors as
defined in ISO/IEC 13818-1, Generic coding of moving pictures and associated

audio information: Systems, July 1996. Refer to the standard for additional
parameter value information.

The following information is taken from ITU-T Rec. H.222.0 (ISO/
IEC 13818-1).

The private_section provides a further means to carry private data also in two
forms. This type of elementary stream may be identified under stream_type as
private_data in PSI sections. The short type of private_section() includes only
the first five defined fields, and is followed by private data. For this structure the
section_syntax_indicator shall be set to a value of 0. For the long type, the
section_syntax_indicator shall be set to a value of 1 and the full syntax up to and
including last_section_number shall be present, followed by private_data_bytes
and ending with the CRC_32.

When private data is sent in Transport Stream packets with a PID value
designated as a Program Map Table PID in the Program Association Table, the
private_section shall be used. The private_section allows data to be transmitted
with a minimum of structure while enabling a decoder to parse the stream. The
sections may be used in two ways: if the section_syntax_indicator is set to 1,
then the whole structure common to all tables shall be used; if the indicator is set
to 0, then only the fields table_id through private_section_length shall follow the
common structure syntax and semantics and the rest of the private_section may
take any form the user determines.

A private table may be made of several private_sections, all with the same
table_id (see Table C--13).

Private Section Types

Syntax of the Private
Section
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Table C- 13: Private section

Syntax No. of bits Mnemonic

private_section() {

table_id 8 uimsbf

section_syntax_indicator 1 bslbf

private_indicator 1 bslbf

reserved 2 bslbf

private_section_length 12 uimsbf

if (section_syntax_indicator = = 0) {

for (i = 0; i < N; i++) {

private_data_byte 8 bslbf

}

}

else {

table_id_extension 16 uimsbf

reserved 2 bslbf

version_number 5 uimsbf

current_next_indicator 1 bslbf

section_number 8 uimsbf

last_section_number 8 uimsbf

for (i = 0; i < private_section_length--9; i++) {

private_data_byte 8 bslbf

}

CRC_32 32 rpchof

}
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The following paragraphs describe the various private section fields.

table_id - This 8-bit field, the value of which identifies the Private Table this
section belongs to. Only values from 0x40 through 0xFE may be used.

section_syntax_indicator - This is a 1-bit indicator. When set to 1, it indicates
that the private section follows the generic section syntax beyond the pri-
vate_section_length field. When set to 0, it indicates that the private_data_bytes
immediately follow the private_section_length field.

private_indicator - This is a 1-bit user definable flag that shall not be specified by
ITU-T | ISO/IEC in the future.

private_section_length - A 12-bit field. It specifies the number of remaining
bytes in the private section immediately following the private_section_length
field up to the end of the private_section. The value in this field shall not exceed
4093 (0xFFD).

private_data_byte - The private_data_byte field is user definable and shall not be
specified by ITU-T | ISO/IEC in the future.

table_id_extension - This is a 16-bit field. Its use and value are defined by the
user.

version_number - This 5-bit field is the version number of the private_section.
The version_number shall be incremented by 1 modulo 32 when a change in the
information carried within the private_section occurs. When the current_next_in-
dicator is set to 0, then the version_number shall be that of the next applicable
private_section with the same table_id and section_number.

current_next_indicator - A 1-bit field, which when set to 1 indicates that the
private_section sent is currently applicable. When the current_next_indicator is
set to 1, then the version_number shall be that of the currently applicable
private_section. When the bit is set to 0, it indicates that the private_section sent
is not yet applicable and shall be the next private_section with the same
section_number and table_id to become valid.

section_number - This 8-bit field gives the number of the private_section. The
section_number of the first section in a private table shall be 0x00. The
section_number shall be incremented by 1 with each additional section in this
private table.

last_section_number - This 8-bit field specifies the number of the last section
(that is, the section with the highest section_number) of the private table of
which this section is a part.

CRC_32 - This is a 32-bit field that contains the CRC value that gives a zero
output of the registers in the CRC decoder defined in ITU-T Rec. H.222.0
Annex A after processing the entire private section.

Semantic Definition of
Private Section Fields
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Descriptors exist within Program Streams and Transport Streams. A range of
private descriptors may be defined by the user (see Table C--14). These descrip-
tors shall commence with descriptor_tag and descriptor_length fields. For private
descriptors, the value of descriptor_tag may take the values 64--255. These
descriptors may be placed within a program_stream_map(), a CA_section(), a
TS_program_map_section(), and in any private section(). Specifically pri-
vate_data_bytes also appear in the CA_descriptor().

Table C- 14: Private descriptor

Syntax No. of bits Mnemonic

private_descriptor() {

descriptor_tag 8 uimsbf

descriptor_length 8 uimsbf

for (i = 0; i < descriptor_length; i++) {

private_data_byte 8 uimsbf

}

}

descriptor_tag - This 8-bit field identifies the private descriptor. Values from
64–255 (0x40 through 0xFF) may be used.

descriptor_length - An 8-bit field. It specifies the number of remaining bytes in
the descriptor immediately following the descriptor_length field.

Private Descriptors
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Appendix D: ATSC Program Paradigm

The ATSC program paradigm specifies the method to be used for allocating the
values of the Packet Identifier (PID) field of the transport packet header in a
systematic manner. Within one transport multiplex, television programs that
follow the ATSC program paradigm are assigned a program number ranging
from 1 to 255. The binary value of the program number is used to form b11
through b4 of the PID. Programs adhering to the paradigm shall have b12 equal to
‘0’. Programs not adhering to the paradigm shall have b12 equal to ‘1’.

Additionally: base_PID = program number <<4, where the program number
refers to each program within one transport multiplex and corresponds to the
16-bit program_number identified in the PAT and PMT. The b0 through b3 of the
PID are assigned according to Table D--1.

The paradigm to identify the transport bit streams containing certain elements of
the program is defined in Table D--1.

Table D- 1: PID assignment for the elementary streams of a program

Name PID definition Description

PMT_PID base_PID+0x0000 PID for the bit stream containing the pro-
gram_map_table for the program.

Video_PID base_PID+0x0001 PID for the bit stream containing the video for the
program.

PCR_PID base_PID+0x0001 Implies the video bit stream also carries the PCR
values for the program.

Audio_PID base_PID+0x0004 PID for the bit stream containing the primary audio for
the program. The primary audio shall be a complete
main audio service (CM) as defined by ATSC Standard
A/52 and shall contain the complete primary audio of
the program including all required voice-overs and
emergency messages.

Data_PID base_PID+0x000A PID for the bit stream containing the data for the
program.

The program_map_table must be decoded to obtain the PIDs for services not
defined by the paradigm but included within the program (such as a second data
channel). According to the program paradigm, every 16th PID is a PMT_PID
and may be assigned to a program. If a PMT_PID is assigned to a program by
the program paradigm, the next 15 PIDs after that PMT_PID are reserved for
elements of that program and shall not be otherwise assigned.
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Table D--2 lists the program paradigm errors for programs adhering to the
program paradigm b12=0.

Table D- 2: Program paradigm errors

Error Requirement
A/53 Annex C
Paragraph 5.3

Bad program number assignment program_number shall be ranged from 1 to 255. A_PSI_PRPA_001

Bad PMT_PID assignment PMT_PID shall be equal to ‘base_PID+0x0000.’ A_PSI_PRPA_002

Bad Video_PID assignment If a program contains only one Video ES, this one shall be
assigned to base_PID+0x0001. The PID of the other Video ES
must be in the range [base_PID+0x0002; base_PID+0x000F],
except the values (base_PID+0x0004, base_PID+0x000A).

A_PSI_PRPA_003

Bad PCR_PID assignment If a program contains PCR data, this one shall be assigned to
base_PID+0x0001.

A_PSI_PRPA_004

Bad Audio_PID assignment If a program contains only one Audio ES, this one shall be
assigned to base_PID+0x000f. The PID of the other Audio ES
must be in the range [base_PID+0x0002; base_PID+0x000F],
except the value base_PID+0x000f, base_PID+0x000A).

A_PSI_PRPA_005

Bad Data_PID assignment If a program contains only one Data ES, this one shall be assigned
to base_PID+0x000A. The PID of the other Data ES must be in
the range [base_PID+0x0002; base_PID+0x000F], except the
value (base_PID+0x0004, base_PID+0x000A).

A_PSI_PRPA_006

PID reserved by a program adhering to
the program paradigm

The PID range from 0x0XX0 to 0x0XXF are reserved by programs
adhering to the program paradigm with program_number = XX.
These PIDs cannot be used elsewhere in the multiplex.

A_PSI_PRPA_007
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Appendix E: Software Repair

There are two parts to this appendix. The first part explains how to create and
use an Emergency Repair Disk. The second part tells you how to reload the test
system software if the installed copy becomes corrupted.

Creating and Using an Emergency Repair Disk

An emergency repair disk, specific to the system, is supplied with each Tektronix
MPEG Test System. Whenever you upgrade the software or change your
password, it is strongly recommended that you also create a new emergency
repair disk. This will minimize the chances that you will need to completely
reload the operating software for a minor problem.

Use the emergency repair disk to restore your system to its initial setup state if
your system files become corrupt and you are unable to recover the previous start
up configuration (Last Known Good — the Windows NT startup screen option).
If you don’t have the emergency repair disk, you will have to reinstall Windows
NT. Please see the Windows NT System Guide, provided with your back-up
copy of Windows NT, for the procedure required to restore your system.

You may also need the emergency repair disk to restore user passwords if they
are forgotten. Be sure to update the emergency repair disk each time you add a
user or change a password.

CAUTION. The files on the Emergency Repair Disk are test system-specific; that

is, the disk shipped with your test system is the only disk that will work with your

system. Do not lose this disk. If you lose the Emergency Repair Disk provided
with your test system, create a new one as described below.
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To create an emergency repair disk, clearly mark a high density 3.5-inch floppy
disk as the emergency repair disk for your test system, serial number <B0xxxxx>
(be sure to write the serial number exactly as it appears on the rear panel); then
perform the following steps.

NOTE. The emergency repair disk is test system specific. Make sure that the

emergency repair disk is clearly marked with its serial number. The serial

number of your Real-Time Analyzer appears on the original emergency repair

disk and on the server rear panel, near the power input connector.

1. Choose Run from the Windows NT Start menu.

2. Type rdisk in the Run dialog box. The Repair Disk Utility dialog box opens.

3. Click Update Repair Info to save your current configuration. A message
appears to remind you that earlier repair information is overwritten. Click
Yes to continue.

4. When the process is complete, a message appears to ask if you wish to create
an Emergency Repair Disk. Click Yes. You are then prompted to insert a
diskette into drive A.

5. Insert a 3.5-inch disk in drive A and click OK. Rdisk formats the disk and
copies the configuration files onto it.

6. When the operation is complete, click Exit in the Repair Disk Utility dialog
box. Remove the disk from drive A and keep it in a safe place.

Creating an
Emergency Repair Disk
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Always refer to the Windows NT documentation if you need more information.

1. Verify that you have a source of setup information available (the Win-
dows NT back up software package).

2. Insert the Windows NT Setup disk.

3. Restart the Test System.

4. When the Windows NT Setup Screen appears, press R (repair).

5. When prompted, insert the emergency repair disk.

6. The emergency repair disk performs the following tasks:

� Runs CHKDSK.EXE on the WINNT and SYSTEM partitions.

� Verifies each file in the installation and replaces any that are missing or
corrupt.

� Replaces the System, Security, and Security Accounts Manager hives in
the registry.

� Reinstalls the Boot Loader (the boot sector, BOOT.INI, etc.).

Reinstalling the MTS200 Series Software

Use the procedures below to reinstall your test system software if it is accidently
deleted or becomes corrupt. Software has been supplied on CD ROM.

NOTE. The following instructions are for reinstalling MPEG Test System

software on a machine running Windows NT Workstation 4.0 only; procedures

for upgrading your software could be different. If you are installing a software

upgrade, follow the instructions provided with the upgrade kit.

Reinstalling software involves three procedures:

� Uninstalling the software

� Copying the program files

� Entering passwords for your licensed applications

Using the Emergency
Repair Disk
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For best results, uninstall the software using unInstallShield application.

1. Restart Windows NT and log in as the administrator (Username = adminis-
trator; password = MPEG2). You must log in as the administrator to install
the MTS200 Series applications.

2. Quit any applications that automatically started at login.

3. Double-click the Uninstall MTS V3.0 icon in the Tektronix MPEG Test
System program group window (or whichever version is appropriate for your
current software).

4. When the dialog box asks you to confirm file deletion, click Yes.

5. When uninstall is complete, Click OK to close the Remove Programs From
Your Computer window.

1. Double-click the My Computer icon on your Windows NT desktop and, in
the resulting My Computer window, select the (C:) disk icon. Check the
window status bar to verify that the system disk has at least 100 MB of free
space. The program will not install if the system disk has less than 100 MB
of free space.

2. Place the MPEG Test System Version 4.0 Installation Software CD ROM
into the CD ROM drive.

3. Select Run... from the Windows NT Start menu. Then enter d:\Setup.exe in
the resulting window and click OK.

4. In a few seconds, the Tektronix MTS200 Series window appears on the
computer screen.

Uninstalling the Software

Copying the Program Files
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5. Read the window text and then click Next to proceed to the Choose
Destination Directory window.

6. The default destination folder is C:\Mts200\. Click Next to accept the default
folder. The applications may not function correctly if you specify another
target folder.

NOTE. It is strongly recommended that you use the default destination folder.

7. The Setup Type window opens. If your test system has only real-time
analysis hardware and software, select MTS205 System software with
hardware; if your system also contains a Data Store (CARB) system, select
MTS215 System software with hardware.

8. Click Next. The Select MTS2nn Platform window opens.

9. Select the option that applies to your test system and then click Next.

CAUTION. Selecting the wrong platform will prevent use of the Real-Time

Analyzer and the Data Store system, if it is installed. Be sure to identify your

computer platform and select the appropriate option.

10. The Select Program Folder window opens. Click Next to accept the default
folder name (Tektronix MPEG Test System) and continue. The Selection
Summary window opens.
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11. Review the Destination Directory, System Product, and Start Menu Folder
selections; if all are correct, click Next to proceed with installation.

The setup program begins installing the software. The activity and progress
gauges appear to show that installation is progressing. Installation proceeds
without your input (and sometimes with no apparent activity) for approxi-
mately 2 1/2 minutes, depending on your platform.

12. After the program group and submenu are set up, an information dialog box
reminds you to verify that the Dongle (software key) is installed. Verify that
the software key is installed on the parallel port; then click OK to continue.

13. The Setup Complete window opens; click Finish to continue.

14. A Notepad window opens to display the Readme file. Scan the text for
important information, then select Exit from the File menu to close the
window.

15. Another Setup Complete window opens. For best results, accept the “Yes, I
want to restart my computer now” option, remove the MPEG Test System
disc from the CD ROM drive, and click Finish to complete setup and reboot
the system.

16. Log on as MTS100. No password is required.
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17. Locate the Tektronix MPEG Test System folder on the Windows NT desktop
and double-click the folder to open the program group window.

Perform the remaining steps to reenter the general password that corresponds to
the attached software key.

1. Double-click the License Manager icon in the Tektronix MPEG Test System
window to start the application. The Tektronix Software Protection window
appears.

2. Consult the list of passwords supplied with your most recent system upgrade
and identify the General password. Use the original password supplied with
your system only if you have not upgraded the system or added any options.

3. Enter the three 6-character Hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields (lowercase
characters are acceptable) and then click OK. A License message window
appears.

4. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 1.

When you enter the correct password, software reinstallation is complete.

Entering the General
License Password



Appendix E: Software Repair

E- 8 MTS 200 Series Real-Time Analyzer User Manual



Glossary



MTS 200 Series Real-Time Analyzer User Manual Glossary- 1

Glossary

AC-3

Audio coding scheme developed by Dolby Laboratories, Inc. and adopted by
ATSC.

Analysis Server
The Analysis Server is the process that performs the actual analyses on
transport stream inputs. The Analysis Server sends analysis results to the
Expert Client and is configured using the Configuration client.

ARIB (Association of Radio Industries and Business)

ARIB is a body of broadcasters, manufacturers, and communication carriers
who are responsible for preparing standards on radio spectrum use in Japan.

ATSC (Advanced Television Systems Committee)

The Advanced Television Systems Committee was formed to establish
voluntary technical standards for advanced television systems, including
digital high definition television (HDTV).

BAT (Bouquet Association Table: DVB SI)

Describes the bouquets (collections of services) carried by one or more
transport streams.

BIT (Broadcaster Information Table)

ARIB only.

Bouquet

A group of transport streams in which programs are identified by the
network ID and PID pair of values.

CAT (Conditional Access Table: MPEG-2 PSI)

Associates one or more EMM (Entitlement Management Message) streams
to specific PID values.

See also ECM.
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Client/Server

The client / server software architectural model allows software to be
developed into two or more modules:

� The server module performs CPU intensive operations, runs in the
background (or remotely), and responds to “requests” from clients.
Usually requests are due to some action you have taken.

� The client module is often a graphical user interface that allows you to
configure or display the status of the server module.

Compression Layer
The compression layer is the compressed elementary stream and associated
metadata that describes the elementary stream. Usually this layer is
organized into variable length packets with headers and payloads of data, in
which case the bitstream is called a packetized elementary stream, or PES.

See the appropriate MPEG-2, DVB, or ATSC standards for more informa-
tion.

See also System Layer.

CRC (Cyclic Redundancy Check)

One of the fields described in the MPEG2 standard, used to check the
accuracy of data in PSI and SI tables.

CVCT (Cable Virtual Channel Table)

One of the tables defined by ATSC PSIP; contains a list of attributes for
virtual channels carried in the TS for a cable system.

Data Broadcast Descriptor

The key to data broadcasting protocols that fall within the scope of DVB
SIDAT 360. The data_broadcast_descriptor that can be found in the SDT and
DVB EIT. The data_broadcast_descriptor is the key to identifying data
piping and synchronous/asynchronous data streaming.

DCT (Download Control Table)

ARIB only.

DDB (Download Data Block)

The DownloadDataBlock table is a table that carries chunks of a module.
DDBs are referenced by DSIs.

DII (Download Info Indication)

The DownloadInfoIndication table is a Data Carousel specific table that
defines a group of modules. DIIs may be referenced either by the
data_broadcast_descriptor of the Data Carousel (one-layer Data Carousels),
or by the associate DSI (two-layer Data Carousels).
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DIT (Discontinuity Information Table)

This DVB structure is only used with partial transport streams; it is never
part of a transport stream used for broadcast.

DLT (Download Table)

ARIB only.

DSI (Download Server Initiate)

The DownlardServerInitiate table is a Data Carousel specific table that
defines a super-group of modules. It is referenced by the data_broadcast_des-
criptor of the Data Carousel (2-layer).

DSM-CC (Digital Storage Media Command and Control)

The Digital Storage Media Command and Control specification is a set of
protocols which provides the control functions and operations specific to
managing ISO/IEC 11172 (MPEG-1) and ISO/IEC 13818 (MPEG-2) bit
streams, although the concepts and protocols are considered to apply to more
general use. DSM-CC is defined in ISO/IEC 13818-6. The strength of
DSM-CC is that it enables a single DSM (in the server) to serve clients on
these and other network topologies with one common protocol. DSM-CC
messages are encapsulated in MPEG-2 sections whose format is compliant
with the private section format defined in ISO/IEC 13818-1.

DTS (Decoding Time Stamp)

One of the fields described in the MPEG2 standard; may be present in a PES
packet header that indicates the time that an access unit is decoded in the
T-STD.

DVB (Digital Video Broadcast)

A project group of the European Broadcasting Union (EBU).

DVB IRD (Digital Video Broadcasting Integrated Receiver Decoder)

A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

DVB-MG

Digital Video Broadcasting Measurement Guidelines

DVB-SI
Digital Video Broadcasting Service Information.

DVB-T

Digital Video Broadcasting Terrestrial.

ECM (Entitlement Control Message: MPEG-2 PSI)

The ECM is private conditional access information that specifies control
words and possibly other, typically stream-specific, scrambling and/or
control parameters.

See also EMM and CAT.



Glossary

Glossary- 4 MTS 200 Series Real-Time Analyzer User Manual

EIT (Event Information Table: DVB SI and ATSC PSIP)

DVB

Provides information about the chronological order of events carried by the
transport stream.

ATSC

Provides information about the programs (or data broadcasting sessions)
defined for the virtual channels.

EMM (Entitlement Management Message: MPEG-2 PSI)

The EMM is private conditional access information that identifies the
authorization levels or the services of specific decoders.

See also ECM and CAT.

Elementary Stream

An ordered series of bytes representing compressed audio, video, or data
including associated control data. Elementary streams are described in the
MPEG-2 standards.

EPG (Electronic Program Guide)

The EPG gives the content of the current program.

ETM (Extended Text Message)

An ETM is a multiple string data structure. Thus, it may represent a
description of an event or channel in several different languages (each string
corresponding to one language).

ETR (ETSI Technical Report)

One of the types of documents released by ETSI.

ETS (European Telecommunication Standard)

One of the types of documents released by ETSI.

ETSI

European Telecommunication Standards Institute

ETT (Extended Text Table: ATSC PSIP)

Provides detailed textual information about the virtual channels and events
(programs) carried by the transport stream.

Frame

An ISDB-S/ARIB structure comprised of 48 slots. See Slot and Super frame.

GPS

Global Positioning System

Input

See Multiplex.
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IRD (Integrated Receiver/Decoder)

A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

ISO (International Organization for Standardization)

Organization responsible for establishing standards at the world wide level.

Mega-Frame

A mega-frame is a set of OFDM frames, defined in such a way that the
number of packets contained in a mega-frame does not depend on the
transmission mode (2K or 8K).

MGT (Master Guide Table: ATSC PSIP)

Provides PID values for all PSIP tables carried in the transport stream
(except for the STT).

MIP

Mega-frame Initialization Packet

MPEG

Moving Picture Experts Group

M_TMCC

An ISDB-S/ARIB compliant multiplex with multiple transport streams. See
TMCC.

Multiplex (Input)

A Multiplex, as used in this online help system, is any single or multiple
program transport stream. The terms Input and Multiplex are interchangeable
when discussing a monitored bitstream.

NIT (Network Information Table: MPEG-2 PSI)

Describes the physical network over which the transport stream is carried.
The DVB and ATSC standards extend the MPEG-2 definition of the NIT.

PAT (Program Association Table: MPEG-2 PSI)

Associates program numbers and PMT PIDs.

PCR (Program Clock Reference)

One of the fields defined in the MPEG2 standard, a time stamp in the TS
from which the decoder timing is derived.

PES (Packetized Elementary Stream)

One of the structures defined by the MPEG2 standard, used to carry
elementary stream data.

PIA (Processing Interface Adapter)

One of the boards designed by THOMCAST. The PIA+ board filters and
analyzes the input transport stream for compliance to MPEG-2, DVB, and
ATSC TS standards.
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PID (Packet Identifier)

One of the fields described in the MPEG2 standard; a unique integer value
used to identify elementary streams of a program in a single or multi-pro-
gram TS.

PMT (Program Map Table: MPEG-2 SI)

Lists the PID values of program elements (for instance, elementary stream
PID(s) and the PID of the clock references for the program elements).

Program

The following structures are elements of MPEG-2 programs (or services):
PES packets, PMT, ECM. Program elements may, or may not, have a
common time base.

Program paradigm

In ATSC environments, the program paradigm specifies the method that
shall be used for systematically allocating PID values of transport packets.

PSI (Program Specific Information)

Program Specific Information is used to describe the structure of a transport
stream encoded using the MPEG-2 standards. PSI is carried in the following
MPEG-2 table structures: CAT, NIT, PAT, PMT, and TSDT.

PSIP (Program and System Information Protocol)

Program and System Information Protocol is used to describe the structure of
a transport stream encoded using the ATSC standards. PSIP is carried in the
following ATSC table structures: EIT, ETT, MGT, RRT, STT, and VCT

PTS (Presentation Time Stamp)

One of the fields described in the MPEG2 standard; it may be present in a
PES packet header that indicates the time that a presentation unit is presented
in the T-STD.

RRT (Rating Region Table: ATSC PSIP)

Provides rating information pertaining to a specified geographic region.

RST (Running Status Table: ATSC PSIP)

Allows quick updates to the timing information for the transport stream.

SDT (Service Description Table: DVB PSI)

Describes the services carried by the transport stream.

SDTT (Software Download Trigger Table)

ARIB only.

Service

A service, also called a program, is a collection of program elements that
may, or may not have a common time base.

See also Program.
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SFN (Single Frequency Network)

SFN is an extension of the DVB system in which all transmitted signals are
identical; therefore, the MPEG--2 TS inputs to the various DVB--T
modulators have to be bit identical.

SI (Service Information)

Service information is used to describe the structure of a transport stream
encoded using the DVB standards. SI is carried in the following DVB table
structures: BAT, EIT, NIT, RST, SDT, TDT, and TOT.

SID (Service ID)

The parameter used to uniquely identify a service within a transport stream.

SIT (Selection Information Table)

DVB--SI table. This DVB structure is only used with partial transport
streams; it is never part of a transport stream used for broadcast.

Slot

An ISDB-S/ARIB structure corresponding to one, 204-byte error coded
packet. See Frame and Super frame.

SNMP (Simple Network Management Protocol)
SNMP is the most common protocol used in network management systems.
SNMP is built on top of UDP/IP (User Datagram Protocol / Internet
Protocol) and provides a common interface between all the various devices
on a network and central network management stations. Network manage-
ment stations use network software to monitor network traffic and respond to
errors reported by devices on the network.

S_TMCC

An ISDB-S/ARIB compliant multiplex with only one transport stream. See
TMCC.

STS Interval

The STS interval measurement is obtained by calculating the difference
between the STS of the current MIP and the STS of the previous MIP,
modulo one second.

STT (System Time Table: ATSC PSIP)
Provides time and date information for the transport stream, as well as offset
and daylight savings time data.

Super frame

An ISDB-S/ARIB structure comprised of eight frames. See Frame and Slot.

System Layer

The system layer is the transport stream with program data and associated
metadata that describes the composition and organization of the transport
stream.
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MPEG-2 system layer information includes synchronization bytes, PID
numbers, scrambling information, and other indicators, including the start of
the transport packet payload. Transport packets can be PES packet, a PSI
table, or other private data. ATSC and DVB transport streams are MPEG-2
compatible because the required ATSC and DVB system layer data are
MPEG-2 private data structures. See the appropriate MPEG-2, DVB, or
ATSC standards for more information.

TDT (Time and Date Table: DVB SI)

Provides the time and date information (in UCT) for the transport stream.

TMCC (Transmission and Multiplexing Configuration and Control)

TMCC information is used to control transmission parameters in ISDB-S
environments where the multiplex includes transport streams from multiple
broadcasters and the services encoded in the various transport streams
require different modulation schemes. TMCC information is encoded in the
first eight bytes of the 16-byte Reed-Solomon area of 204-byte packet
transport streams. TMCC information includes modulation modes, slot
assignments, and alarms.

TOT (Time Offset Table: DVB SI)

Provides time offset information for the transport stream.

Traps

Traps are SNMP messages generated by the Analysis Server. These
messages are sent to one or more Server Managers (which you specify using
the Router utility). Ultimately, the traps regarding errors on the transport
stream are displayed as various error icons using the Master client.

Transport Stream

A transport stream is an ordered series of bytes representing valid MPEG-2,
DVB, ATSC, or ISDB-S/ARIB elements used to deliver video, audio, or
data. A transport stream may be composed of one or more elementary
streams.

The following MPEG-2, DVB, and ATSC structures are transport stream
elements: Program elements (including elementary streams and time
stamps), and PSI, SI, and PSIP tables.

TS

See Transport Stream

TSC

Transport Scrambling Control

TSDT (Transport Stream Descriptor Table: MPEG-2 PSI)

The TSDT uses descriptors to provide information about the transport
stream; for instance, information about the elementary streams, system
clock, bit rate, and other parameters.
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TSID (Transport Stream ID)

The parameter that uniquely identifies a transport stream within an original
network.

TVCT

VCT for terrestrial broadcast environments.

T-STD (Transport Stream - System Target Decoder)

Described by the MPEG2 standard; a hypothetical reference model of a
decoding process used to define the semantics of a TS.

VCT (Virtual Channel Table: ATSC PSIP)
There are two types of VCT: Terrestrial and Cable. Both describe attributes
of the virtual channels defined for the transport stream including the
transmission system and data about the services and programs for the
network.
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A
Absence of mandatory EIT, 3--133
Absence of referenced PID error analysis, 3--129
AC-3

analysis option, 3--70, 3--110
definition, Glossary--1

Active view menu, Expert client, 2--8
adaptation field, 3--116, 3--120, 3--122
Adding

interpretations for private syntax messages, C--17
private syntax branches, conditions, and loops, C--19

adding and editing private syntax hierarchies, C--14
Address, Tektronix, xix
Address bar

Configuration client, 2--17
Expert client, 2--3

ADF flags error analysis, 3--138
Advanced report mode, 3--21
Analysis

changing modes, 3--110
default, 3--106
indicator, 2--4
transport rate, 3--87, 3--106, 3--147

Analysis indicator, 2--17
Analysis panel, Configuration client, 3--69
Analysis Server, 3--105, Glossary--1

configuration, 3--63
interaction with client applications, 3--7
overview, 1--2
password protecting configuration, 3--102
stopping and restarting, B--12

analysis type, MPEG-2, DVB, or ATSC, 3--110
Application, locked, A--1
ARIB, definition, Glossary--1
ASI/M2S Distribution panel, 3--47
ATSC

analysis mode, 3--110
definition, Glossary--1
general option, 3--69
overview, 3--5

Automatic analysis, 3--128

B
Bandwidth, PCR jitter measurement, 3--83
BAT, 3--119, 3--123
BIT, definition, Glossary--1
Buffer filling, 1--6
Buttons, Expert client section analysis view, 3--50

C
Capture a transport stream event, 3--97
Capture a transport stream manually, 3--10
CAT, 3--119, 3--122

CAT_error, 3--122
Changing

analysis modes, 3--110
disk space available for captured data, 3--96
private syntax hierarchy, C--20
private syntax interpretation order, C--18

Client area, 3--34
Client/server, Glossary--2
Clock, symbol, Expert client, 3--16
colors, Expert client report view icons, 3--21
compiling definition files, private syntax, C--21
compression layer, Glossary--2
Conditional Access Table, 3--122
Configuration

delete, 3--64
load (restore saved), 3--64
new (restore default Analysis Server configuration),

3--63
password protecting Analysis Server configurations,

3--102
report view, 3--20
save, 3--63

Configuration client
application window, 2--18
connecting to an input, 3--98
functional overview, 2--18
overview, 1--3

Configuration panel, 2--17
Configuration settings, 3--67
Configure, Analysis Servers with private syntax files,

3--75
connecting to an input, Configuration client, 3--98
Contacting Tektronix, xix
Continuity Counter (Statistic view), 3--43
Continuity counter error analysis, 3--137
Continuity_count_error, 3--116
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CRC, 3--119
CRC check (analysis), 3--141
CRC_error, 3--119
creating a private syntax definition file, C--12
CTA files, loading into Analysis Server configurations,

3--75
Cyclic Redundancy Check, 3--119

D
Data storage

event configuration panel in Configuration client,
3--95

filtering panel in Configuration client, 3--101
input size, 3--96

data types, private syntax, C--16
DCT, definition, Glossary--2
default analyses, 3--106
default analysis configuration, loading, 3--107
default gateway, incorrect, B--11
discontinuity indicator, 3--116, 3--120
disk space available for data capture, 3--96
DIT, definition, Glossary--3
DLT, definition, Glossary--3
DNS tab parameters, B--5
Dongle, E--6
DVB

analysis mode, 3--110
definition, Glossary--3
general option, 3--69
overview, 3--4
SI tables, 3--4

DVB IRD, definition, Glossary--3
DVB-T, analysis option, 3--70, 3--111

E
edit private syntax definition files, C--12
editing expressions, private syntax, C--18
EIT, 3--119

EIT_error (DVB), 3--123
Emergency Repair Disk, E--1
encryption data, 3--122
End, locked application, A--1
End task, A--1
Ending, locked application, A--1
EPG, definition, Glossary--4
Error report mode, 3--21
Errors, printing messages, 3--31
Ethernet, networks, B--1
ETM, definition, Glossary--4

ETR290
Expert client view, 3--48
probes, 3--112
report view mode, 3--21

ETR290 panel, Configuration client, 3--71
Event Configuration panel, Configuration client, 3--95
Event Information Table, 3--122
Event viewer

setting error message parameters, Configuration
client, 3--91

viewing error message details in Expert client, 3--32
Exiting the application, 1--4
Expert client

application window, 2--12
functional overview, 2--12
overview, 1--2
specifying input type, 3--9
view transport rate analysis results, 3--147

Expert client menus, 2--8
expression panel, Private Syntax Interpreter, C--10
expressions, private syntax, C--16

F
field panel, Private Syntax Interpreter, C--9
Filtering panel, Configuration client, 3--101
First time operation, xi
frame, definition, Glossary--4
Functional Overview

Configuration client, 2--18
Expert client, 2--12

G
general analysis settings, Configuration client, 3--69
Ghost packet error analysis, 3--129
Ghost scanning, analysis option, 3--70, 3--110
GI-Digicypher, analysis option, 3--70
Graphics view, configuration panel, Expert client

Settings dialog box, 2--21
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H
Hardware installation, xi
Hardware panel, Configuration client, 3--68
Help menu

Configuration client, 2--16
Expert client, 2--11

Hexadecimal check box, 2--17
Hierarchic view, Private Syntax Interpreter, C--7
histogram

PCR analysis view, 3--55
PTS/DTS analysis view, 3--57
section rate view, 3--53

I
Icons, Hierarchic view, 3--15
Installation, hardware, xi
InterSI consistency error analysis, 3--130
IP address, incorrect, B--9
IP Address tab parameters, B--4

J
Jitter measurement bandwidth, 3--83

L
loading default analysis configuration, 3--107
Lock, symbol, Expert client, 3--16
Locked application, A--1
Logging on, 1--3
Logins, 1--3

M
M_TMCC, definition, Glossary--5
Managing remote systems, 3--65
Manual capture of a transport stream, 3--10
Manual Reset, A--1
Map private section as DVB section, 3--74
mask discontinuities, PCR analysis, 3--83
Maximum number of errors by entity, 3--74
Mega Frame

CRC analysis, 3--142
frequency offset analysis, 3--143
power error analysis, 3--143
rate analysis panel, Configuration client, 3--90
size error analysis, 3--132

syntactic analysis panel, Configuration client, 3--80
syntax error analysis, 3--142
syntax probes, 3--81
time offset analysis, 3--143
timing analysis panel, Configuration client, 3--86

Mega Frame size error analysis, 3--132
Menus

active view, Expert client, 2--8
Configuration client, 2--15

Help, 2--16
Session, 2--15

Expert client hierarchic view shortcut menus, 3--17
Help, Expert client, 2--11
Private Syntax Interpreter, C--4
Session, Expert client, 2--9
Trace, Expert client, 2--10
View, Expert client, 2--10
Window, Expert client, 2--11

Message, view settings, 3--91
Message level panel, Configuration client, 3--93
message view, Private Syntax Interpreter, C--11
Messages, setting error report parameters, 3--92
MGT PID with PUSI and pointer field, 3--140
MIB, text file, B--6
Minimum interval between sections analysis, 3--150
MIP packet analysis view, 3--57
MPEG, operational monitoring, 3--2
MPEG-2

analysis mode, 3--110
general option, 3--69
overview, 3--3
PSI tables, 3--3

multiplex, Glossary--5
Multiplex panel, Configuration client, 3--72
Multiprotocol encapsulation, analysis option, 3--111

N
Navigation panel, 2--17
Network

installation, B--2
minimum requirements, B--2
physical requirements, B--1
SNMP, B--6
troubleshooting, B--8

NIT, 3--119
NIT_error, 3--123

Null packet, 3--116
with ADF error analysis, 3--138
with PUSI error analysis, 3--136
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O
Opening

a section analysis view in the Expert client, 3--51
ETR290 view in Expert client, 3--48
IP monitoring view in Expert client, 3--60
MIP packet analysis view in Expert client, 3--58
PCR analysis view in Expert client, 3--55
PTS/DTS analysis view in Expert client, 3--56

Output activation, 3--68
Overview

Analysis Servers, 1--2, 3--7
ATSC, 3--5
client-server, 3--7
Configuration client, 1--3
DVB, 3--4
Expert client, 1--2
MPEG-2, 3--3
MTS200 system, 1--2
operational monitoring, 3--2

P
padlock symbol, Expert client, 3--16
Password

changing, emergency repair disk, 1--4
protecting Analysis Server configurations, 3--102

PAT, 3--115, 3--119
PAT_error, 3--115

PAT PID with AFC & DI error analysis, 3--139
PAT PID with AFC and DI, 3--139
PCR

interval, 3--83
jitter, 3--83
probes, 3--144
settling filter, 3--144

PCR analysis
settings, 3--54, 3--82
view, 3--53

PCR analysis view
histogram, 3--55
opening, 3--55

PCR jitter measurement bandwidth, 3--83
PCR timing analysis panel, Configuration client, 3--82
PCR/OPCR flags error analysis, 3--138
PCR_accuracy_error, 3--121

PCR_error, 3--120
Phone number, Tektronix, xix
PID, 3--118
PID 0x47 error analysis, 3--137
PID Allocation (Statistic view), 3--40, 3--147
PID Allocation View configuration panel, 2--23
PID_error, 3--118
pinging a host machine, B--13
PMT, 3--117, 3--119, 3--120, 3--127

PMT_error, 3--117
PMT PID with AFC & DI error analysis, 3--139
PMT PID with AFC and DI, 3--139
PMT PID with TSC error analysis, 3--137
Presentation time stamp, PTS_error, 3--122
Printing

error messages for one program, 3--32
reports and error messages, 3--31
section Analysis view, 3--51

Private syntax
adding branches, loops, and conditions, C--19
adding interpretations, C--17
analyzing with the Expert client, C--21
compiling definition files, C--21
data types, C--16
descriptor, C--19
editing expressions, C--18
expressions, C--16
hierarchy, C--20
loading, 3--135
loading files into Analysis Server configurations,

3--75
loop, C--19
saving files, C--20
semantic definition of fields, C--25
table showing structure of a section, C--24
table showing structure of descriptor, C--26

Private syntax interpreter, C--1
application window, C--2
expression panel, C--10
field panel, C--9
hierarchic view, C--7
menus, C--4
message view, C--11
starting, C--2
table panel, C--8
toolbar, C--6
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Probes
changing, 3--109
ETR290, 3--112
mega frame syntax, 3--81
multiplex, 3--73
PCR, 3--144
PTS/DTS, 3--145
removing, 3--109
section syntax, 3--79, 3--141
setting, 3--107
setting default configuration, 3--107
Transport rate, 3--87
transport syntax, 3--77

Problems, common network, B--12
Product support, contact information, xix
Profile

Analysis Server configuration, 2--16
saved Analysis Server configuration, 3--63

Program, report view mode, 3--21
program, 3--118, Glossary--6
Program Allocation (Statistic view), 3--37, 3--147
Program and System Information Protocol (PSIP)

tables, ATSC overview, 3--5
Program Association Table, 3--115
Program Clock Reference, 3--120
Program Map Table, 3--117, 3--127
Program paradigm, 3--133, D--1

definition, Glossary--6
Program Specific Information (PSI) tables, MPEG-2

overview, 3--3
PSI, 3--119
PSIP tables PID with ADF, 3--140
PSIP tables PID with TSC, 3--139
PSIP tables PID with TSC error analysis, 3--139
PTS, 3--122
PTS/DTS Analysis view, 3--56
PTS/DTS analysis view

histogram, 3--57
opening, 3--56

PTS/DTS probes, 3--145
PTS/DTS timing analysis panel, Configuration client,

3--84
Pulldown menus. See Shortcut menus

R
Rate analysis

program, PID, and type allocation, 3--147
section, 3--148
transport, 3--147

registry editor, 3--64
Repair Disk Utility, E--2
Report panel, Configuration client, 3--91
Report view

configuration, 3--20
configuration panel, Expert client Settings dialog

box, 2--19
Report view modes, Program, ETR290, Advanced, and

Error, 3--21
Report view toolbar, 2--5, 3--19
Reserved PID with TSC error analysis, 3--137
Reset, A--1
Restart test systems remotely, 3--65
restarting Analysis Servers, from the desktop, B--12
restore default analysis settings, 3--63
RST, RST_error, 3--123

S
S_TMCC, definition, Glossary--7
saving definition files, private syntax, C--20
Scrambled ES without CA descriptor, 3--133
Scrambling without CAT error analysis, 3--129
SDT, 3--119, 3--123

SDT_error, 3--123
SDTT, definition, Glossary--6
Section

analysis view, 3--50
maximum and minimum rate intervals, 3--148
number analysis, 3--141
opening a section analysis view, 3--51
rate analysis, setting minimum and maximum

intervals, 3--88
rate analysis panel, Configuration client, 3--88

section, 3--119
Section rate view, 3--52
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Section syntactic analysis panel, Configuration client,
3--78

Section syntax probes, 3--141
Security, Windows NT dialog box, A--1
Security panel, Configuration client, 3--102
service, Glossary--6
service information, 3--122
Service Information (SI)

DVB overview, 3--4
DVB tables, 3--123

Service support, contact information, xix
Session menu, 2--15

Expert client, 2--9
setting default probe configuration, 3--107
Settings, Configuration client, 3--67
Settings dialog box, Expert client, 2--19
Settings window, 3--62
settling filter, 3--82

jitter analysis, 3--54
PCR analysis, 3--144

Setup, hardware, xi
SFN (Single Frequency Network), definition,

Glossary--7
Shortcut menu, Expert client, 3--17
Shutdown

computer, A--1
remote test system, 3--65

Shutting down the computer, 1--5
SI_repetition_error, 3--125
SIDAT 360, analysis option, 3--111
SIDAT 360 Data Broadcasting Analysis, analysis

option, 3--70
SIDAT 360 Profiles, Analysis option, 3--70
SIT, definition, Glossary--7
slot, definition, Glossary--7
Smoothing time, analysis option, 3--70, 3--110
SNMP

GET operation, B--6
MIB file, B--6
SET operation, B--7
setting TRAP destination, B--7
setting up for, B--6

Software key. See Dongle
Software repair, E--1
Software version, xv
Specifications, xi
starting and stopping analysis servers, remotely, 3--66
Starting the application, 1--4
Statistic analysis settings, 3--129
Statistic view, 3--36
stopping Analysis Servers, from the desktop, B--12
stopping and restarting analysis servers, B--12
subnet mask, incorrect, B--10

super frame, definition, Glossary--7
Sync_byte_error, 3--114
SyncByte, 3--114
synchronization, default analysis, 3--106
Syntactic analysis panel, Configuration client, 3--74
Syntax analyses, error indicator in Expert client, 3--134
system layer, Glossary--7
system time, 3--120

T
Table ID error analysis, 3--130
table panel, Private Syntax Interpreter, C--8
table_id, 3--117, 3--123
Task Manager, A--1
TCP/IP

DNS parameters, B--5
IP Address parameters, B--4
properties dialog box, B--3
setting parameters, B--2

TDT, 3--123
TDT_error, 3--123

Technical support, contact information, xix
TEI. See Transport error indicator
Tektronix, contacting, xix
Terrestrial descriptor consistency, 3--132
test systems, shutting down remotely, 3--65
TMCC, definition, Glossary--8
Toolbar, 2--16

Configuration client, 2--16
Private Syntax Interpreter, C--6
Report view, 2--5, 3--19
View, 2--4

TOT, 3--119, 3--123
TP Error Indicators (Statistic view), 3--45
Trace menu, 3--11

Expert client, 2--10
tracing TCP/IP packets, B--14
Transport error indicator analysis, 3--138
Transport rate, analysis, 3--106, 3--147
Transport rate analysis, 3--148

settings, 3--87
viewing results, 3--147

Transport rate analysis panel, Configuration client,
3--87

Transport stream
capturing an event, 3--97
manual capture, 3--10

transport stream, Glossary--8
Transport syntactic analysis panel, Configuration

client, 3--76
Transport_error, 3--118
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transport_error_indicator, 3--118
transport_scrambling_control, 3--122
Traps, Glossary--8

SNMP event reporting, B--7
Trigger configuration, 3--68
Troubleshooting

alternative information sources, B--16
common procedures, B--12
networking, B--8
pinging a host machine, B--13
tracing TCP/IP packets, B--14

TS_Sync_Loss, 3--114
TVCT, definition, Glossary--9
Type Alloc (Statistic view), 3--44, 3--147

U
Uninstalling MTS software, E--4
UNP. See Unsynchronized packet error analysis
unreferenced PID, 3--127
Unsynchro Packets (Statistic view), 3--46
Unsynchronized packet error analysis, 3--130
URL, Tektronix, xix

V
Version, software, xv

Version number analysis, 3--141
View

ETR290, 3--48
IP monitoring, 3--60
jitter based on PCR analysis, 3--53
MIP packet analysis, 3--58
PCR analysis, 3--53
PTS/DTS analysis view, 3--56
Section analysis, 3--50
Section rate, 3--52

View configuration panel, 2--19
View menu, Expert client, 2--10
View toolbar, 2--4
viewing transport rate analysis results, Expert client,

3--147

W
Web site address, Tektronix, xix
Window menu, Expert client, 2--11
Windows NT

initialization, 1--3
security dialog box, A--1
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